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1 Getting Started with Light-O-Rama

Welcome to Light-O-Rama

Light-O-Rama is a computerized lighting system designed to control elaborate or simple lighting
displays. The Light-O-Rama system can be applied to almost any lighting situation, from stand-alone
controllers to synchronizing hundreds of controllers.

This page gives a high-level oveniew of how to start controlling your lights using Light-O-Rama:

Getting Help about Light-O-Rama

Important Terms and Information

Connecting the Lights Using Light-O-Rama Controllers
Creating a Show

For more detailed information, please see Light-O-Rama Concepts and the Light-O-Rama Software
Package.

Experienced users may wish to see what's new in the latest version of Light-O-Rama.

Getting Help about Light-O-Rama
Other than this help file, there are several ways to get help about Light-O-Rama:
Frequently Asked Questions, quick start guides, training presentations, tutorials, demos, and user

guides can be found on the Support page of the Light-O-Rama website, along with phone, mail, and
email contact information.

Light-O-Rama users' forums can be found at the LOR Users Support Center.

The LOR Wiki is a user-created and edited repository of Light-O-Rama information. Please note that
the information contained in the LOR Wiki is not published by Light-O-Rama, and cannot be
considered official.

Important Terms and Information

Companion Unit

A companion unit is a Light-O-Rama controller that receives lighting commands from another
source - either a PC running Light-O-Rama software, or from another controller known as a director
unit.

Control Panel

The Light-O-Rama Control Panel is a program that can be used to manage the Light-O-Rama
system on your PC. The Control Panel runs in the system tray (where the PC's clock is displayed).
Light-O-Rama is made up of a number of different programs, and the Control Panel is a convenient
way of accessing them. The Control Panel must be running in order to control shows from your PC.

Daisy Chain
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This is the term generally used to describe the manner in which Light-O-Rama light controllers are
connected. A wire goes from the source (a PC running Light-O-Rama software or a director unit) to
a companion unit. Another wire goes from that companion unit to another companion unit, and so
on, until all companion units are "chained" together.

Do not put "Y"s or forks in the data cable. Only connect the units in this daisy chain configuration.
Data Cable

Light-O-Rama controllers can be connected using both data cables and phone cables, but you must
know which type of cable it is (for the purposes of Light-O-Rama, a cable is considered a data
cable if its wires are connected straight through).

How do you know if it is a data cable? Well, most likely the only cable that you will see that is not a
data cable is a wire that is intended specifically for phones. If you go to your local hardware store
and purchase a phone extension cable, then that wire is not a data cable. The distinction between
data cables and phone cables is important, because the wires are swapped around. There are
selectors or jumpers on most Light-O-Rama controllers that allow you to specify which wire type you
are using.

Only the wire coming into a controller (from the previous controller or from a PC running Light-O-
Rama software) should be used to determine which selector setting to use. The wire leaving a
controller (if there is one) can be of any type, and has no bearing on which selector setting should be
used. For example, if a controller has a phone cable coming in from the previous controller, and a
data cable leaving to the next controller, the selector should be set for "phone cable".

Director Unit

A director unit is a Light-O-Rama controller that sends lighting commands to other controllers
(known as companion units). Controllers can run individually in standalone mode, but to synchronize
multiple controllers together, they must be directed either by a PC running Light-O-Rama software,
or by a director unit.

Standalone sequences may contain lighting commands for a number of different units. A director
unit is a unit that is running standalone - i.e. not connected to a PC - that contains lighting
commands for other units cabled to it (the companion units). The director unit can also control its
own lights, simultaneously.

There is no difference in the hardware of a director unit and a companion unit - the only difference is
the mode that they are in.

A PC running Light-O-Rama software can also be thought of as a director unit, in that it can send
lighting commands to Light-O-Rama controllers. There must be one and only one director unit (or
PC running Light-O-Rama software) on a daisy chained group of controllers.

Hardware Utility

The Light-O-Rama Hardware Utility is a program that can be used to set up and test the hardware
used to control lights, as well as download sequences to standalone controllers or director units.

Phone Cable

Light-O-Rama controllers can be connected using either data cables or phone cables, but you must
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know which type of cable you are using. See data cables for details.

Schedule
A schedule is a list of shows and the times at which those shows are to be played.
If the Light-O-Rama Control Panel is running on a PC, and its "Enable Schedule" option is turned on,

then the schedule will be monitored, and its shows will be started and stopped at the appropriate
times.

The Schedule Editor program is used to create and modify schedules.

Sequence

A sequence is a file that contains a set of lighting commands to be sent to Light-O-Rama
controllers. There are two types of sequences: musical sequences, which have an associated
music or video file that is to be played at the same time, and animation sequences, which do not.

Sequences can be grouped together into shows.

The Sequence Editor program is used to create and modify sequences.

Show
A show is a file that contains a number of sequences, and the order in which they should be played.
A schedule can be created to specify the times at which various shows should be played.
The Show Editor program is used to create and modify shows.

Standalone
A Light-O-Rama controller can be controlled by another controller (or a PC running Light-O-Rama
software), or it can control itself and/or other controllers, in standalone mode. A sequence,
created using the Sequence Editor, can be downloaded to a standalone controller using the
Hardware Utility. The controller can then be set up to run this sequence whenever it has power, or, if

the unit is a model with an internal clock, it can be instructed to run the sequence during a particular
time.

A standalone controller whose sequence contains lighting commands for other controllers will
transmit those commands to the other controllers. In this case, the controller is known as a director
unit.

Unit

A unit is another term for a Light-O-Rama controller. Each unit has a number of circuits, each of
which can be used to control lights independently of each other. Each unit is identified by a unit ID.

Unit ID

Each unit has an identifier assigned to it, known as a unit ID. When a lighting command is sent to
a unit, all of the units that are daisy chained together can see that command. Howeer, the
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command contains a unit ID; only the units having that unit ID will act upon that command.

For Light-O-Rama controllers, the unit ID is a two characters, each of which can have any of the
values 0,1, 2, 3,4,5,6,7,8,9, A, B, C, D, E, and F. For example, "01", "25", "37", "5C", "BD", or
"E2". However, not all possible combinations are allowed: "00" and "F1" through "FF" are
disallowed.

Controllers other than Light-O-Rama controllers use different formats for their unit IDs.

Connecting the Lights Using Light-O-Rama Controllers
To connect lights using Light-O-Rama controllers, take the following three steps:

1. Determine the serial port and hook up a controller.
2. Select a unit ID.

3. Test the lights.

Step 1. Determine the Serial Port and Hook Up a Controller

Insert an SC485 converter into your PC's DB9 serial connector which you plan on using for the Light-
O-Rama network. If you are using a USB/RS-232 conwerter, then make sure that it is properly
installed, and that the SC485 conwerter is connected. If you're not sure what all this is about, simply
try to find a connector on the back of your PC that has nine pins and which will accept the SC485
adaptor.

Using a cable, connect a Light-O-Rama controller to the SC485 adaptor. Make sure that the LOR
controller is powered on. The LED in the controller should be blinking.

Using the Light-O-Rama Control Panel, start the Hardware Utility program. In the Hardware Utility's
Setup Comm Port section, use the Auto Configure button. This will cause the Hardware Utility to
look for the attached controller and determine which comm port is being used.

Step 2. Select a Unit ID

If your controller has unit ID selection switches, you can select its ID by adjusting the selectors to
the desired ID. If your controller does not have these unit ID selection switches, then you will need
to set its unit ID by using the Hardware Utility:

To set the unit ID using the Hardware Utility, connect one and only one unit to the PC using the
SC485 adaptor and a cable. In the Set Unit IDs section, go to Set New Unit ID, select the ID that
you wish to use for the controller, and click the Set Unit ID button. This button will only work on
new units that have never been assigned a unit ID (to change the unit ID of a unit that already has
one assigned, use the Change Existing ID section instead).

TIP: Assign unit IDs sequentially, starting at 01. This will make maintenance of the units faster.

Step 3. Test the Lights

With the unit connected to the PC, attach lights and power the unit on. In the Hardware Utility, click
the Refresh button in the top center of the screen. After a short time, your unit should appear in the
dropdown list to the right of the Refresh button. Select the unit, and you can then test the lights
using the various controls in the Test Unit's Operation section of the Hardware Utility.
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TIP: Before clicking Refresh, set the Hardware Utility's Max Unit ID to as low a value as possible.
This is the maximum unit ID of controllers that you plan on using (you can always change it to a
higher value if you add more controllers later). Setting it to a low value makes the Hardware Utility
run faster (though it will not find any connected units with higher unit IDs).

Creating a Scheduled Lights Display
To create a lights display and hawe it run at certain times, take the following steps:

1. Make your sequences.

2. Make a show.

3. Make a schedule.

4. Turn on the Control Panel's "Enable Schedule".

Step 1. Make Your Sequences

Using the Sequence Editor, create the sequences that will be used in your show.

You can test how the lights will look for a sequence while in the Sequence Editor: Make sure
Control Lights is turned on in the Play Menu, and that you have assigned the channels in the
sequence to a controller that is hooked up to your PC. Then, click the play button (which is the
green arrow in the toolbar).

Step 2. Make a Show
A show is a collection of sequences. A show can be created using the Show Editor program.
Shows hawe seweral sections, each of which can have sequences:

e Background: Sequences listed in the "background" section will be played for the entire
duration of the show.

e Startup: Sequences listed in the "startup” section will be played when the show first begins.

e Animation and Musical: After the "startup” sequences have completed, sequences in both of
these sections will run, until it is time for the show to stop.

e Shutdown: When it is time for the show to stop, the "animation" and "musical" sequences
will stop running, and the sequences in the "shutdown" section will start. Only after the
"shutdown" sequences are finished will the show truly end.

In the Show Editor, you can add sequences to any of these sections by selecting the appropriate
section's tab, and hitting the big PLUS button.

After you have created your show, you should sawe it using the "Sawe" or "Sawve As" button. Assign
the show a meaningful name - this is the file name that you will be using in the next step.

Step 3. Make a Schedule

Unlike sequences, you cannot run a show interactively. Instead, to test a show, put that show into
a schedule, using the Schedule Editor program:

In the Schedule Editor, click the Add button, and select the show file with the name that you created
in the previous step. Select a start and end time that will allow the show to start at a convenient
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time for you to view it. Then click Save to save your schedule.

Step 4. Turn On the Control Panel's "Enable Schedule"

To view the scheduled show, turn on the "Enable Schedule" option in the Light-O-Rama Control
Panel. Doing this will cause the Control Panel to monitor your schedule, and start and stop your
show at the appropriate times.

2 What's New?

What's New in Light-O-Rama

What's New in Version 4.3.4
What's New in Version 4.3.2
What's New in Version 4.3.0
What's New in Version 4.2.10
What's New in Version 4.2.8
What's New in Version 4.2.6
What's New in Version 4.2.4
What's New in Version 4.2.2
What's New in Version 4.2.0
What's New in Version 4.1.2
What's New in Version 4.1.0
What's New in Version 4.0.38
What's New in Version 4.0.36
What's New in Version 4.0.34
What's New in Version 4.0.32
What's New in Version 4.0.30
What's New in Version 4.0.28
What's New in Version 4.0.26
What's New in Version 4.0.24
What's New in Version 4.0.22
What's New in Version 4.0.20
What's New in Version 4.0.18
What's New in Version 4.0.16
What's New in Version 4.0.14
What's New in Version 4.0.12
What's New in Version 4.0.10
What's New in Version 4.0.8
What's New in Version 4.0.6
What's New in Version 4.0.4
What's New in Version 4.0.2
What's New in Version 4.0.0
What's New in Version 3.12.2
What's New in Version 3.12.0
What's New in Version 3.11.2
What's New in Version 3.11.0
What's New in Version 3.10.14
What's New in Version 3.10.12
What's New in Version 3.10.10
What's New in Version 3.10.8
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e What's New in Version 3.3.0
e What's New in Version 3.2.4
e What's New in Version 3.2.0
e What's New in Version 3.1.4
e What's New in Version 3.1.2
e What's New in Version 3.1.0
e What's New in Version 3.0.2
e What's New in Version 3.0.0
e What's New in Version 2.9.4
e What's New in Version 2.8.12
e What's New in Version 2.8.10
e What's New in Version 2.8.8
e What's New in Version 2.8.6
e What's New in Version 2.7.6
e What's New in Version 2.7.4
e What's New in Version 2.6.2
e What's New in Version 2.6.0
e What's New in Version 2.5.6
e What's New in Version 2.5.4
e What's New in Version 2.5.2
e What's New in Version 2.4.10
e What's New in Version 2.4.8
e What's New in Version 2.3.8
e What's New in Version 2.3.6
e What's New in Version 2.3.4
e What's New in Version 2.1.6
e What's New in Version 2.1.4
e What's New in Version 2.1.2
e What's New in Version 2.0.16
e What's New in Version 2.0.14
e What's New in Version 2.0.12
e What's New in Version 2.0.8
e What's New in Version 2.0.4
e What's New in Version 2.0.0
e What's New in Version 1.5.0
e What's New in Version 1.4.0

What's New in Version 4.3.4

e Improved "About" box in the Pixel Editor
e Pixel Editor warnings for unsupported license level

* Bug fixes
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Improved "About" box in Pixel Editor

The Pixel Editor's "About" window now has a "Copy to clipboard" button to make it easy to paste the
displayed system information into forums and help tickets.

Pixel Editor warnings for unsupported license leve

When Tools > Control Lights is selected in the Pixel Editor, the user is now warned if he or she does
not have a Pro license.

Also, the File > Sawe Intensity Data menu item is now enabled at all license lewels, but the user gets
an error message if they select it and do not have a Pro license.

Bug fixes

In SuperStar,stretching of DMXin CCR mode by specifying the pixel length of DMX pixels got
broken in version 4.2.10. It is now fixed.

In SuperStar, export of DMXin CCR mode in Half ribbon mode with controllers at the bottom would
get an error saying "Channel on wrong part of ribbon, export failed."

SuperStar's "No Clip" rectangle has been fixed to be the entire matrix instead of being the first
matrix in the visualization.

The output of intensity data by SuperStar was dimmer than it should have been.

In some cases, the second time that a sequence was played during a run of a show, it would fail
with an error message saying "ERROR WITH SEQUENCE (Invalid play state (3) for
InitializeForPlay)", and the sequence would never successfully play again during that run of the
show. Now, if the Show Player notices a sequence in this invalid play state, instead of giving up
on trying to play the sequence, it will attempt to reset the sequence to clear out the problem so
that it can be played again.

In some cases, a seemingly random string of Chinese characters (seemingly not actual
meaningful Chinese text) would appear in LOR Control Panel's Status window. At least some
instances of this have been fixed.

If tooltips were disabled in the Sequence Editor, then the waveform cursor in the Pixel Editor did
not get displayed.

What's New in Version 4.3.2

Bug fixes

Bug fixes

The Visualizer would claim that "Time is running backwards" and would not enter simulation mode.
In SuperStar's Instant Sequence, themes with scenes would not mowve in some cases.

What's New in Version 4.3.0

CF50D in Insert Device

Blanking out channel settings in Delete Controller

Keys to view start or end of selection in the Sequence Editor
Pixel Editor can now create New sequence files

Pixel Editor playback window Always on Top

SuperStar fonts modified
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¢ New Pixel Editor effects

e Creating sequences directly in the Pixel Editor

e Nested prop groups

e Tracking marker on Pixel Editor's timeline/waveform
e Channel conflict checks

e Repeat in picture and text effects

e Minimum number of props decreased

¢ Bulb size in effect thumbnails

e Better thumbnails for Curtain and Fireworks effects
e New way to access prop and group definitions

e Effect Generator favorites improved

e Preview Design behavior changed

¢ Additional columns in Preview Info

e Default manual brightness in Effect Generator mixer
e Preview and Prop dropdowns wider

* Bug fixes

CF50D in Insert Device

The Sequence Editor's Insert Device dialog now can add CF50D devices to the sequence. Both
Cosmic Color Floods and UV Black Light Floods are supported.

Blanking out channel settings in Delete Controller

In the Channel Configuration screen of the Sequence Editor, the Delete Controller function used to
remove the channels of the selected controller from the track. You can now choose whether you
want that to happen or instead to leave the channels in place but blank out their settings (such as
unit ID and circuit).

Keys to view start or end of selection in the Sequence Editor

In the Sequence Editor, there are now keystrokes to move the display to ensure that the start or end
of the current selection is onscreen. Shift-Alt-Up and Shift-Alt-Down will display the first or last row
in the selection, respectively, and Shift-Alt-Left and Shift-Alt-Right will display the first or last column
in the selection, respectively.

Pixel Editor can now create New sequence files

The Pixel Editor can now create a new sequence file rather than just work with existing Sequence
Editor files.

Pixel Editor playback window Always On Top

A new option has been added to the Pixel Editor to force the playback window on top of all other
windows.

SuperStar fonts modified

Three SuperStar font files have been modified: The characters i, j, u, v, and w have been modified in
10-12x12_Thin.custom.font and 10-12x12_Thin.system.font, and the characters u, v, and w hawe
been modified in 10-12x12_Thin_Vertical.system.font.
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New Pixel Editor effects
Three new effects were added to the Pixel Editor: LinesVertical, LinesHorizontal, and Twinkle.
LinesVertical can be used to create marquee-style chase effects on rooflines, arches and frames.

You can use the Twinkle effect for a very slow twinkle, or a very fast strobe, and everything in
between.

Creating sequences directly in the Pixel Editor
You can now create new sequences directly in the Pixel Editor using the File > New menu item.
You no longer need to switch to the Sequence Editor to do this task. If your preview has props
where the Sequence Method=Sequence Editor, the channels for those items will automatically be
created in the LMS/LAS file and will be grouped by prop.

Nested prop groups

In the Pixel Editor, prop groups have a new arrangement option of "nested". In particular, this allows
nested stars to be grouped together and sequenced as a single item. Using this arrangement, the
Bar effect with direction=up mowes from the inside out. Bars left/right will mowve around all of the
nested props.

Tracking marker on Pixel Editor's timeline/waveform

As you mowe your cursor across the Pixel Editor's sequence grid, a marker is now displayed on the
timeline/waveform.

Channel conflict checks

In the Pixel Editor's Preview Info warnings box, all props are now checked for channel conflicts.
Previously only props with Sequence Method=Pixel Editor were checked.

Repeat in picture and text effects
For the Pixel Editor's picture and text effects, a repeat parameter was added. Default is "on" to
emulate previous functionality. Repeat=off causes just one scroll of the picture or text across the
screen.

Minimum number of props decreased
Changed the minimum number of props in a group in the Pixel Editor from 2 to 1. This allows you to
create a preview group (a prop group where the arrangement setting=preview) for a single frame or
wreath, which can be useful for certain effects like fire.

Bulb size in effect thumbnails

When effect thumbnails are displayed in the Pixel Editor, bulb size is now taken into account. This
is especially helpful for RGB floods.

Better thumbnails for Curtain and Fireworks effects

Better thumbnails are now generated for Curtain and Fireworks effects in the Pixel Editor.
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New way to access prop and group definitions

Prop and group definitions can now be viewed in the Pixel Editor by right-clicking on a prop name in
the sequence grid and then selecting "View Prop Definition" from the pop-up menu. It is no longer
necessary to go into preview design just to check on the definition of a prop.

Effect Generator favorites improved

In the Pixel Editor, icons are now displayed in the Effect Generator's favorites tree so that folders can
be easily distinguished from effects. Also, organizing the favorites tree is now accomplished by
right-clicking on any item in the tree. New actions have been added that allow items to be moved up
or down, copied, exported to a file, or imported. There is also now a help icon in the favorites area -
clicking on it provides detailed instructions on how to use and manage effect favorites.

Preview Design behavior changed

In the Pixel Editor's Preview Design, the prop list no longer scrolls if you modify a prop (as long as
the prop name is unchanged).

Additional columns in Preview Info

Columns for Sequence Method and Dimming Curve have been added to the Pixel Editor's Preview
Info grid.

Default manual brightness in Effect Generator mixer

When switching to manual brightness for the first in time in the Pixel Editor's Effect Generator's
mixer, the default brightness value has been changed from 0% to 50%. Previously, when switching
to manual brightness, nothing was displayed in the middle window because the brightness value was
0.

Preview and Prop dropdowns wider

The Pixel Editor's Effect Generator's Preview and Prop selection drop-downs were made wider, so
that longer names are \isible.

Bug fixes

* In some rare cases, SuperStar was reporting duplicate channels when comparing an LOR channel
and a DMX channel.

e When the maximum number of sequencing rows has been exceeded, SuperStar will now display
an error message and suggest increasing the sequencing grid's "Max Length".

¢ Setting SuperStar's manual clip rectangle was only working correctly if you did the mouse drag
from upper left to lower right.

¢ If you had DMX selected in SuperStar's Configuration dialog box, and had CCB selected in the
Layout dialog box, then "Export to Sequence Editor" was exporting invalid files.

¢ In SuperStar's Layout dialog box, some labels were changed: "CCR's" is how "CCR in Normal
Mode or CCB/CCP in Dual Normal Mode", and "CCB's" is now "CCB/CCP in Normal Mode".

e When creating an SD card for an MP3 Director in the Hardware Utility, sequences that only
contained lighting commands in Intensity Data could not be selected.
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e Users who participated in the original S4 beta releases (4.0.0 - 4.0.38) and who had Advanced
licenses were granted access as if they had purchased Pro. That access would have allowed the
user to set the 'Enhanced Network' for an LOR network ON. At the end of the Beta period, their
licenses reverted back to 'Advanced’, but the 'Enhanced Network' setting was still incorrectly set.

e [f you selected 1000K for the speed of an LOR network in Network Preferences, the "Enhanced"
checkbox would automatically become checked (as 1000K is currently only supported for
Enhanced networks). Howewer, Enhanced networks are not supported if the license lewel is less
than Pro, and so the network would not work, but also you would have no way to turn off the
Enhanced setting.

* In SuperStar, if you had a scrunched visualization, and were doing instant sequence, there were
cases where it would only use red, green, and blue; if there were white strings they would never
get any effects.

e SuperStar's Pixel Extender was being used in CCR mode if it was enabled. This has been
changed so that the Pixel Extender only does something if in Visualization mode.

* If a sequence's filename, or the name of the directory path it was in, contained any of various
characters such as a parentheses, and the sequence were used in an interactive group in a show,
the sequence would not properly be loaded when the group's trigger was pressed.

e The Sequence Editor's New and Open dialog was displaying the Recent tab's right-click popup
menu as a main menu (on the dialog's menu bar).

e [f using a visualization of a mega-tree made with the S4 Visualizer Tree Wizard, the auto-clip
region for SuperStar images was only using 12 rows of the mega tree. This caused images to get
clipped to the first 12 rows.

* If the audio path was not in the default path, SuperStar was not storing the path properly in the
sequence file exported to the Sequence Editor, and so the Sequence Editor would fail to find the
audio file.

* An error message is now displayed when SuperStar cannot find the visualization file.

e On some computers, the Pixel Editor's text effect would display text in the entry box but not in the
preview area. This has been fixed.

e [f errors occur in the Pixel Editor while calculating intensity data, a more detailed error message is
now displayed.

e For picture and text effects in the Pixel Editor, if movement is not "none", the initial positioning has
been fixed so that the text or picture starts off-screen and scrolls on-screen.

e For picture and text effects in the Pixel Editor, Peak-A-Boo movement now starts immediately.
Previously, the effect waited for a "peak-a-boo hold time" before the text or picture was first
displayed.

e When the selected prop is changed in the Pixel Editor's Effect Generator, the current effect now
restarts.

e The mouse wheel and keyboard shortcuts now work while a tooltip is displayed on the sequence
grid in the Pixel Editor.

¢ A potential Pixel Editor crash after double-clicking on a blank cell in the sequence grid was fixed.

e A Pixel Editor crash when any arrow key is pressed and nothing is selected on the sequence grid
was fixed.

e Preview Info warnings in the Pixel Editor now show network name instead of network number (i.e.
Regular, Aux A, etc), and unit id's are now displayed in hexadecimal notation.

¢ A Pixel Editor crash in the Effect Generator when bulb size is invalid was fixed.

e The Pixel Editor's Visualizer import so that it no longer generates invalid bulb sizes was fixed.

¢ Fixed string assignments for the Fan shape clockwise layout (-CW) (previously the strings were
reversed) in the Pixel Editor.

e When double-clicking on an effect favorite in the Pixel Editor to recall it, if that effect had manual
brightness, the brightness value was not being restored.

What's New in Version 4.2.10
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¢ |P Troubleshooter for PixConl6 devices
e Additional troubleshooting information in LOR Diagnostic

* Bug fixes

IP Troubleshooter for PixCon16 devices

If a PixCon16 is using Network Settings that are not compatible with the computer you are using,
you may not be able to configure it. The PixConl16 will appear in the list of devices, however
selecting it will produce an error stating that the board cannot be configured. When this occurs, the
Network Preferences now offers to start an IP troubleshooter which can try to fix the issue.

Additional troubleshooting information in LOR Diagnostic

LOR Diagnostic now collects additional information that may be useful for troubleshooting purposes,
via Windows Management Instrumentation (WMI). It collects some by default, and also now has an
"Advanced" screen that allows other WMI-based information to be collected.

Bug fixes

e The Pixel Editor's Fire, Fireworks and Meteor effects could have locked up (i.e. the effect freezes)
during the intensity calculation that occurs when a sequence is loaded. Once this happened,
those effects would be permanently frozen until the program was restarted.

e SuperStar's vertical matrix string pattern with the origin in the upper right or lower left was
importing backwards.

e The Pixel Editor could crash in rare instances while starting up.

What's New in Version 4.2.8

e Faworite names in Pixel Editor tooltips

e Changed display for shimmer and twinkle in the Pixel Editor
e New Pixel Editor option "Playback window is always on top"
* Bug fixes

Favorite names in Pixel Editor tooltips

If you hover over an effect on the Pixel Editor's grid, and that effect is a favorite, the favorite's name is
now shown in the tooltip.

Changed display for shimmer and twinkle in the Pixel Editor

The Pixel Editor now displays a hash pattern on shimmer and twinkle effects on props where the
Sequence Method is "Sequence Editor".

New Pixel Editor option "Playback window is always on top"

The Pixel Editor has a new menu option: Tools > Preview Playback > Playback window is always on
top. If you are displaying the preview in a separate window and you press one of the play buttons,
when this option is enabled it will cause the playback window to immediately gain focus. Testing
has shown that this will help on some computers, but on others it will cause playback to be worse
(more jerky). Use with caution!

Bug fixes
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e The Light-O-Rama Control Panel can be set to automatically launch when Windows starts up. It
was not doing this in exactly the manner that it should have, and if some other program (unrelated
to Light-O-Rama) were doing it in the same incorrect way, that program and the Light-O-Rama
Control Panel would interfere with each other's automatic launching settings.

e The first star channel in SuperStar's Configuration dialog box only allowed entries of 1-10 for the
channel's circuit ID. It has been changed to allow 1-11.

* In Superstar, CCR mode half ribbons would not export in intensity data format correctly.

¢ In SuperStar's Image mode, if you had manual clip set and did a left mouse click while holding the
Shift key to get the color of a pixel, it would also set the manual clip rectangle to that one pixel.
This was fixed so that you would now need to click and drag more than one pixel to do a manual
clip rectangle.

¢ In SuperStar's Scene mode or Image mode, if you do a left or right mouse click while holding the
Ctrl key, it sets or clears all the pixels. A warning box was added to ask if you want that to
happen.

e The Pixel Editor would hang while pasting when the number of rows in the clipboard was greater
than the number of writable grid rows.

e Grid tooltips no longer display in the Pixel Editor when the Effect Generator is open.

* Speed 0 has been removed from the Pixel Editor's Meteor effect, as it was not producing a useful
result.

e The Pixel Editor's calculation of intensity data for groups of traditional strings has been fixed.

e Playback in the Pixel Editor is now halted when switching tabs (i.e. when moving between
sequences).

What's New in Version 4.2.6

e CCB and Firefli options in SuperStar

e Faster E1.31 Universe Definitions in Network Configuration
e New system tray icons for LOR Control Panel

e Tooltips in the Pixel Editor's sequence grid

e Improved favorites display in the Pixel Editor

¢ Bug fix

CCB and Firefli options in SuperStar

The "CCB" and "Firefli" options are now back in SuperStar's Layout dialog box.

Faster E1.31 Universe Definitions in Network Configuration

Now while editing a universe in the Advanced mode of the Network Configuration program, you can
specify a total number of universes that should have these identical settings.

New system tray icons for LOR Control Panel

The LOR Control Panel now uses new icons in the system tray, which are visually more in line with
the new program icons recently introduced in version 4.2.4:

ann

Tooltips in the Pixel Editor's sequence grid

The Pixel Editor's sequence grid now displays tooltips similar to the way the Sequence Editor does.
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In fact it uses the same set of tooltip display preferences. So if you want to change the way the
Pixel Editor is displaying tooltips on the grid, then you will need to open the Sequence Editor and
select Edit > Preferences > Display Preferences from the menu. Updated tooltip preferences will be
read by the Pixel Editor whenever you open a sequence.

Improved favorites Display in the Pixel Editor

If the Pixel Editor's current effect is stored as a favorite, the favorite's name is now displayed instead
of the technical description below the Effect Generator button.

Bug fix

¢ When displaying props whose sequence method is "Sequence Editor" in the Pixel Editor's
sequence grid, in some cases the channel name would show "no matching channel" even though
the PE and SE physical channel information matched.

What's New in Version 4.2.4

¢ New PixConl16 Configuration field: Don't Create Universe Settings
e Pixel Extender can shrink as well as expand

e Decreased E1.31 comm usage

e CTBO04 in Add Device

e New sample visualization files

e "Cool White" vs. "Warm White" in SuperStar

¢ New program icons

e Display order of props in the Pixel Editor

e Configurable filename suffixes in the Pixel Editor

¢ Bug Fixes

New PixCon16 Configuration field: Don't Create Universe Settings

When updating the configuration of a PixCon16 board, the Network Preferences program can
automatically create the E1.31 multi-cast settings necessary to run the universes defined. However
some users may have already created these settings and may not want them created again. Setting
this option will bypass that automatic creation.

Pixel Extender can shrink as well as expand

The Pixel Extender feature in SuperStar can now shrink as well as expand. So now the "Number of
DMX Pixels" setting in the Configuration dialog box can be from 10 to 170 instead of from 50 to 170.

Decreased E1.31 Comm Usage

In some situations, when the lights for a DMX universe using E1.31 are all off, the Comm Listener will
now deliver fewer E1.31 packets than it had previously. This will result in less comm traffic on the
ethernet network, especially during long stretches of time when the lights are all off (for example, idle
time between shows).

CTBO0O4 in Add Device

An option to add a four-channel LOR device (such as the CTB04) has been added to the Sequence
Editor's Add Device dialog.
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New sample visualization files

Two new sample visualization files, 24x50Tree_8RowGlobe_BottomControllers.lee and
24x50Tree_8RowGlobe_DMX BottomControllers.lee, have been added.

"Cool White" vs. "Warm White" in SuperStar

"Cool White" and "Warm White" selections were added to the Configuration dialog box in SuperStar.
Some ribbons/strings are a cool white (they look bluish white when fully on) and some are a warm
white (they look yellowish white when fully on). Set this setting appropriately to best get your lights
to have colors that match the colors you saw on the computer screen when you made the sequence.

New program icons
The various programs now have new main icons. It should now be easier to tell apart the various
programs in your task bar (and elsewhere). For example, here is an image of the taskbar with icons

for the Comm Listener, the Sequence Editor, the Hardware Utility, the Visualizer, and the Pixel
Editor:

B8N a

Display order of props in the Pixel Editor

In prior versions of the Pixel Editor, the order in which props were displayed in the sequence grid was
fixed. You still can't change the order of individual props, but now you can change the order by type
of prop. To do this, click on the "Props" button - located just to the left of the timeline, above the
sequence grid. In the "Select Props" window you can change the "Display Order" drop-down
selections to suit your needs. As an example, this feature can be used to mowve your beat track from
the bottom of the grid to the top.

Configurable file name suffixes in the Pixel Editor

In prior versions of the Pixel Editor, when using File > Save As from the menu a suffix of "-Copy" was
added to the end of the original file name. This suffix is now configurable by going to Tools >
Preferences > Save As. One of the options is to add a suffix that contains the date and time, which
makes it very useful for creating backup copies of your sequence.

Bug fixes

e When updating the configuration of a PixCon16 board, the Network Preferences program may
occasionally throw an error 523 - Update Failed. If you subsequently check the configuration of
the board, you'll see that the configuration actually succeeded. This is due to an incorrect check
that was being performed.

¢ In SuperStar, visEffects would not work in floating windows after resizing the window.

¢ The number of matrix rows for a horizontal snake matrix in SuperStar was not correct. This made
it so the default clipping rectangle for the smooth effects was often too small.

¢ In SuperStar, a \ertical snake matrix was not being imported correctly.

e The Pixel Editor no longer crashes if the "Arial" font is missing or corrupted, although you will be
unable to add or edit props until the Arial font is restored.
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¢ The logic that refreshes the Pixel Editor's sequence grid during playback has been improved. As a
result, playback's "Force Refresh" option is no longer required and has been remowed.

What's New in Version 4.2.2

e Change to starting the Control Panel while an instance is running

e Page Left and Page Right in the Sequence Editor

e Support for 340 pixels on a PixCon16 port

e Simplified PixConl6 configuration

e Faster response times when searching for and configuring PixConl16s
e New DMX addressing options in SuperStar

e Pixel Extender in SuperStar

* Bug Fixes

Change to starting the Control Panel while an instance is running

There's nothing stopping a Windows user from trying to start a program any number of times, but
only one instance of the LOR Control Panel should be running at any given time. So, in previous
versions, if the Control Panel were started while another instance of it was already running, the
newly-started instance would simply stop, allowing the already-running instance to continue being
the sole running instance.

In some situations, this could be confusing, because it might seem to the user that they told the
Control Panel to start, and nothing happened. To address this issue, now, instead of just stopping,
the newly-started instance will first send a message to the already-running instance, causing the
already-running instance to display its status window, and also to refresh its icon in the computer's
system tray, in case it had disappeared for whatever reason.

Page Left and Page Right in the Sequence Editor

In the Sequence Editor, the Ctrl-Left and Ctrl-Right keys now operate as Page Left and Page Right.
Ctrl-Shift-Left and Ctrl-Shift-Right do the same but expand the selection instead of moving it. Also,
although Page Up and Page Down functionality was already covered by the Page Up and Page Down
keys, for the sake of consistency, Ctrl-Up and Ctrl-Down now operate as Page Up and Page Down
(similarly, Ctrl-Shift-Up and Ctrl-Shift-Down as Shift-Page Up and Shift-Page Down).

Please note that unlike in the Page Up/Page Down case, there is not necessarily any relationship
between a "page" and the cells. That is, for Page Up/Page Down, one "page" consists of a certain
number of cell rows - i.e. a certain number of channels. But for Page Left/Page Right, one "page”
consists of a certain length of time, not a certain number of cell columns - i.e. a certain number of
timing marks. Timing marks can be anywhere, willy-nilly, or even nowhere, and do not necessarily
have any relation to the page. So, as compared to Page Up/Page Down, it may be more difficult to
predict exactly where your selection will move or expand to after a Page Left/Page Right.

Support for 340 Pixels on a PixCon16 port
The PixConl16 configuration now allows for a maximum of 340 pixels per port.
Simplified PixCon16 Configuration

Seweral changes have been made to the process and dialog boxes for PixConl6 configuration in an
effort to simplify them. Boards that were configured with earlier versions of Showtime will be
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automatically converted to the new configuration. However there could be some incompatibility
between the old version and the new. You should carefully review your boards configuration the first
time it is edited in this new version.

To prevent future incompatibilities, once you have edited the configuration of a PixCon16 in the
Network Configuration, you should not use the PixConl6 assistant program in the future. If you do
use the PixConl6 Assistant program, be sure to double check your configuration to ensure that
settings were not changed.

Faster response times when searching for and configuring PixCon16s

The Network Configuration program used very conservative timing when searching for PixConl16
boards and during the load/save of the board's configuration. Those times have been shortened and
improve performance.

New DMX addressing options in SuperStar

Three new DMX addressing options were added to SuperStar's Configuration dialog:

¢ Tightly Packed: Uses all 170 channels available in each universe. Strings can have transitions to
the next universe in the middle of the string.

e Semi Packed: Puts as many full strings as will fit into each universe. Strings will not have a
transition to another universe in the middle of a string.

¢ Not Packed: Each string starts with a new universe.

Pixel Extender in SuperStar

The new Pixel Extender in SuperStar's configuration dialog box makes it so you can export 50 pixel
CCR sequences to DMX strings of any length from 50 to 170 pixels. This will make all the 50 pixel
CCR sequences that have been written transportable to displays that have DMX strings that have
more than 50 pixels.

Bug fixes

e After configuring a PixConl6 board, the user is asked if they would like to create the E1.31 entries
in the Network Configuration for the DMX Universes in use on the board. However in versions
previous to this, the 4 bridge port entries were not created even if they were in use.

e Using Instant Sequence rapid fire on 13 or more rows would cause a crash in SuperStar.

e If a DMXfixture that was not part of a prop were used in SuperStar, it could cause an invalid name
to be put in for the fixture, leading to the Sequence Editor being unable to load the exported
sequence.

* If SuperStar were unable to load the visualization at startup, it would cause a "failed to load
visualization" error every time it was launched. It will now instead change to use the default
visualization (which is "Sample.lee").

* If you had entered an invalid number in the "Sensitivity" or "Length of Effects” fields in SuperStar's
Timing Map dialog box, the invalid value would get saved to a file, and every time you launched or
shut down SuperStar, you would get a warning message saying that the value needs to be in the
range 1-10.

* The Sequence Editor is supposed to remember the last used paste mode even between separate
runs of the program, but a bug was causing it to always start up as "Paste by Cell".

What's New in Version 4.2.0
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e Warnings for incorrectly configured triggers

e New 1000K speed for LOR Networks

e New 1000K speed when creating SD cards for G3 MP3 directors
e Saving custom colors in SuperStar

¢ Flipping images in SuperStar

e Wait cursor during visualization loading

¢ New advanced option when creating SD cards for MP3 directors
e New 'comment' fields for Networks and Universes in Network Configuration
e PixConlé6 in Insert Device dialog

e PixConl6 Version V1.4.8 Firmware Support

¢ New pasting options in the Sequence Editor

e Merge Intensity Data Files in SuperStar

e Floating sequencing grid in SuperStar

e Memory usage improvements in the Pixel Editor

¢ File References in the Pixel Editor

e Windows Jump List compatibility for the Pixel Editor

¢ Maximum font size increase in Text effect

¢ New repeat mode option in Curtain effect

¢ Pixel Editor's Preview List window is resizable

e Prop Copy window remembers last position

e RGB channels for Insert Device's DMX Universe option

e Hardware Utility support for 50W Cosmic Color Floods

e Exporting and importing Pixel Editor props

e Importing Visualizer files to existing Pixel Editor previews

e Accumulation in Snowflake effect

¢ Allow for some PixConl6 configuration updates with older software
e Maximum images in SuperStar increased

* Bug fixes

Warnings for incorrectly configured triggers

If your trigger (no matter whether a show startup trigger or an interactive group trigger) is configured
to use a network that does not have a comm port set in Network Configuration, the Verifier will now
warn you with the new warning message number 53, "Trigger uses undefined network".

Also, since triggers are not supported on LOR Enhanced networks, the Verifier will now issue the
new warning message number 54, "Trigger uses LOR Enhanced network", if a trigger using such a
network is found.

Finally, despite the fact that triggers are not supported on LOR Enhanced networks, they can still be
tested on such networks by using the Hardware Utility. They will not, however, work during your
show. Therefore, if you have any LOR Enhanced networks designed, the Hardware Utility's input
testing screen will warn you about this fact.

New 1000K speed for LOR networks

A new speed of 1000K has been added for LOR Networks in the Network Configuration. Currently
only the PixCon16 board running on an Enhanced LOR Network can run at this speed.

New 1000K speed when creating SD cards for G3 MP3 directors

A new speed of 1000K has been added to the Hardware Utility when creating SD cards for G3 MP3
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directors. To use the new speed, you must have a G3 MP3 director with updated firmware. The only
device that can currently run at 1000K is the PixConl6 in Enhanced LOR mode.

Saving custom colors in SuperStar

In SuperStar's Color Picker dialog box, you can now save custom colors.

Flipping images in SuperStar

You can now "Flip Left-Right" and "Flip Up-Down" for images in SuperStar.

Wait cursor during visualization loading

When loading a visualization in SuperStar, a wait cursor now appears.

New Advanced Option when creating SD cards for MP3 director

A new option has been added to the Advanced Options of the SD Card creator in the Hardware
Utility. The new option lets you optionally set the throughput efficiency of the MP3 director.

New 'Comment’ fields for Networks and Universes in Network Configuration

A new comment field has been added for each Network or Universe that can be configured in the
Network Configuration program.

PixConl16 in Insert Device dialog

The Sequence Editor's Insert Device dialog now has a PixConl6 option, which can be used to insert
PixConl6 devices.

PixCon16 Version 1.4.8 Firmware Support

The software now supports version 1.4.8 firmware of the PixConl16. This is a minor firmware revision
that only changes how the status and power lights work, and includes no other new functionality.

New pasting options in the Sequence Editor

In previous ersions of the Sequence Editor, there was a "Paste from Foreground" option. [f it were
turned on, then when you pasted, only the copied effects that were not completely off would be
pasted. This sort of control has now been expanded into the "Paste From/To" options: In addition to
Paste from Foreground, you can now also Paste from Background (i.e. pasting only the copied
effects that are completely off), and also Paste to Foreground (paste only onto effects that are not
completely off) and Paste to Background (paste only onto effects that are completely off). You can
even combine the "from" and "to"; for example, paste from foreground to foreground.

Merge Intensity Data Files in SuperStar

SuperStar now has support for merging intensity data files.

Floating sequencing grid in SuperStar

In SuperStar, you can now put the sequencing grid and the \visualization each in their own floating

© 2015 Light-O-Rama, Inc.



What's New? 31

window. Before, there were cases where the visualization would be very small. This gives control over
the size of the region used for the sequencing grid, and the size of the region for the visualization.
Also, if you have two monitors you can move the sequencing grid to one monitor and the
visualization to the other monitor.

To activate the feature, click on the "View" menu and select "Floating Windows".

Memory usage improvements in the Pixel Editor

Memory used by the Pixel Editor has been dramatically reduced. This should allow you to easily
open longer sequences with more pixels and more prop groups. Memory used is now proportional to
the total length of the effects populated in the sequence.

File References in the Pixel Editor

There is a new menu option in the Pixel Editor: Sequence > File References. This will open a window
that lists all files referenced by Movie and Picture effects. It also has an option to specify a new
location for those files - which can be useful if you move your sequence directory.

Windows Jump List compatibility for the Pixel Editor
The Pixel Editor is now compatible with Windows' "Jump List" feature. If you pin the Pixel Editor to

the task bar and right-click on it, you will see a list of recently opened LMS/LAS files from which you
can select.

Maximum font size increase in Text effect

In the Pixel Editor's Text effect, the maximum font size has been increased. This allows for larger
and more readable text, especially for matrices with less than 10 rows.

New repeat mode option in Curtain effect

The Pixel Editor's Curtain effect has a new repeat mode option: repeat_at_speed_rotate_colors. This
causes the curtain to display with a different color in your palette every time it opens.

Pixel Editor's Preview List window is resizable

The Pixel Editor's Preview List window is now resizable.

Prop Copy window remembers last position

When you open the Pixel Editor's "Prop Copy" window, it opens at the size and position that you
last had it open.

RGB Channels for Insert Device's DMX Universe option

When adding a DMX universe through the Sequence Editor's Insert Device dialog, you can now
optionally add RGB channels instead of regular channels.

Hardware Utility support for 50W Cosmic Color Floods

The Hardware Utility now is able to correctly identify 50W Cosmic Color Flood controllers.

© 2015 Light-O-Rama, Inc.



Light-O-Rama v4.3.4

Exporting and importing Pixel Editor props

The Pixel Editor now can import and export preview props. This allows you to export props from one
preview and import them into a different one. It also allows you to share your props with others.

Importing Visualizer files to existing Pixel Editor previews

The Pixel Editor has had the ability to import a Visualizer (.LEE) file into a new preview. Now you
can also import into an existing preview.

Accumulation in Snowflake effect

The Pixel Editor's "snowflake" effect has an additional parameter to control snow accumulation.
Please note that in order to accommodate this change, the meaning of the first and second palette
colors in the snowflake effect have changed. Now, the first color is always the main color and the
second color is the highlight color. In versions 4.1.2 and prior, the first color was the highlight color
the second color was main color for flake types larger than single-pixel flakes.

Allow for some PixCon16 configuration updates with older software

When needing to update the configuration of a PixCon16, the Network Configuration program would
look at the Firmware Revision of the board to decide if it could be used to update that board or not.
Howe\er, in the future there could be firmware updates that do not require changes to the Network
Configuration program. This would force a user to update LOR Showtime for no other reason than to
use a hew PixConl6 firmware.

Now if the board revision is found to be greater than 1.4.6, additional checks are performed to see if
an older version of software can successfully update the board.

Maximum images in SuperStar increased

The maximum number of images in SuperStar has been increased from 1000 to 1500.

Bug fixes

¢ After version 3.12.2, the 'Advanced Settings' button was inadvertently remowved from the final
options of writing an SD card in the Hardware Utility. The button has been returned.

¢ |f the SuperStar configuration file SSEdit.cfg did not exist when SuperStar was launched, the
program would crash. This could happen on a fresh install to a computer that has never had the
Light-O-Rama Software Suite installed on it.

¢ If a sequence having a Windows shell command were changed to no longer use any such
command, the command would be eliminated from LOR's internal list of known commands. This
would have the intended effect that the sequence would no longer cause the command to run, but
it would also have an unintended side effect: If you were to restore a backup of your sequence
sawe file, which still was supposed to use the command, that restored old version would also not
run the command. Moreovwer, if any other sequences had been using the same command (which
would have required manual modification of the sawe files), they also would no longer run it. Now,
instead of eliminating the command from LOR's list of known commands, the command is merely
eliminated from the sequence itself.

* In the Sequence Editor, if you tried to copy, cut, or paste in a loop lewel, a bizarre and minimally
comprehensible error message would appear. It now more clearly states that you cannot copy,
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cut, or paste loop lewels.

e [f the user attempted to edit a Network or Universe that was using advanced parameters while in
Simple mode, the Network Configuration program could leak resources and/or refuse to end
properly.

e The Comm Listener port could not be changed in the Network Configuration program while in
Simple mode.

e The Comm Listener port, as well as the 'Send To' Port on a DMX Universe when using E131 was
not validated and could be set to nonsensical values. The value is now checked to ensure it is
numeric and between 0-65535.

¢ In very limited circumstances after an upgrade from a beta version, the Network Configuration
program would refuse to start and give a cryptic 'Runtime Error 380" and/or 'Invalid Property' error.
This error has been resolved.

¢ Depending on the source sequence, an SD card written by the Hardware Utility could have been
incorrectly throttled leading to out of sync sequences when run on a MP3 director. SD cards
created by earlier versions of S4 should be re-created with this version.

¢ In the Insert Device dialog of the Sequence Editor, the DMX Universe option would not pay
attention to the "Name" field. It would instead always name the channels as if you had selected a
name of "DMX".

* When using the Advanced Rendering Engine, the Visualizer was ignoring the Max Opacity setting
of RGB Flood Light fixtures. A bug fix in Version 4.1.2 for the same root cause failed to fix the
problem for RGB floods.

e Importing a visualization into SuperStar would sometimes report nonexistent errors.

* In SuperStar's Configuration dialog box, the unit ID and start channel of the star were reverting to
original numbers if you clicked on the "LOR" or "DMX' radio buttons.

* In SuperStar, the "matrixlength" keyword was not working if the prop used row/column
coordinates.

* In SuperStar, group modify for scenes used in the star were not being modified.

* When exporting the SuperStar display as intensity files, all the channels in the 16 channel
controller that controls the star were being exported. Now, only the six channels used to control
the star are exported. This is important because if the other channels in the controller for the star
are used to control other lights, then the blank intensity data for those channels would make them
shimmer and blink.

e When exporting the SuperStar display in Legacy format, made it so that only the channels defined
in the visualization file are in the export.

* In SuperStar, when using morphs with a visualization, only the 1a and 1b morph anchor labels
were being displayed in the visualization. This has been fixed so that the 1a, 1b, 2a, and 2b labels
are drawn. In addition, lines are drawn between the labels in the same manner as they are drawn
in the sequencing grid. If using a matrix or tree made of RGB lights this can make it easier to
specify morphs by clicking on the \isualization instead of the sequencing grid.

e Bugs in the Pixel Editor's drawing of the red playback marker have been fixed. Users have a new
menu option: Tools > Playback Options > Fast Playback Marker. Normally, this option should be
enabled/checked, as it uses the least system resources. Howeer, if you are using a tool such as
Screencast-O-Matic, the red playback marker may still display incorrectly. In this case, turn the
"Fast Playback Marker" option off (uncheck), and the grid and playback marker will display
normally - even during screencast recording.

e [f you built the sequence that is part of the Pixel Editor Introduction (video or PDF presentation), in
the final version with the cross-fades the effects reset at the end of the ramp up and at the start of
the ramp down. This is especially noticeable in the Countdown effect. This has been fixed - so the
ramp-up, full intensity, and ramp-down are considered one continuous effect.

¢ Improvements to the Pixel Editor's Spiral effect: no more gaps on 100% thickness, fully consistent
as rotation is changed, Show 3D can now trail either left or right, and spirals are spaced more
evenly.

e Animation sequences (LAS files) with large numbers of pixels did not always play back in the
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Pixel Editor at the correct rate. This has been fixed.

e A Pixel Editor crash could occur while audio was being loaded if the audio contained a sample
with the absolute minimum value. This has been fixed. It was noted in the "Open Beta Bug
Reports" forum as bug SCO08.

¢ Fixed a few remaining Pixel Editor screen layout issues on high resolution displays - any time
Windows' "Text Resolution" setting is greater than 100%.

e The firmware for PixConl6s was using the LHX extension, however these firmware files can not be
loaded by the Hardware Utility, they must be loaded by the Network Configuration program. The
extension was changed to NHX to prevent confusion.

What's New in Version 4.1.2

Automatically switch to new timing grid
New Candy-Cane shapes in Pixel Editor
Consolidated list of props in Pixel Editor's Preview Info

Bug Fixes

Automatically switch to new timing grid

When creating a new timing grid in the Sequence Editor, you can now optionally have the active
track automatically switch to using the newly created timing grid.

New Candy-Cane shapes in Pixel Editor

The Pixel Editor's Prop Definition window now has selections for candy-canes, both left and right
facing.

Consolidated list of props in Pixel Editor's Preview Info

A consolidated list of all props with their associated channel information has been added to the Pixel
Editor's Preview Info window (accessed from the Tools > Manage Previews menu). There is a Copy
button that will put all of the channel information on the clipboard so it can be pasted into Excel, or a
similar spreadsheet program.

Bug fixes

¢ When using the Advanced Rendering Engine, the Visualizer was ignoring the Max Opacity setting
of Flood Light fixtures.

¢ In the Pixel Editor, if the user attempted to save a color palette with a name that already existed
the program could crash.

e An error was introduced in 4.1.0 in the Pixel Editor when importing a Visualizer .LEE file with
duplicate prop names.

¢ In the Pixel Editor, if the user changed the string type from Traditional' to 'RGB' in the prop
definition window, the Pixel Editor could crash.

What's New in Version 4.1.0

Pixel Editor documentation

The Sawed Palettes option of the Pixel Editor has mowved
Additional clip rectangle group modify support in SuperStar
Enhanced naming in SuperStar

Enhanced sparkle in Effect Generator
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e Centering for bar effect
e Clarified Instant Sequence defaults

* Bug fixes

Pixel Editor documentation

Documentation for the Pixel Editor, which was previously distributed as a standalone file, is now
integrated in this help file.

The Saved Palettes option of the Pixel Editor has moved
Previously, there was a separate option the Tools menu where you could delete/copy/rename your

Saved Palettes in the Pixel Editor. This function has been mowed to inside the Effect Generator's
'Star' menu and called 'Manage Palettes'.

Additional clip rectangle group modify support in SuperStar

Support of clip rectangle group modify was added for shockwave, spiral, and fan smooth effects in
SuperStar.

Enhanced naming in SuperStar

The naming of the wrapped tree visualization file and the wrapped guide text file in SuperStar have
been enhanced so that all parameters of the wrapped tree are encoded in the name.

Enhanced sparkle in Effect Generator

The slider for the sparkle setting in the Pixel Editor's Effect Generator has been changed so that the
value can change over the course of the effect.

Centering for bar effect

A "Center" parameter has been added to the Pixel Editor's bar effect. Now the center point can be
adjusted for expand and compress variations of the effect.

Clarified Instant Sequence defaults

In SuperStar's Instant Sequence dialog, the buttons "Set TCM Defaults 1" and "Set TCM Defaults 2"
have been replaced by "Set Normal Defaults"and "Set Rapid Fire Defaults".

Bug fixes

* In some situations, for sequences that have animations, deleting a controller or channels in the
Sequence Editor would lead to various errors, for example a "subscript out of range" error. Such
errors would not necessarily occur only in the Animator; the fact that the sequence had an
animation would cause the problem elsewhere as well.

e The Pixel Editor's startup check for the correct version of OpenGL has been fixed. The user can
no longer open sequences if the version of OpenGL is less than 1.5.

e The Pixel Editor would not correctly handle when a pixel string had more channels than the "max
channels" setting.

* After a Visualizer import, a bug in Prop Definition could cause the Pixel Editor to crash.

e The Pixel Editor was assigning the wrong unit ID on CCRs during Visualizer import.
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e The Pixel Editor was not correctly handling Visualizer import when one or more channels had a
device type of "none".

* When loading a sequence file, the Pixel Editor would only read the first track.

e The "More Info" button in the Pixel Editor's Sequence Editor migration tool now displays
messages in a scrollable window. Previously, if there were a lot of messages, the window size
could exceed the screen size.

¢ Display of the starting channel number in the Pixel Editor's Prop Definition is suppressed if the
corresponding string number is skipped in the custom prop grid.

What's New in Version 4.0.38

e Undo and redo in the Pixel Editor preview design
e Pixel Editor prop definition window resizable
e Pixel Editor documentation

* Bug fixes

Undo and redo in the Pixel Editor preview design

The Pixel Editor's preview design now has undo and redo capability. This applies to prop movement,
but not to adding or deleting props.

Pixel Editor prop definition window resizable
The Pixel Editor's prop definition window is now resizable.
Pixel Editor documentation

Documentation for the Pixel Editor is now available. It has not yet been worked into this help file
document, but can be found on the web at:

http://www.lightorama.com/help/LORPixelEditorHelp. pdf

A copy of the document is also distributed by the installer. It can be found in the Light-O-Rama
program files directory, which is typically, but not always, either C:\Program Files\Light-O-Rama or
C:\Program Files (x86)\Light-O-Rama.

Bug fixes

The Pixel Editor was unable to load some large sequences when attempting to migrate channels.
Drawing of timing marks in the Pixel Editor was not working correctly on high DPI displays.

The Pixel Editor would crash when the device type was set to Unconnected/None in the prop
definition.

e Some bugs in the movement options of SuperStar's Instant Sequence dialog box were fixed.

What's New in Version 4.0.36

Relaxed requirements for Cosmic Color Devices in Visualizer
Better 'Force to Front' handling in the Visualizer

Control Sequence Editor Play/Stop during Visualizer simulation
Sequence Editor performance improvements

Clip Rectangle in SuperStar

Rotate Selected Image in SuperStar
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e Prop rotation handle in the Pixel Editor
Adjustable Pixel Editor background image brightness
e Zooming in the Pixel Editor

Bug fixes

Relaxed requirements for Cosmic Color Devices in Visualizer

In previous versions, when simulating Cosmic Color Devices, the Visualizer required that the fixture
when assembled had exactly 50 pixels with no gaps. CCDs now instead follow the relaxed rules
that DMX Pixel Universe fixtures follow. That is, you can skip pixels and/or use less than 50 pixels.

Better 'Force to Front' handling in the Visualizer

When using the Visualizer's 'Force to Front' option along with channels that required the use of the
Listener, the Visualizer could not be set back into the background. This was because of periodic
data messages the Listener is required to send, even if no data is changing. These periodic updates
would force the Visualizer back to the top even if no sequence was currently running. Instead now
the Sequence Editor sends a separate message to the Visualizer to tell it that you are starting play
of a sequence. This will only happen once when you start the sequence, allowing the Visualizer to
be pushed back into the window stack afterward.

Control Sequence Editor play/stop during Visualizer Simulation

When the Visualizer is placed in Simulation mode, two new buttons have been added that allow you
to start and stop playing the active sequence in the Sequence Editor. To start the active sequence
press the 'Play SE' button. This performs the same action as if you went to the Sequence Editor's
'Play’' menu and then selected 'Start This Sequence'. To stop the play of a sequence, press the

'Stop SE' button.

Sequence Editor performance improvements

Version 4.0.34 introduced changes that decreased the loading times of sequences (for example, in
the Sequence Editor). Unfortunately, these changes also increased the length of time that various
other things took, including, notably, saving, exporting, importing, and opening the right-click popup
menu on a channel group button. These things have been sped up again, including some that are
now even significantly faster than they had been before version 4.0.34 slowed them down. For
example, on a certain huge sequence on a certain machine, saving took about 16 seconds before
4.0.34, but 142 seconds in 4.0.34, and is now back down to about 16 seconds again; importing a
certain huge configuration file took about 518 seconds before 4.0.34, 663 seconds in 4.0.34, and
now takes about 85 seconds; opening the right-click popup menu took about seven seconds before
4.0.34, and about 39 seconds in 4.0.34, and is now basically instant.

Clip Rectangle in SuperStar

"Clip Rectangle" has been added to SuperStar's Image Group Modify dialog box.
Rotate Selected Image in SuperStar

"Rotate Selected Image" has been added to SuperStar's Image setup dialog box.

Prop rotation handle in the Pixel Editor
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In the Pixel Editor's preview design, props are now displayed with a rotation handle to the right of the
selected prop (similar to the Visualizer). Just grab the handle and drag it with your cursor to rotate
the prop. Note that only one prop can be selected for the rotation handle to be displayed.

Adjustable Pixel Editor background image brightness

The brightness of the Pixel Editor's preview's background image can now be adjusted from the main
window. With a sequence open, click on the small down arrow next to the preview name. Select
"Background Image" from the dropdown menu, then select the desired brightness (10% - 100%).
Note that this setting only affects image brightness during preview playback; image brightness during
preview design is a separate setting.

Zooming in the Pixel Editor

Zoom in and zoom out buttons have been added to the Pixel Editor's sequence toolbar (the same
buttons that are in the Sequence Editor). You can still zoom in and out using the previous methods
- dragging over the waveform to zoom in, and right-clicking on the waveform to zoom out - but there
are now two ways to zoom.

Bug Fixes

¢ In the Sequence Editor, in some situations, certain actions such as grouping channels would
cause the track to stop being displayed.

¢ In some situations, inserting channels in the Sequence Editor would not work.

e Some movement patterns in SuperStar's Instant Sequence were not behaving properly.

What's New in Version 4.0.34

Channel-related performance improvements

Cosmetic changes for Network Configuration program
Change Intensities

New CB100D Firmware

New CMB16D Firmware

Verifier checks for recommended Show Player options
Slider in Pixel Editor Effect Generator upgraded

Bug fixes

Channel-related performance improvements

Changes have been made to improve performance related to channels, RGB channels, and other
channel groups. For example, a certain enormous sequence which previously took 143 seconds to
load on a certain machine now takes 81 seconds on the same machine. The vast majority of the
remaining time is taken by loading effect events within channels, as opposed to loading the channels
themselves, and the Smooth to Fades tool can be put to good use on the effect events of this
particular sequence: The same sequence, but modified via the Smooth to Fades tool, used to take
82 seconds to load before this performance improvement (as opposed to 143 without Smooth to
Fades), and now takes 19 (as opposed to 81 without Smooth to Fades).

Cosmetic changes for Network Configuration program

Various small changes have been made to the Network Configuration program to simplify its use.
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For example, the X10/Dasher and Options tabs have been combined into a single new tab called
'Misc'. These changes are cosmetic only and do not change any functionality.

Change Intensities

The Sequence Editor now has a Change Intensities command, which can be used to change the
intensities in the selected area in a wide variety of ways. For example, you can add to or subtract
from intensities, impose caps or floors, and scale them (for example, double them or halve them).
The tool can be set up to apply to all channels or only to certain types of channels (for example, to
RGB channels' red channels).

You can access the Change Intensities tool via the Change Intensities submenu of the right-click
context menu.

New CB100D Firmware

Version 1.21 of the Cosmic Color Bulb/Cosmic Color Pixel firmware has been released. This version
fixes a problem with LOR Enhanced mode and the last channel (310) of the unit not working when in
Extended ID Mode.

New CMB16D Firmware

Version 1.34 of the CMB16D 16 Channel DC controller firmware has been released. This new
firmware will continuously read the status of the address switches so the Hardware Utility can no
longer be used to update the Unit's ID. This change also allows for the CMB16D to now have a
speed setting while in stand-alone mode. Setting an address that starts with F (FO-FF) will actually
make the unit's ID 01, and the second digit (0-F) will control the speed of the stand-alone program
running from 0:Slow to F:Fast.

Verifier checks for recommended Show Player options

The Show Player options Use Compressed Sequences and Show Player Memory Restarts (both
accessible via the LOR Control Panel's right-click popup menu) both, when enabled, give possible
benefits while causing no drawbacks. They are thus both recommended to always be enabled. The
only reason the option to disable them is given is as a sort of "safety" in the case of some
hypothetical, unforeseen bug, so that if you have some very specific reason to believe that one of
them is causing a problem, you can turn it off. The Verifier now checks to see whether or not they
are enabled, and if not, issues warning messages saying so (messages number 51 and 52,
respectively).

Slider in Pixel Editor Effect Generator upgraded

In the Pixel Editor's Effect Generator, many effects use a slider to control effect behavior. In this
release, the slider has been upgraded to allow the setting of a start value (effective when the effect
begins) and an end value (effective when the effect completes). This allows you to do such things as
having a spiral slow down or speed up during the course of the effect.

The top of the slider (green) represents the start value. The bottom of the slider (red) represents the
end value. By default, the start and end values are locked together. To specify different start and
end values, the slider must be unlocked. This is done by double-clicking anywhere along the slider.
When unlocked, the top and bottom pointers can be moved independently. To relock, just double-
click the slider again.
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Bug fixes

* In SuperStar, strings of lights that are not CCDevices or DMX pixels were always being given the
incandescent dimming curve. Now the strings use the LED dimming curve if they are RGB dumb
strings or if they are specified as LED in the channel dialog box of the Visualizer.

e The LOR Control Panel's status window would not show log messages that occurred while the
status window was itself not displayed.

¢ In rare circumstances, the Pixel Console of the Hardware Utility could refuse to control pixels on a
DMX Universe, if an unrelated LOR Network adapter had a problem.

¢ \When using the Pixel Console on an LOR unit in Enhanced LOR Mode, the last pixel (#100) could
not be fully controlled.

¢ The Pixel Editor requires video drivers supporting OpenGL version 1.5 or later. If a PC did not
support this, the Pixel Editor would crash when opening a sequence. Now, the Pixel Editor
instead detects this situation, gives the user an informative message when the Pixel Editor starts,
and disables the opening of sequences.

¢ A bug in the movement of scenes when using the Rapid Fire trigger in SuperStar's Instant
Sequence was fixed. If it was more than one pixel, the scenes could get messed up when
traversing over an unused area.

What's New in Version 4.0.32

e Change Effect Type
e Test Tracks' Physical Lights
e Background image can be displayed during main window playback

* Bug fixes

Change Effect Type

The Sequence Editor's right-click context menu now has a "Change Effect Type" submenu that can
be used to change the effect types of all the events in the selected area of the sequence, while
keeping their intensities the same. For example, a fade up from 0% to 37% followed by an intensity
of 37% can be changed to a twinkling fade up from 0% to 37% followed by a twinkle of 37%.

Test Track's Physical Lights

The Sequence Editor's right-click context menu on a track grid now has a new submenu "Test
Track's Physical Lights”. Using the various items in this submenu, you can make the physical lights
for all of the channels in the track turn on, off, shimmer, or twinkle, or else do whatever the sequence
says they are supposed to do at the time that you clicked in the track grid.

Background image can be displayed during main window playback

In the Pixel Editor, the background image for the preview can now be displayed during main window
playback. This feature is controlled via a new menu option: Tools > Preview Playback > Show
background image.

Bug fixes
e [fthe Sequence Editor's "Test Physical Channels" command were used on a Cosmic Color

Device, commands would be sent not only to its pixels, but also to its macro channels, potentially
leading to strange results. The commands are now only sent to pixels, skipping the macro
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channels. Howewer, note that it is possible to control an actual physical Cosmic Color Device from
the Sequence Editor without the Sequence Editor knowing that it is a Cosmic Color Device; the
macro channels will only be skipped if the Sequence Editor knows that the channel group
represents a Cosmic Color Device (for example, if it had been added to the sequence as a CCD
via Insert Device).

* If the Sequence Editor's "Test Physical Channels” command were used on a channel group or
RGB channel (as opposed to on a single channel), it would be needlessly inefficient with the
commands it sent to the lights over the comm line. This wouldn't have a noticeable effect in most
cases, but it could possibly cause lagginess if a very large number of channels were in the
channel group.

¢ In the Pixel Editor's Visualizer import, LOR unit IDs greater than 09 were not imported correctly.

¢ In the Pixel Editor's Visualizer import, channel settings for bundles/superstrings were not used
during playback, even though they were displayed properly in the prop setup window.

¢ In the Pixel Editor's prop setup window, the maximum allowed segments per line has been
increased.

e During the Pixel Editor's sequence playback, pixels were often not square when playing back on
the main window. Now, pixel dimensions are even recalculated if the playback window is resized
during playback.

What's New in Version 4.0.30

e "Test Physical Channel" can be used on RGB channels and channel groups
e Smooth to Fades

* Bug fixes

"Test Physical Channel” can be used on RGB channels and channel groups

The "Test Physical Channel" commands in the Sequence Editor's right-click popup menu on channel
buttons used to apply only to actual channels, as opposed (for example) for RGB channels. You
could use them on the individual channels comprising an RGB channel, but not on the RGB channel
as a whole. You can now use these commands on RGB channels and other channel groups, turning
on or off all channels in the group in one fell swoop.

Smooth to Fades

Sometimes, sequences (especially those created with the help of various automatic tools) will have
sections wherein a channel will have many very rapid consecutive effect events. For example, "From
time 0.00 to time 0.05, 10%; from time 0.05 to time 0.10, 30%; from time 0.10 to time 0.15, 40%,;
from time 0.15 to time 0.20, 70%". If done on many channels, this sort of thing can lead to laggy or
bursty behavior. Moreower, it's often more or less indistinguishable (to the human eye) from the
simpler "From time 0.00 to time 0.20, fade up from 10% to 70%", which is significantly more
efficient. The Sequence Editor now has a "Smooth to Fades" tool which will attempt to
automatically smooth out effects in this way, which can improve the performance of the sequence
(reducing lagginess) and also decrease loading and saving time. You can get to the Smooth to
Fades tool via the track grid's right-click context menu.

Bug fixes

¢ The Hardware Utility would crash without warning when using the Pixel Console if the Comm
Listener was not active and the REGular port was not defined as 'Enhanced'.

e Consecutive picture effects in the Pixel Editor would not display the correct images.

¢ When creating a new prop in the Pixel Editor, an error would occur if the user selected the string
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type as "strobe string 1 ch" or "multicolor string 1 ch" before selecting a color.

What's New in Version 4.0.28

e The Pixel Console in the Hardware Utility can now test PixConl16 and other devices running in
ELOR mode

Visualizer props imported into the Pixel Editor

Sequence method defaults for importing Visualizer fixtures into the Pixel Editor

Pixel Editor prop groups can contain any prop

"More Info" buttons on Sequence Editor-to-Pixel Editor migration tool

Bug fixes

Pixel Console in the Hardware Utility can now test PixCon16 and other devices
running in ELOR mode.

The Pixel Console in the Hardware Utility could previously only test PixConl6 devices when running
in E1.31 (DMX over Ethernet). It can now also test PixCon16 boards, or any other LOR controller
that are connected to the REGular LOR Enhanced network running at 500K.

Visualizer props imported into the Pixel Editor

In the Pixel Editor's Visualizer import function, Visualizer props now get imported as Pixel Editor
prop groups.

Sequence method defaults for importing Visualizer fixtures into the Pixel Editor
In the Pixel Editor's Visualizer import function, string, single bulb, and flood fixtures now default the

Sequence Method to Sequence Editor. CCR and DMX fixtures default the Sequence Method to
Pixel Editor.

Pixel Editor Prop Groups can contain any prop

Pixel Editor prop groups can now contain any prop, not just those with a Sequence Method of Pixel
Editor.

"More Info" buttons on the Sequence Editor-to-Pixel Editor migration tool

"More Info" buttons were added on the Sequence Editor-to-Pixel Editor migration tool, to show exact
channel mismatches.

Bug fixes

¢ In SuperStar's Smooth Effects dialog box, if the Enter key were pressed while the tab pane had
the focus, the pane would go blank. It now does not go blank, and sets the current values to the
screen.

¢ In SuperStar's Smooth Effects dialog box, if the Esc key were pressed while the tab pane had the
focus, the pane would go blank. It now instead closes the dialog box.

¢ In SuperStar's Smooth Effects dialog box, if the Esc key were pressed while the tab pane did not
have the focus, the dialog box would close, but the tab pane would remain. Now both go away.

e When importing or exporting a network configuration in the Network Preferences program, if the
filename contained a special character (such as a space), the import or export could fail silently or
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the file could be saved with an incorrect filename.

e When changing the Unit ID or Universe ID in the Pixel Console, the pixels displayed should have
reset to show the first pixel. Howewer this was not happening.

e When changing a DMX universe to use E1.31 in the Advanced Network Configuration, if there were
no previous settings the IP is set to Multicast with the correct address rather than Specify with an
IP of 0.0.0.0.

e [f the user previously configured a DMX Universe in the Advanced Network Configuration, those
values are used as the defaults for the next DMX Universe edited if that universe has no previous
settings.

e The Pixel Editor would crash when opening some sequences.

e The Pixel Editor would sometimes hawe incorrect channel assignments on custom props.

e The Pixel Editor's preview playback would not update when in a separate window.

e The Pixel Editor's Effect Generator was not detecting the "none" effect correctly.

What's New in Version 4.0.26

e Physical channels can now be tested in the Sequence Editor
e Importing Visualizer files into the Pixel Editor
e Pixel Editor playback performance improved

¢ Bug fix

Physical Channels can now be tested in the Sequence Editor

If you right click on a physical channel in the Sequence Editor, you can nhow send an ON command
directly to that channel. This will allow you to test if you have properly configured and connected
your equipment, and that you have correctly set the channel's parameters. The channel will remain
ON until you select to turn the channel OFF, or you play a sequence.

Importing Visualizer files into the Pixel Editor
You can now import Visualizer files (*.lee) into the Pixel Editor. In the Pixel Editor, select Tools >
Manage Previews from the menu, then click on the "Import Visualizer" button. This functionality is
preliminary - only fixtures get imported at this time. It is intended that in a future release, Visualizer
props will also get imported as Pixel Editor prop groups.

Pixel Editor playback performance improved
The performance of sequence playback has been improved in the Pixel Editor.

Bug fix

¢ In the Pixel Editor, the timing mark display no longer bleed through if the user switches to another
window/application during playback.

What's New in Version 4.0.24

e Hardware Utility can take control of ports from the Comm Listener
e PixConl6 can now be automatically configured as 1 UID/Universe per port

* Bug Fixes

Hardware Utility can take control of ports from the Comm Listener
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Only one program can have a comm port open at any given time. For ports associated with LOR
Enhanced networks and DMX networks, typically the Comm Listener will have the port open. In
previous versions, this meant that if you wanted to use the Hardware Utility on such a port, you
would have to ensure that the Comm Listener was not running, which is typically done via "Unload
Light-O-Rama" in the LOR Control Panel's right-click popup menu. Now, instead, when the
Hardware Utility cannot open a port and it suspects that the reason might be that the Comm Listener
has that port open, it now offers you the choice of whether or not it should ask the Comm Listener to
temporarily give up control of the port. Thus, you can use the Hardware Utility on such ports without
completely unloading the LOR Control Panel.

Two things should be noted: First, if you ask the Comm Listener to give up control of the port, then
no program other than the Hardware Utility will be able to control lights on that port (until the Comm
Listener retakes control of it). Notably, this means that if a show is running, any lighting commands
from the show for the lights on that port will not take effect. Similarly with lighting commands from
the Sequence Editor or Pixel Editor.

Second, the Hardware Utility does not really know that the Comm Listener is the culprit that is
preventing it from opening the port; it just has a good guess that this might be the case. The culprit
might instead be some other program entirely; for example the Sequence Editor might have the port
open, or even some program completely unrelated to Light-O-Rama. So, if the Hardware Utility asks
you if you want it to ask the Comm Listener to give up control of the port, and you say yes, this
might not cause the Hardware Utility to be able to take control of the port. In some cases, you
might still have to (for example) close the Sequence Editor.

PixConl6 can now be automatically configured as 1 UID/Universe per port

When configuring the PixConl6, the only way to automatically have the board assign ascending
Universe or LOR Unit IDs previously was to use the 'Advanced' configuration and manually create the
parameters for each port. The PixConl6 configuration can now perform this task automatically in
simple or advanced mode. In simple mode, select the 'One UID/Universe per port' radio button. In
Advanced configuration use one of the 2 buttons which automatically update all lower ports with
ascending unit IDs.

Bug fixes

¢ When automatically creating Network Configuration while configuring a PixCon16, not all DMX
Universes in use were being created.

¢ In the Hardware Utility the 'Lights Off button on the bottom right of the main screen was not turning
all lights off on Cosmic Color devices

What's New in Version 4.0.22

e Prop creation is now optional when using the DMX Pixel Draw or CCR Pixel Draw Wizards
PixConl16 can now be configured to run in LOR mode

PixConl6 configuration can now optionally create DMX Network Configuration on save

e More robust PixConl6 communications for loading board configuration and updating firmware

* Bug Fix

Prop creation is now optional when using the DMX Pixel Draw or CCR Pixel
Draw Wizards

Previously, when finished drawing a DMX Pixel Universe or a CCR String, it was always required to
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create a new prop. However many times these wizards are used to continue adding pixels to
existing fixtures. These wizards now ask if you want to create a new prop or not.

PixConl1l6 can now be configured to run in LOR mode

The PixConl6 has 2 operation modes: It can be used as an E1.31 controller on an Ethernet
network, or it can be used as an LOR controller on an LOR RS485 network. Now the user can
specify which mode to use the board in, and will change its operation accordingly (Unit IDs instead
of Universes, Circuit IDs rather than Channels, etc.)

PixCon16 configuration can now optionally create DMX Network Configuration
on save

When the PixConl6 is in E1.31 (DMX) mode, saving the configuration will bring up an option to
automatically create the necessary DMX Network configuration changes. If the user selects yes, for
each DMX universe in use on the board the system will create Multicast entries in the network
configuration.

More robust PixCon16 communications for loading board configuration and
updating firmware

Previous versions took a very consenvative approach when reading or writing to the board, including
during firmware updates. Now the read/update process will retry more often and at a faster rate in an
effort to reduce the number of errors the user has to deal with.

Bug fix

e When creating DMX Pixel Universes using a Wizard, the Visualizer would not correctly display
fixtures with available pixels. Instead the wizard would crash and leave the Visualizer in an
inconsistent state.

What's New in Version 4.0.20

* Bug Fix
Bug fix

¢ The Hardware Utility main window was improperly sized allowing for controls that should have been
hidden to be visible.

What's New in Version 4.0.18

e Sequence Editor's comm status more informative and more accurate

e Hardware Utility can now more easily test Cosmic Color Ribbons and Bulbs/Pixels
e Separate tab for traditional strings in prop definition window

e Custom bulb colors for traditional strings in the Pixel Editor

e Bulb shape and transparency in the Pixel Editor

e New Pixel Editor prop shape, "Bulbs"

¢ Increased maximum bulb size in the Pixel Editor

e Owerriding default channel settings in the Pixel Editor

e Props comment field
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e Renamed Pixel Editor sequence method

e Color selection palette hidden for effects that do not use it
e Movie effect support for uncompressed AVI files

¢ New default for Pixel Editor migration tool

e Custom Pixel Editor dimming curves

e Wait dialog while saving intensity files

* Bug fixes

Sequence Editor's comm status more informative and more accurate

There is a small colored square in the bottom right corner of the Sequence Editor which indicates the
status of various networks: Blue means everything's OK, red means some sort of problem exists,
and orange means other (for example, if Control Lights is off). This has been improved in several
ways in this version of the Sequence Editor:

¢ In S3, it would only indicate the status of LOR networks. In earlier beta releases of S4, it
would actually indicate less than that: It would only indicate the status of non-enhanced LOR
networks. It now also indicates the status of non-enhanced LOR networks and of DMX
networks (although see below for a cawveat).

¢ Previously, if an error existed on some network, its tooltip would simply say that there is an
error. It now indicates which network or networks have errors.

¢ Previously, starting play would in some cases make the panel turn from red to blue even if
some network still had an error.

¢ |t now updates in close to real time when some sort of status change happens.

Two things should be noted: First, for LOR enhanced networks and for DMX networks, the status
describes whether or not the Sequence Editor is successfully communicating with the Comm
Listener; it does not necessarily indicate that the Comm Listener is successfully communicating
with the network. Check the Comm Listener itself for that information. Second, only the statuses of
LOR and DMX networks are taken into account at this time; the statuses of Dasher, X10, Digital 10
and BSOFT Digital IO networks are not reflected.

Hardware Utility can now more easily test Cosmic Color Ribbons and Bulbs/
Pixels

Previously, the Hardware Utility Test screen could only test up to 32 circuits on a device. Cosmic
Color devices howewer can have 150 or more circuits, which could lead to user confusion. Now when
a Cosmic Color device, like the Cosmic Color Ribbon or Cosmic Color Bulb, is selected the test
screen changes to testing the entire device with a particular color rather than circuit by circuit.

Separate tab for traditional strings in prop definition window

On the Pixel Editor's prop definition window, the details of setting up a traditional string have been
moved to a separate tab from RGB strings.

Custom bulb colors for traditional strings in the Pixel Editor

In the Pixel Editor, traditional strings can now have a custom bulb color (defined with the rest of the
string colors). Press the "Custom™ button to set the color.

Bulb shape and transparency in the Pixel Editor
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Bulb shape and bulb transparency were added to the Pixel Editor's props. These can be set in the
preview design window after one or more props have been selected.

New Pixel Editor prop shape, "Bulbs"

The Pixel Editor has a new prop shape of "Bulbs". Each bulb in the prop can be individually
positioned.

Increased maximum bulb size in the Pixel Editor

The maximum possible bulb size in the Pixel Editor has been increased so as to better
accommodate flood lights.

Overriding default channel settings in the Pixel Editor
It is now possible to override the default channel settings for every channel in a prop with traditional
strings in the Pixel Editor. For example, a traditional megatree with red and green strings can now
have a channel configuration of RRRR...GGGG.... Previously, it had to be RGRGRGRG....

Props comment field

The Pixel Editor has a new comment field for props, which you can use to enter your own notes
about the prop.

Renamed Pixel Editor sequence method
The Pixel Editor's "Traditional" sequence method has been renamed to "Sequence Editor".
Color selection palette hidden for effects that do not use it

The color selection palette on the Pixel Editor's Effect Generator window is now hidden for effects
that don't use the palette (e.g. Picture and Movie effects).

Movie effect support for uncompressed AVI files

The Pixel Editor's Movie effect can now read uncompressed AVI files produced by the fimpeg
program.

New default for Pixel Editor migration tool
The Pixel Editor's "Remove prop channel data from Sequence Editor" migration tool defaults to
checked if the Pixel Editor and Sequence Editor channel counts match and the Has SE Events
columnis Yes.

Custom Pixel Editor dimming curves

You can now create your own dimming curves for the Pixel Editor, placing them in the "Pixel Editor
\Curves" directory within your LOR data directory.

Wait dialog while saving intensity files
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The Pixel Editor now shows a wait dialog while saving intensity files.

Bug fixes

e The Pixel Editor would hang after pressing play when the audio file was missing.

e The Pixel Editor would crash if a sequence was opened, closed, re-opened, and then the preview
was changed. A memory leak related to this was also fixed.

¢ A bug in the Pixel Editor's onscreen playback of strobes was fixed.

e A Pixel Editor bug dealing with custom RGB props with multiple strings has been fixed.

e After a "Sawve As" was done in the Pixel Editor, the Pixel Editor file (LPE) had a timestamp that
was current, but the new LMS/LAS file's timestamp was the same as the original file. Now both
files will have a timestamp that is current.

What's New in Version 4.0.16

e Pixel Console in the Hardware Utility can now test DMX pixels
e Sequence Editor no longer turns off Control Lights when a port cannot be opened

* Bug fixes

Pixel Console in the Hardware Utility can now test DMX Pixels

The Pixel test Console in the Hardware Utility has been improved to now be able to test DMX pixels.
DMX Pixels can only be tested when the Comm Listener is running and if your software is registered
at the Advanced lewel or higher.

Sequence Editor no longer turns off Control Lights when a port cannot be
opened

In previous ersions of the Sequence Editor, if any particular comm port for an LOR network could
not be opened, the Sequence Editor would automatically turn off Control Lights and therefore not
attempt to control lights on any network. The reason for this was that it would be very resource-
intensive to keep trying to open a comm port that just could not be opened, to a degree that would
noticeably affect play. Now, instead, the Sequence Editor will leave Control Lights on, but not
attempt to control the specific problematic network (or networks). If you find yourself in this
situation, and you fix the problem with the comm port, you can get the Sequence Editor to attempt
to open the port again by manually turning Control Lights off and then on.

Bug fixes

e For some DMX visualizations, SuperStar would not export all of the pixels.

¢ In certain situations, the Visualizer when in normal rendering mode would not display all fixtures
properly.

¢ When entering Simulation Mode in the Visualizer, DMX Pixel Universe fixtures were not being
properly flagged as an error if they contained duplicate pixels.

What's New in Version 4.0.14

Network Preferences Program can export/import network configurations
Right click copy in the Pixel Editor

Dragging effects in the Pixel Editor

e Owerlapping channel warnings in the Pixel Editor
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e New Pixel Editor prop types
e Control over beat interval range in SuperStar

* Bug Fixes

Network Preferences program can Export/Import network configurations

There are two new buttons on the Network Preferences Advanced configuration that allow for the
export and import of user network configurations. These functions can be used to keep multiple
configurations on the same computer, or to move configurations between computers.

Right-click copy in the Pixel Editor

In the Pixel Editor, you can right-click on an effect thumbnail and select "Copy" from the popup
menu. This puts the effect on the clipboard, from where it can be pasted anywhere on the grid.

Dragging effects in the Pixel Editor

In the Pixel Editor, you can drag an effect thumbnail onto a grid cell, and that cell will then be
populated with that effect.

Overlapping channel warnings in the Pixel Editor

In the Pixel Editor's Preview Management window, clicking the "Info" button now lists warnings where
channel assignments owverlap (in addition to listing basic statistics about the preview). This is a great
way to check whether you have any errors in creating your preview.

New Pixel Editor prop types

The Pixel Editor's prop types "Line-Horizontal" and "Line-Vertical" have been replaced with "Lines-
Closed Shape", "Lines-Connected", and "Lines-Unconnected”, which can be used to create a much
larger variety of shapes. Any Line-Horizontal props in your preview will be automatically converted to
a Matrix-Horizontal that is one string high. Line-Vertical props will be automatically converted to a
Matrix-Vertical that is one string wide.

Control over beat interval range in SuperStar

When doing a "Create Timings" in SuperStar, a dialog box now appears, giving control over the range
that the beat interval can be. The default range is what it used to be a year ago so that Carol of the
Bells is given a short beat interval that matches what is in the first SuperStar tutorial.

Bug fixes

¢ In some very limited cases, the Network Preferences program would produce an error stating that
a COM port and a DMX adapter were in conflict but were not. This same bug could also manifest
itself as an 'Error 9 - Subscript out of Range' error and crash when starting the Network
Preferences program.

e [f the user pressed ESC while in simulation mode using the Advanced Rendering Engine,
Visualizer would completely exit rather than return to Edit Mode.

e The position of the Visualizer Advanced Rendering Engine window would not be remembered
between executions.

What's New in Version 4.0.12
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Checkmark for currently selected waveform size

* Bug fixes

Checkmark for currently selected waveform size

The Pixel Editor now shows a checkmark in the menu next to the currently selected waveform size.

Bug fixes

In some situations, the Light-O-Rama Control Panel would issue an error message saying "Error in
Form_Unload: (91) Object variable or With block variable not set".

Lighting commands for DMX universes would not be sent to the Visualizer unless "Control Lights"
was enabled, even if "Control Visualizer" was enabled.

Lighting commands for LOR Enhanced networks would be sent to the physical controllers if
"Control Visualizer" was enabled, even if "Control Lights" was not enabled.

The way that SuperStar's configuration is saved has been changed for better backward
compatibility.

On some computers, if the Pixel Editor's preview playback window lost the focus, the playback
would be blank.

The Pixel Editor would only allow one universe for custom props.

Media files longer than twenty minutes were not loading in the Pixel Editor.

What's New in Version 4.0.10

MP3 directors running DMX universes can now optionally leave lights on at the end of a sequence.
Commands menu in LOR Control Panel

Comm Listener starts even if no networks are configured to use it

Pixel Editor migration tool to remove channel data from sequence

Pixel Editor preview data now stored in LOR data path

Pixel Editor Design & Playback window split into two windows

Pixel Editor toolbar changes

Pixel Editor preview playback changes

Windows Media Player used for all Pixel Editor playback

Bug fixes

MP3 Directors running DMX Universes can now optionally leave lights on at the
end of a sequence.

A new option has been added to Hardware Utility when creating SD cards for MP3 directors to either
leave channels on DMX Universes at their current intensities or else turn them off when a sequence
ends.

Commands menu in LOR Control Panel

The Light-O-Rama Control Panel's right-click popup menu is now also accessible from its Status
window, as the "Commands" menu. Generally speaking, this may (or may not) be more convenient
in some situations, but it could be very useful in certain situations where Windows repeatedly keeps
closing the popup menu automatically before you get a chance to select the menu item that you
want to use from it.

Comm Listener starts even if no networks are configured to use it
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In previous \ersions, the Light-O-Rama Control Panel would not start up the Comm Listener unless
at least one network was configured in Network Preferences to use the Comm Listener. It now no
longer requires any such networks to be configured. This allows commands to go through the
Comm Listener to the Visualizer even if no networks at all are configured to use the Comm Listener.

Pixel Editor migration tool to remove channel data from sequence file

The Pixel Editor migration tool to remove channel data associated with Pixel Editor props from the
sequence file (LMS or LAS file) is now operational. This tool should be used only after you have first
imported your sequence using the Sequence Editor import and/or the xLights import. The benefit of
this tool is that it eliminates any overlapping channels between the sequence file and the intensity
file, which is necessary for proper playback outside of the Pixel Editor. It can also greatly reduce
the size of your sequence file.

Pixel Editor preview data now stored in the standard LOR data path

The Pixel Editor previously stored the preview data file under the hidden AppData directory. It now
stores it in the standard LOR data path, and no longer stores any data under AppData.

Pixel Editor Design & Playback window split into two windows

The Pixel Editor's Design & Playback window has been split into two separate windows, one for
design and the other for playback. This was a prerequisite for solving other playback issues.

Pixel Editor toolbar changes

The Pixel Editor's toolbar above the sequence grid has been revamped to look more uniform. Also,
playback buttons were added, as were some options that were previously in the Sequence menu.

Pixel Editor preview playback changes

The Pixel Editor's preview playback can now be hidden, shown on the main window, or shown on a
separate window. Ewven when on a separate window, the grid remains interactive. The choice of
which mode to use is under the new Tools > Preview Playback menu, and applies to all sequences.

Windows Media Player used for all Pixel Editor playback

Windows Media Player is now used for all media playback in the Pixel Editor. Previously, the
displayed audio waveform (compressed audio) was used for playback on the main window, but this
had low sound quality.

Bug fixes

* In SuperStar, regular light string effects would not work in certain visualizations.

¢ The SuperStar star was not getting marked properly if it also had row/column coordinates.

e The Comm Listener would ignore lighting effects for DMX universes that were not set up in Network
Preferences. As a result, the effects would not be displayed in the Visualizer.

e SuperStar has improved error reporting when importing visualizations with DMX pixels.

¢ In the Pixel Editor's Preview Design window for "Dumb RGB" and traditional strings, moving an end
point on such a string would cause the drawn string to collapse to a single point.

e The Pixel Editor's media file search was not locating files in subdirectories under the default LOR
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media directory.

What's New in Version 4.0.8

e New CMB16D firmware

Dumb RGB elements in groups

Clockwise and counterclockwise pixel orders in Window Frame props
e Prop creation dialog change

* Bug fixes

New CMB16D firmware

Version 1.33 of the firmware for the CMB16D has been released (filename CMB16-1-33.l1hx). This
new version has no effect on functionality; it is being released because the recently released
previous version 1.32 would incorrectly be displayed in the Hardware Utility as being version 1.31.

Dumb RGB elements in groups

In the Pixel Editor, dumb RGB elements can now be members of a group.

Clockwise and counterclockwise pixel orders in Window Frame props

In the Pixel Editor, the user can now specify Window Frame props to use clockwise (CW) or
counterclockwise (CCW) pixel order. Users who have created Window Frame props with previous
beta versions will need to go back into those prop definitions and update the Start Location value to
match their prop.

Prop creation dialog change

In the Pixel Editor's prop creation dialog, the number box next to the DMX radio button (max
channel/circuit number) now applies to both DMX and LOR networks. In particular, this resolves an
issue when defining props based on the CMB24DC card.

Bug fixes

e The Comm Listener is designed to shut down when the LOR Control Panel shuts down. In
previous versions, this behavior relied upon the LOR Control Panel periodically sending "keep alive"
messages to the Comm Listener; if the Comm Listener didn't receive such a message within a
reasonable amount of time, it would shut itself down. This worked fine most of the time, but in
some situations (typically involving very large shows), the LOR Control Panel would sometimes not
get a chance to send such a message to the Comm Listener for a while, leading to the Comm
Listener shutting itself down prematurely. Now, instead of relying on these messages, the Comm
Listener periodically directly checks whether or not the LOR Control Panel is running.

e SuperStar's progress dialog box works smoother.

* In SuperStar, play of a song sometimes wouldn't stop until the end of the song was reached.

e The Verifier is supposed to check for the existence and correct version numbers of various
program files (in Verifer message number 7 and number 16 respectively), but it was not doing so
for several relatively new files.

e The Network Preferences program could incorrectly identify two or more networks as being in
conflict when they were actually not.

e The Pixel Editor now displays unit IDs in hex on the prop layout window.

e The Pixel Editor's "Control Lights" command was always using the default port to attempt to
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connect to the Comm Listener, even if the Comm Listener were configured to listen on a different
port.

e The Pixel Editor could crash during migration of custom props.

e The preview calculation for LOR channels in the Pixel Editor was producing a range of 0-100
instead of 0-255, which made them appear dim (both as part of the preview and as part of the
Sequence Editor migration). Users should rerun any Sequence Editor migrations they performed
using version 4.0.6.

What's New in Version 4.0.6

Highlighted thumbnail in Pixel Editor effects
Comm Listener no longer requires FTDI drivers
New firmware for CMB16D card

New Pixel Editor Sequence Editor migration tool
New Pixel Editor effect: Movie

Performance improvements in the Pixel Editor

Bug fixes

Highlighted thumbnail in Pixel Editor effects

In the Pixel Editor's table of effect thumbnails, the current thumbnail is now highlighted, making it
easy to distinguish which thumbnail is playing in the right-hand window.

Comm Listener no longer requires FTDI drivers

Previous versions of the Comm Listener required FTDI drivers to be installed on the computer, even if
the Comm Listener weren't supposed to drive any lights that use FTDI-based adapters. It now no
longer requires these drivers. If they are not installed, then the Comm Listener will not be able to
control any lights on FTDI-based networks (such as LOR Enhanced networks and most types of
DMX networks), but it will be able to control the Visualizer, and also control lights on E1.31
networks.

New firmware for CMB16D card

Version 1.32 of the firmware for the CMB16D card has been released (filename CMB16-1-32.1hx). It
now supports 500K comm speed and LOR Enhanced protocol.

New Pixel Editor Sequence Editor migration tool

The Pixel Editor has a new Sequence Editor migration tool. From the menu: Sequence > Migration
Tools > Import from Sequence Editor. It will allow sequences for RGB props to be copied into the
Pixel Editor. The result will be an exact pixel for pixel copy displayed as a single effect that spans
the length of the sequence (one effect per imported prop). Portions of that single effect can then be
removed and replaced with Pixel Editor effects as desired.

New Pixel Editor effect: Movie

The Pixel Editor has a new effect: Movie. This effect will play AVI movie files on your props (files
with an "av" extension). This effect is a bit limited in that the AVI movie files must be
"uncompressed”. Various third-party programs (such as VirtualDub) can be used to produce such
uncompressed AVI files.
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Perf

ormance improvements in the Pixel Editor

The Pixel Editor has received some performance improvements: There has been some modest
improvement in the preview calculation speed, and a large speed improvement to the Pinwheel effect
(meaning it now takes far fewer CPU cycles to calculate).

Bug

Wh

fixes

In SuperStar, if you attempted to export an intensity file to a directory other than the sequences
folder, the empty *.Ims file got placed in the correct folder, but the associated intensity file always
got placed in the sequences folder.

When a \visualization file would get a "ran out of sequencing rows" error, SuperStar would
sometimes freeze.

Preview of text on SuperStar's sequencing grid was being clipped to only the matrix in a
visualization that contained a matrix and other lights. It will now display the preview of the text to
the entire sequencing grid.

If the Comm Listener were configured to use some particular adapter, but it could not open that
adapter, lighting commands sent to the Comm Listener for that adapter's network would build up
without being processed until the adapter was successfully opened. This would result in the
Visualizer unnecessarily not receiving the lighting commands either, and also potentially lead to
an out-of-memory condition eventually.

Ramp up effects on the left side of the Pixel Editor's grid were displayed incorrectly.

In some cases, Sequence Editor channels were not being displayed in the Pixel Editor's grid even
though they were selected after clicking the "Props" button.

The Pixel Editor's xLights 3 import tool is now located under the Sequence > Migration Tools
menu.

SuperStar now remembers the clip rectangle state for Smooth Effects mode, Image mode, and
Text mode.

at's New in Version 4.0.4

New CMB24D firmware
Bug fixes

New CMB24D firmware

Version 1.05 of the firmware for the CMB24D card has been released (filename CMB24D-V1_05.1hx).

Bug

It has support for the Enhanced LOR Protocol.

fixes

e [f you did not have an LOR USB dongle attached to the computer and attempted to start the Pixel

Console, it would crash the Hardware Utility with no error message.

¢ In the Visualizer if in one session you ran a simulation with the Advanced Rendering Engine and

then switched options to the Regular engine, the simulation would not run.

e The Visualizer was not correctly reporting issues with simulations that used pixel universes. This

could lead towards the Visualizer deleting fixtures coming out of simulation.

¢ One of the things that the Light-O-Rama Post Install utility does is to give you a chance to choose

the directory that Light-O-Rama will (by default) use to store your data files (such as your
sequences and visualizations). If you previously had chosen a data directory, then ran Post Install
again and told it to use a different directory, it would copy your data from the old directory to the
new. Howewer, it would not copy all such data; in particular, data files that you had stored in
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subdirectories would not typically be copied over to your new data directory.

What's New in Version 4.0.2

e "Spokes" prop shape in Pixel Editor

e Pixel Editor pinwheel effect improvements

e Visualizer will back up S3 and earlier Editor Files before converting to S4
e Comm Listener identifies clients by name in log messages
[ ]
[ ]
[ ]
[ ]

New Pixel Test Console for the Hardware Utility
Tracks and props now remember whether or not they are hidden
New sample visualization file

Bug fixes

"Spokes" prop shape in Pixel Editor

The Pixel Editor has a new predefined prop shape called "Spokes", for props that have spokes that
radiate from a central hub.

Pixel Editor pinwheel effect improvements

The Pixel Editor's pinwheel effect has new controls: Two sliders to control the center of rotation, and
one to control the length of the arms.

Visualizer will back up S3 and earlier Editor Files before converting to S4

The file format of Visualizer files has changed. When saving an S3 file in S4, the Visualizer will first
back up the editor file. Should you choose not to mowe to S4, you can use this backup file to
restore to an S3 format.

Comm Listener identifies clients by name in log messages

When issuing a log message about one of its clients (such as the Sequence Editor or Show Player),
the Comm Listener would refer to the client via the IP socket that the client used to connect to the
Comm Listener. For example, it might refer to a certain client as "Socket 127.0.0.1:57223". This is
enough to uniquely refer to the client (at least until it disconnects and later reconnects), but it's not
terribly informative for troubleshooting purposes. Now it additionally refers to the client by name
(such as "Sequence Editor"), if the client has identified itself to the Comm Listener in that way.
Please note that not all clients will necessarily identify themselves to the Comm Listener in all
situations, so in some cases the Comm Listener will still only log the IP socket information.

New Pixel Test Console in the Hardware Utility

A new testing console that can more easily be used with Light-O-Rama RGB devices has been
added to the Hardware Utility.

Tracks and props now remember whether they are hidden

In the Sequence Editor, when you opened a sequence, all tracks and the props section would be
unhidden, even if you had previously hid some of them while that sequence was open earlier. The
sequence now remembers whether or not they should be hidden even after it is closed and reopened.

New sample visualization file
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A new sample visualization file, 24x25Tree_8RowGlobe_dmxPixelTool.lee, has been added.

Bug fixes

When the Pixel Editor was displayed on a secondary monitor, the timing marks would display
incorrectly during prop playback.

In the Pixel Editor, when creating custom props that skipped node numbers, the program would
crash.

In the Pixel Editor, when creating custom props that used the same node number more than once,
the prop would display some nodes in the wrong locations.

When loading certain sequences into the Pixel Editor, the program would crash. This would
happen with sequences that had more than one channel assigned to the same physical circuit. It
would also happen with sequences that used the same channel name more than once.

The version number displayed in the Pixel Editor's "About" box did not match the rest of the Light-
O-Rama programs (it had an extra ".0" in it).

The caption on the Pixel Editor's main window was missing some of the information displayed in
the captions of other Light-O-Rama programs.

In certain cases after unexpectedly disconnecting from and successfully reconnecting to the
Comm Listener, a client may not have correctly told the Comm Listener whether or not lights
should be turned off the next time that it disconnects.

In the Visualizer when using the Arch Wizard to create a pixel based fan, the fan was not properly
created.

When the Pixel Editor displayed effect thumbnails in the left window, thumbnails for Firestick
props were bunched too close together. A similar problem could occur for horizontal lines.

When a log message is added to the LOR Control Panel's status window and it is beyond the end
of the visible portion of the log, the log should automatically scroll to the bottom in order to display
the message. In certain situations, this was not happening.

The Pixel Editor was requiring unit IDs for LOR networks to be entered using their decimal value.
Now unit IDs are entered with their hex value, just like every other LOR program. Users of
version 4.0.0 will need to go back into each prop thatis on an LOR network and update
the unit ID to use the controller's hex value.

What's New in Version 4.0.0

Pro lewel license

The Light-O-Rama Pixel Editor

Intensity files

Enhanced Light-O-Rama networks

Speed improvement for converting channels to RGB channels

Fading images and text in and out in SuperStar

Visualizer now supports DMX RGB Pixel Universes

Visualizer now supports inserting Symbol Fixtures with more than 256 Vertices
Visualizer Wizard Updates

Improved Pixel Ordering Display in Visualizer Draw Window

Improved Visualizer performance while rendering

Improved Visualizer Error Messages

Improved Visualizer Shimmer and Twinkle Emulation

New SuperStar parameters windows in Visualizer for Fixtures & Props
Improvements for certain Comm Listener log messages

New and updated firmware

"4GB Patch" enabled by default

New LOR PIXCON16 E1.31 based controller
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e Cosmetic Control Panel changes
¢ MP4 media files

* Bug fixes

Pro Level License

There is now an additional license lewel, "Pro", above Advanced. A Pro level license enables several
new features designed to help with very large displays: The Light-O-Rama Pixel Editor, intensity
files, and enhanced Light-O-Rama networks.

The Light-O-Rama Pixel Editor

The Light-O-Rama Pixel Editor is a new program which can be used to produce lighting effects for

sequences in a visual way. It produces intensity files, which can efficiently support large lighting
displays.

Intensity Files

Intensity files are a new way to store lighting commands. An intensity file, generated by the Light-O-
Rama Pixel Editor or the Light-O-Rama SuperStar Sequencer, is associated with a sequence, and
will play at the same time that the associated sequence plays. Instead of storing lighting
commands in the traditional high-level way (such as "fade up over the next five seconds from 0% to
100%"), an intensity file stores large blocks of instantaneous intensity values for potentially many
circuits. This allows the intensity file to be very efficient during play, and so enables better support
for very large lighting displays.

Only Light-O-Rama controllers and native DMX devices can be used in an intensity file, and the
Light-O-Rama controllers must be on enhanced LOR networks. The LOR Comm Listener must be
running in order for the lights to be controlled. This feature only works under the Pro license lewel.

Enhanced Light-O-Rama Networks

A Light-O-Rama network can now be set to be an "enhanced" network. This causes the network to
use a new communications protocol (an extension of the standard Light-O-Rama communications
protocol) which can deliver lighting commands for many channels efficiently. If an intensity file is
used, any LOR controllers from the intensity file must use an enhanced LOR network, but enhanced
LOR networks also support effects defined directly in a sequence.

The Hardware Utility can also write SD cards for G3 Directors for Enhanced Networks. Again, all
controllers connected to a port must support the Enhanced Protocol, and the G3 directors firmware
will need to be updated to at least version 5.32.

Not all Light-O-Rama controllers support the enhanced protocol, and some may require firmware
updates in order to do so. The LOR Comm Listener must be running in order for lights on an
enhanced network to be controlled when using a computer. Enhanced LOR Networks only work
under the Pro license lewvel.

Speed Improvement for Converting Channels to RGB Channels

In the Sequence Editor, converting channels to RGB channels would get slower and slower as the
sequence got larger and larger, and eventually the sequence would become large enough that the
conwersion would take a very long time. This has been sped up significantly.
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Fading Images and Text In and Out in SuperStar

You can now fade images and text in and out in SuperStar, using PreRamp and PostRamp times
(see here for images and here for text).

Visualizer now supports 'DMX RGB Pixel Universes'

The Visualizer now supports a 'DMX RGB Pixel Universe' fixture. This fixture allows for up to 170
RGB pixels to be part of a single fixture which is defined as a DMX Universe.

Visualizer now supports inserting Symbol Fixtures with more than 256 vertices

Previously the Visualizer was limited to creating a single fixture for a symbol. This limited the
selection of a font glyph to one that had less than 256 vertices. The Visualizer will now create a prop
and as many fixtures as needed for a single glyph, up to a maximum of approximately 16,000
vertices.

Visualizer Wizard Updates

All drawing wizards that could previously be used with Cosmic Color Devices have been updated to
be able to use the new DMX Pixel Universe fixtures as well.

A new wizard for drawing DMX Pixel Strings has been added.

A new option for 'Snake' layouts has been added to the Matrix Wizard, as well as a new selection
that will show pixel ordering while the wizard is running.

e Maximums for the Tree, Arch, and Matrix wizards have all been increased. Trees and Arches can
now be up to 64 segments. A matrix can be either 64 pixels wide or high depending on the
orientation.

Improved Pixel Ordering display in Visualizer Draw Window

Pressing SHIFT while pointing at a CCR or DMX Pixel Fixture in the drawing area will 'blink’ the
pixels in the order they are assigned. The speed of the blink can be controlled in the The
Visualizer's Options window, Tab 2.

Improved Visualizer performance while rendering

A new advanced rendering engine has been added to the Visualizer to greatly enhance performance
of the program while simulating many channels, especially RGB bulbs. The new rendering engine
takes advantage of the hardware acceleration available on nearly all modern video cards. This new
engine is experimental, however it has been tested on seweral different cards. The new engine is
enabled by default, howewer it can be disabled if needed.

Improved Visualizer Error Messages

When entering simulation mode, the Visualizer would give cryptic error messages if it was unable to
assemble Cosmic Color Devices into meaningful groups. Those error messages have been improved
and expanded to include DMX Pixel Universes.

Improved Visualizer Shimmer and Twinkle emulation
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The Visualizer will now more closely emulate how a real controller presents shimmers and twinkles.
Due to differences between actual hardware clock speed and the visualizer, slight differences will
remain, howewer the look is much improved over S3.

New SuperStar parameters windows in Visualizer for Fixtures and Props

A new dedicated window has been added to both Fixtures and Props in the Visualizer to store
SuperStar parameters. Previously, these parameters were placed as a keyword in the comments of
a fixture/prop. They now have a dedicated area for ease of use.

Improvements for certain Comm Listener log messages

Certain log messages that were output by the Comm Listener, associated with errors or other
information about TCP/IP sockets, would include in their output some numbers that were essentially
meaningless from the point of view of the end user. They now instead output the IP address and port
of the socket.

New and updated firmware
Several new and updated pieces of firmware have been released:

e CCB100D-V1 20.Ihx (CB100D Cosmic Color Pixel/Bulb Controller) : Added support for Enhanced
LOR networks, and fixed a bug where the bulb self test did not correctly run while the reset button
was held on the controller.

e CCR150D-V1 19.lhx (CR150D Cosmic Color Ribbon): Added support for Enhanced LOR networks.

e CMB24D-V1 _02.lhx (CMB24D): This is the first version of firmware for this device that has been
distributed with the LOR software suite.

e CTB04Dg3-V1 01.Ihx (the new 4 channel CTB04g3 AC controller; also used in the new
LOR400Wg3 and LOR400ELLWg3 controllers).

e CTB08Dg3-V1 02.Ihx (the CTB08Dg3 controller card and the LOR800Wg3 controller): Added
support for Enhanced LOR networks.

e CTB16PCg3-V1_08.lhx (the CTB16PCg3 card and the gen3 residential controllers): Added support
for Enhanced LOR networks.

e CTB32Lg3-V1_12.lhx (the CTB32L card and the LOR16xxWg3 light controllers). Added support
for Enhanced LOR networks.

e DC_MP3 _V4-20.lhx (DC-MP3): This version of the firmware makes triggered shows start faster.

e iDMX1000_V1_50.Ihx (the iDMX1000 controller). Fixed a problem with missed effects when running
at 115.4K. Added support for 500K. Added support for Enhanced LOR networks.

e MP3g3-V5_32.lhx (G3 MP3 Dual Network Director): Supports Enhanced LOR networks, and fixes
two bugs: (1) In some cases, the firmware would believe that the sound and lights were extremely
out of sync when they were not. This would cause error detection code to be triggered which
would stop the song that was playing and mowve on to the next song. (2) In some cases, the
firmware would ignore a show's schedule. Instead, a show would start as soon as the SD card
was inserted.

e RF-V4 \2-10.lhx (RF-V4 Easy Light Linker): This release allows the RF-V4 to use 115K comm
speed.

e UMP3g3-V5_32.lhx (G3 Mini Director): Supports Enhanced LOR networks, and fixes two bugs: (1)
In some cases, the firmware would believe that the sound and lights were extremely out of sync
when they were not. This would cause error detection code to be triggered which would stop the
song that was playing and mowve on to the next song. (2) In some cases, the firmware would ignore
a show's schedule. Instead, a show would start as soon as the SD card was inserted.
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"4GB Patch" enabled by default

In recent times, many customers with very large sequences who have been running into memory-
related issues have been using a third-party tool known as the "4GB Patch" to modify the Sequence
Editor and Show Player executable files. The effect of this is that Windows will allow the patched
programs to use more memory than it would allow for the unpatched programs. Whenever a
customer using the 4GB Patch upgraded to a new version of Light-O-Rama, they would have to
remember to use the 4GB Patch on the new \ersions of the two executable files, or else they would
start running into memory-related issues again.

Now, though, the Light-O-Rama installer distributes the Sequence Editor and Show Player
executable files as if they had been patched using the 4GB Patch. Users therefore should no longer
need to run the 4GB Patch on these programs.

Just in case something unexpected occurs because of this, the installer also distributes unpatched
versions of the executables. The patched versions are what are used by default, without the user
needing to take any action. If for whatever reason you want to use the unpatched versions, though,
they can be found in the Light-O-Rama program files directory (which is typically, but not always,
either C:\Program Files\Light-O-Rama or C:\Program Files (x86)\Light-O-Rama). They are called
LORSequenceEditor-Unpatched.exe and LORMonitor-Unpatched.exe. To start using them, shut
down your running programs, then rename the default patched versions out of the way (for example,
rename LORSequenceEditor.exe to LORSequenceEditor-4GBPatched.exe), and then copy the
unpatched versions into their place (for example, copy LORSequenceEditor-Unpatched.exe to
LORSequenceEditor.exe).

The LOR PixConl16 E1.31 Controller

The LOR PixConl6 is the first E1.31 and newest controller offering from Light-O-Rama. The board
can control up to 16 170-pixel strings using various different chipsets, as well as be a bridge for 4
separate DMX universes all running on Ethernet.

Cosmetic Control Panel Changes

The order of menu items in the LOR Control Panel's right-click popup menu has been changed so as
to hopefully more clearly group sets of similar items. Also, the Control Panel would say things like
"Light-O-Rama is Disabled" to mean that scheduled play of shows was not currently enabled; this
has been changed to the hopefully less confusing "Scheduled Play is Off".

MP4 Media Files

The Sequence Editor now allows MP4 files to be used as the media files for musical sequences.
Please note that not all such files will work on all computers; for example, a particular MP4 (or some
other type of media file) may be encrypted with DRM or may require a codec or filter that is not
present on the computer.

Bug Fixes

¢ Using a Wizard other than the Channel Wizard could cause the Visualizer to leak resources.

¢ When using the Arch Wizard, changing from Arch to Fan or vice-versa the minimum number of
segments was not being set correctly. This could lead to errors in the wizard which were caught
and dealt with, but which should not have occurred.

e When using the Tree Wizard, the Pixels Per Segment spin control did not accelerate the longer
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the user pressed the up/down buttons.

e The Matrix Wizard was generating errors whenever the form was re-sized. This lead to errors in
the wizard which were caught and dealt with, but which should not have occurred.

* Deleting a Prop did not always remowve the Prop's definition from the program. In essence, a prop
with no fixtures was saved/loaded each time. Any prop that is deleted now also deletes the prop's
definition.

* If a sequence file could not be loaded due to an invalid end centisecond for one of its effect events,
the Sequence Editor would issue an error message mistakenly quoting the event's start
centisecond instead of its end centisecond.

e Some memory leaks (in various programs) associated with interacting with the Windows shell
have been fixed. Most of these seem unlikely to have actually caused memory to leak in practice,
but in theory they might have. One would definitely cause memory to leak in practice, but a
relatively small amount.

e When the LOR Verifier was checking for warning 32 ("Channel in tracks of conflicting length"), it
would display its progress percentage incorrectly, sometimes even displaying progress above
100%.

* The Simple Show Builder and the MP3 tab of the Hardware Utility would incorrectly allow for more
than 99 sequences to be added to a show. Hardware Directors can only handle a maximum of 99
sequences in a single show.

e The Network Preferences program was not correctly deleting old versions of the network
configuration from the registry. This was due to a recent change in how Microsoft allows access
to the registry.

¢ In the Visualizer, when simulating devices with Unit IDs greater than 100 (hex 64), a channel could
be incorrectly activated on a different channel on the next higher network.

e The Network Preferences program could incorrectly flag two ports as being in conflict even if they
were not. If the ports were in conflict, there was also a chance that the incorrect ports/adapters
were reported.

e The Network Preferences program could experience unintended behavior if the column header in
any of the list displays were clicked.

* If the Sequence Editor or Show Player stopped while a sequence was playing, any DMX lights that
happened to be on at that time would remain on indefinitely.

What's New in Version 3.12.2

¢ New SuperStar license level: 60 CCR

New SuperStar license level: 60 CCR

SuperStar now supports a new license level for up to 60 CCRs. The highest previously existing
license lewvel supported up to 40.

What's New in Version 3.12.0

MP3g3 Directors can now output to DMX devices

MP3 File Loading Speed Improvements for MP3 Directors
New MP3g3 Show Time Director Firmware

Initial firmware for Single Network Mini MP3 Director
Improvements for busy sequences being run on MP3 Directors
New Options and Features in SuperStar Instant Sequencing
New Pre-ramp and Post-ramp options for SuperStar images
New SuperStar Morph Option

New Wrapped Tree for SuperStar
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* Bug Fixes

MP3g3 Directors can now output to DMX devices

MP3g3 Directors can now output to both LOR, DMX, or a combination of the two devices. All the
devices must be the same on a particular port, but a particular port can run LOR or DMX devices
now. You must use the Hardware Utility to write the sequence to the SD card, and the MP3g3
director must be updated to version 5.28 of the firmware.

MP3 File Loading Speed Improvements for MP3 Directors

The Hardware Utility can now optionally strip unnecessary header information from an MP3 while
creating an SD card, improving sequence loading speed on MP3 directors.

New MP3g3 Show Time Director Firmware

A new version of the firmware for the MP3g3 Show Time Director, MP3g3-V5_28.lhx, allows for the
use of DMXor LOR devices on a port.

Initial firmware for Single Network Mini MP3 Director

The initial version of firmware for the Single Network Mini MP3 Director, uMP3g3-V5_28.Ihx, has been
released. This version of firmware supports both LOR and DMX512 output (DMX512 output requires

version 3.12.0 of the Hardware Utility).

Even though this is the first release of firmware for this particular device, the version number is 5.28
so as to keep in sync with the version number of the Dual Network ShowTime MP3 Director (MP3g3-
V5_28.lhx).

Improvements for Busy Sequences Being Run on MP3 Directors

The Hardware Utility and the Simple Show Builder will now throttle busy sequences so that they
better stay in sync with audio. Once the bandwidth of a port on an MP3 director is exceeded, the
amount of sequence data written to the card is reduced until the director can catch back up with the
sequence. Previously MP3 directors would continue to send all data out the port, regardless of the
bandwidth available. During particularly busy sequences, the director would fall back further and
further. Once a sequence falls behind now, all subsequent commands are discarded until the
director finishes sending the queued data.

New Options and Features in SuperStar Instant Sequencing

The SuperStar Instant Sequencer now has new options including new custom colors, new
movement options, and a new trigger type.

New 'Pre-ramp' and 'Post-ramp’ options for SuperStar Images

The user can now specify pre and post ramp options when using images in the SuperStar editor.

New Superstar Morph Option

The user now has the option to not shrink a visualization when doing a morph.
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New 'Wrapped Tree' for SuperStar

The Superstart Sequencer now can use Wrapped Trees in Visualization sequences.

Bug Fixes

¢ In the Hardware Utility when creating an SD card for an MP3 Director that used triggers,
immediately trying to create another show using a different trigger could overwrite the wrong show
number.

¢ The Hardware Utility incorrectly identified the CCB100D as having stand-alone capability. It does
not.

e |f SuperStar was in Visualization mode and a smooth effect color is set to white, if the color is
changed to something that is not white, the bar in the time layers would stay white.

e |f SuperStar was in Visualization wrap around mode and also in scene mode there were cases
where the first pixel turns black with a yellow border.

e |f SuperStar was in Visualization wrap around mode sometimes only the left half would have pixels
set.

* In some cases, SuperStar could create instant sequences that go beyond the end of a song. This
is caused issues since the Sequence Editor fails to play the exported sequence if there are effects
that go beyond the end of the song.

* In some cases, SuperStar would crash when creating a Quick Visualization.

* In SuperStar, when opening an .sup file the Instant Sequence settings were being cleared.

¢ In SuperStar, if a fixture was multi-color and had no channels assigned it was still being drawn as
if it were active.

* In SuperStar non-CCR strings would sometimes display in dark gray on the screen when clicking
on the "VisEffect" checkbox.

¢ For SuperStar, increased the maximum value of the Sequencing Grid Max Length from 200 to 360
in the Import Visualization dialog box,

¢ For SuperStar, changed the valid range of morphs to be -50 to 360.

* In some instances, SuperStar was not checking the length of the row it was sequencing.

* For SuperStar the limit of Maximum Detection lines was increased from 24 to 36 in the Import
Visualization dialog box.

* In SuperStar if the user clicked twice very quickly on the Play or Play All button, the program
Beeped, played and then crashed at the end of the Play.

¢ In SuperStar, if in Visualization mode and a smooth effect color was set to white, and then the
color was changed to something that is not white, the bar in the time layers would stay white.

What's New in Version 3.11.2

e Changes to Edit menu keyboard shortcuts

Verifier checks for old MC-P compatibility mode

Optional speed improvements for saving in the Sequence Editor
Manual creation of compressed sequences

Bug fixes

Changes to Edit Menu Keyboard Shortcuts

The menu items Undo Settings and Use Internal Media in the Sequence Editor's Edit menu did not
have shortcut keys assigned to them. To give them shortcut keys, the menu items "Turn on Loops"
and "Select" were changed to "Turn on Loop Lewels" and "Select Zone", which allowed them to be
moved to the shortcut keys "V' and "z", thus freeing up "s" and "|" for Undo Settings and Use Internal
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Media, respectively.
Verifier Checks for Old MC-P Compatibility Mode

The Verifier now checks to see whether old MC-P compatibility mode has been enabled. This
compatibility mode is required for certain controllers, but they are rare, and if it is enabled, it can
cause significant overhead on your network. The Verifier therefore warns you if it detects that this
mode is enabled.

Optional Speed Improvements for Saving in the Sequence Editor

When the Sequence Editor saves a sequence, it actually saves it to a temporary file first, and then
attempts to reload that temporary file. Only if the load is successful will it actually overwrite the
existing "real" sequence file with the newly saved temporary one. This is intended to minimize the
potential for a save where something went wrong to cause the user to lose a good (earlier) save.
This behavior is now optional, via the Verify Load option in the Saving Preferences menu. 1t is still
recommended to have this behavior enabled, but if you work with very large sequences that take
significant amounts of time to load and save, and are willing to take the risk of a corrupted save
overwriting your previous good save file, you might want to turn it off in order to speed up saving.

The Sequence Editor also creates a compressed sequence whenever it saves a sequence, but you
can now optionally disable this behavior via the Export Compressed option in the Saving Preferences
menu. Again, it is still recommended to have this behavior enabled, but if you work with very large
sequences that take significant amounts of time to save, you might want to turn it off in order to
speed up saving. If you do choose to turn it off, it is highly recommended that you manually ensure
that your sequences each have an up-to-date compressed sequence before starting your show. You
can do so via the Export as Compressed command from the File menu.

Manual Creation of Compressed Sequences

By default, the Sequence Editor creates a compressed sequence whenever it saves a sequence, but
this behavior can be disabled via the Export Compressed option in the Saving Preferences menu. If
you choose to disable that option, it is highly recommended that you manually ensure sure that your
sequences each have up-to-date compressed sequences before starting your show. You can now
manually create a compressed sequence for a single sequence via the new Export as Compressed
menu item on the File menu, or manually create compressed sequences for a show or for the entire
schedule via the Sequence Compressor program.

Bug Fixes

e The LOR Verifier would incorrectly report that three files (AdjMmsEng.dll, amp3dj.ocx, and
Asoedmms.ocx) had unexpected version numbers.

e SuperStar's Play 8 Seconds and Play All buttons were not staying depressed when used in
visualization mode, and the other buttons were not being grayed out.

e SuperStar's Configuration dialog box will now give a message if the range of unit IDs for a network
is invalid.

¢ In SuperStar, if the row visualization had a fixture that was not in the real visualization, it
sometimes would not get reported as a warning.

¢ If you modified a morph in SuperStar and then played a part of the sequence, the start and end
coordinates of the morph would get set to -1 after stopping play of the sequence.

¢ SuperStar might have crashed if you put a smooth effect in the right half of a visualization that was
in wrap around mode.
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¢ SuperStar might have crashed when playing a shockwave effect using a visualization in wrap
around mode, especially if the shockwave had a large leading or trailing edge.

e Various Light-O-Rama programs used to depend upon the Microsoft library "SCRRUN.DLL". If this
library was missing or misconfigured, various strange problems would occur. An example is that
keyboard maps would not function in the Sequence Editor. In recent times, this library seems to
be missing or misconfigured more and more frequently on customers' computers, and so Light-O-
Rama no longer depends upon this library.

e SuperStar now checks in the Configuration dialog box to make sure that entries for the star unit
1D, first CCR unit ID, and the ranges of the networks are all valid.

e |f Windows had been running for about 25 days or more without having been shut down, the
Hardware Utility would sometimes not be able to write the time to an SD card.

What's New in Version 3.11.0

e Cosmic Color Array support

e Channel priority

e Named timing grids kept even if empty and not in use

e New card and controller support in the Hardware Utility

e Easy Light Linker configuration change

e SuperStar font update

e SuperStar CCR string segments increase

e Sequences can be removed from the Recent Sequences list
e Paste options mowved to their own portion of the Tools Panel
e Memory and speed improvements for sequences

e Control over number of recorded undo items

e Changing input types with InputPup devices

e New MP3g3 Show Time Director firmware

e New CTB32LD/LOR160xWg3 firmware

* Bug fixes

Cosmic Color Array Support

Cosmic Color Arrays are now supported in the Sequence Editor, via the Insert Device dialog and also
in channel grouping.

Channel Priority

In most cases, if two lighting effects for two different channels on the same controller are supposed
to happen at the same time, it does not matter which of the two commands is sent to the controller
first. Howewer, in some cases, it does matter. For example, a macro command for a Cosmic Color
Device should be sent before a command for a regular channel on that CCD (presuming the two
commands are supposed to take effect at the same time). In the past, this was determined based
upon the circuit number of each channel. Howewer, with the introduction of Cosmic Color Arrays,
this is no longer possible, as their special channels use different circuit numbers than the special
channels of other CCDs. So, the concept of "channel priority” has been added, to explicitly set
which channels take priority over which others. Please note: If you have created a Cosmic Color
Device (or Array) channel group in the sequence, channels within that group will automatically have
their priorities set appropriately. You only need to manually set the priority yourself if you have not
included those channels in a CCD/CCA channel group in the sequence.

Named Timing Grids Kept Even If Empty and Not In Use
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Previously in the Sequence Editor, if you changed which timing grid a track was using, and the old
timing grid was empty (i.e. had no timings) and was not in use by any other track, that old timing
grid would be discarded. This is now only done if, additionally, that old timing grid does not have a
name.

New Card and Controller Support in the Hardware Utility

The Hardware Utility now recognizes the CTB08Dg3 card, and the LOR800W which uses that card.

Easy Light Linker Configuration Change

Easy Light Linker (ELL) configuration has been changed in the Hardware Utility: Support was added
for the new LOR-RF-V5, which supports 115200 kbps. Also, previously, the LOR-RF-V4 only
supported speeds up to 57600, but with the introduction of the LOR-RF-V5, there will be a new
release of firmware for the LOR-RF-V4 that will enable it to run at 115200 as well.

SuperStar Font Update

Sevweral of SuperStar's fonts have been updated:

6-6x6_Thin_Vertical.system.font
8-8x8_Thin_Vertical.system.font
10-12x12_Bold_Vertical.system.font
10-12x12_Thin_Vertical.system.font

SuperStar CCR String Segments Increase

The number of CCR string segments that can be used in an imported visualization in SuperStar has
been increased from 124 to 160.

Sequences Can Be Removed from the Recent Sequences List

Sequences can be removed from the Sequence Editor's Recent Sequences list. To do so, right-click
on the file you wish to remowve, and a popup menu will open. The menu will have an entry to remove
the file from the list.

Paste Options Moved to Their Own Portion of the Tools Panel

The Clipboards subpanel of the Tools Panel in the Sequence Editor used to contain controls for both
clipboards and for paste options. The paste options have now been mowed to their own subpanel.
This will hopefully make them a little easier to get at when many clipboards are present, by
collapsing the Clipboards subpanel.

Memory and Speed Improvements for Sequences
Various memory and speed improvements related to sequences have been made. For example, one
particular very large sequence which took about 2 minutes 15 seconds to load, consuming about 420
MB of memory, now takes about a minute and a half and about 160 MB.

Control Over Number of Recorded Undo ltems

The Sequence Editor only remembers a certain number of changes (per sequence) for undoing and
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redoing. This number can now be changed, via the Undo Settings dialog. For most users, the

default value will be fine, but users with large sequences who make large changes to those
sequences might want to place a smaller limit on the number of remembered changes so as to help
awoid running into memory-related issues.

Changing Input Types with InputPup Devices

The Hardware Utility will now allow changing input types (NO/NC) with InputPup devices.

New MP3g3 Show Time Director Firmware

A new version of the firmware for the MP3g3 Show Time Director, MP3g3-V5_25.Ihx, fixes a bug
where animation sequences (non-musical sequences) would not run if two networks were specified in
the file.

New CTB32LD/LOR160xWg3 Firmware

A new version of the firmware for CTB32LD/LOR160xWg3 controllers, CTB32LG3-V1_12.lhx, fixes a
bug where most standalone sequences would not operate properly.

Bug Fixes

In the Hardware Utility, sometimes the ELL icon would show up when an MP3 director was
connected but no ELL was on the network.

Smooth effects in SuperStar would not export beyond 4 minutes 21 seconds of a song.

The LOR Verifier would report an "error 7" on the file "audioconv.ocx”, meaning that the file was
missing. This is because the file is no longer used by the current version of Light-O-Rama
software, and therefore is no longer distributed. That check has now been replaced with checks
for new libraries used by the current version of software.

In SuperStar's Visualization mode, the Pixel Resolution macro was not being supported for
auxiliary networks.

On some computers, SuperStar would have a repaint problem that would happen when you
replayed a sequence to the computer screen.

Import visualization in SuperStar had various issues relating to mapping lights to the sequencing
grid.

Text with a ramp in SuperStar could create channel commands for channel 151 when exported,
resulting in white flashes on the CCR.

In SuperStar, the selection rectangle would not get drawn around text actions that had a trailing
ramp.

SuperStar would crash when saving a file with a very large image.

Only one star could be set when applying a star scene in SuperStar.

If you had more than one sequence open in the Sequence Editor, and they were not maximized
(with respect to the Sequence Editor itself, as opposed to with respect to the screen), and you
attempted to close them via their "X' buttons, the last one would not close.

Musical sequences are not allowed to have loop levels, but the Sequence Editor would allow you
to add a media file to an animation sequence that had loop lewvels, which would lead to various
issues. Now the Sequence Editor will offer to remowve the loop levels, and will not add the media
file unless the loop levels are remowved.

In SuperStar, selecting or moving an effect in the time layers in a large sequence could take 30
seconds or more and cause the program to appear to crash.

If you moved two smooth effects that have the same start time up or down a layer in SuperStar,
one of them could disappear.
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If you tried to use a sequence containing a loop that looped back more than 255 times as a
standalone sequence, the Hardware Utility would refuse, giving a not-too-helpful error message
that merely said "Owerflow". The Hardware Utility will still refuse, but it will now give an error
message that is, hopefully, more helpful.

There could be a flicker at the end of the tail on a visEffect. The flicker would only be seen in the
exported file.

Moving endpoints of a group of morphs in SuperStar wouldn't move to the upper sequencing rows if
using half ribbons in CCR mode.

A light in a QuickVis visualization would fail to draw if the QuickVis was large and had to be
shrunk to fit on the SuperStar screen.

What's New in Version 3.10.14

Bug fixes

Bug Fixes

The Sequence Editor could sometimes report that a media file is not present when in fact it is
present. This could cause an error within the Sequence Editor or any of its tools. This problem
usually manifested itself when adding a track to a new sequence. However, any part of the
Sequence Editor that requires media could also have had this issue.

CCRs laid end to end horizontally did not import properly in SuperStar.

SuperStar would crash on some computers if the first effect in a sequence was the smallest star
in the SuperStar star.

When modifying a text mask in SuperStar, it would always display an error.

In SuperStar, visualizations with draw objects that have the same unit ID would display the square
in the sequencing grid as disabled, and instant sequence would not properly define effects to the
row.

A matrix of CCR props would sometimes not import in the proper order in SuperStar.

What's New in Version 3.10.12

Bug fixes

Bug Fixes

Text and images sometimes would not clip properly when played to a visualization in SuperStar.
Some visualizations would not import properly in SuperStar.

What's New in Version 3.10.10

Help file available in EPUB format
Bug fixes

Help File Available in EPUB Format

An EPUB (e-book) version of the Light-O-Rama help file is now available, and is published along with
the installer as well as on the Light-O-Rama website.

Bug Fixes
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¢ Importing a prop into a visualization that was empty (that is, which had no fixtures) would cause
the object selection area to disappear from the Visualizer.

* If Play Again was used in the Sequence Editor before Play (without "Again") had ever been used,
play would hang.

e |f a large sequence with a ribbon located at the bottom was exported, SuperStar would crash.

* If SuperStar was launched into CCR mode, the "star in use" setting would get set to "no", and the
star channels would get played to ribbons, and you wouldn't be able to add star channel effects
either.

* Visualization errors in SuperStar no longer get reported at launch if you are in CCR mode. Also,
visualization file errors are not reported when loading a CCR mode sequence.

e Some dialog boxes in SuperStar would allow the start time of an effect to be after the end time.

What's New in Version 3.10.8

e New device in Insert Device: CMB24D

Continued improvements to media handling
VisEffects

Import Visualization Pair

"Reverse" keyword for pixel layout in CCR fixtures
e "Myorder" keyword for order of fixtures

* Bug fixes

New Device in Insert Device: CMB24D

The Insert Device dialog of the Sequence Editor now supports an additional device: The CMB24D. It
is a 24 channel controller; you can tell the Insert Device dialog to treat it either as 24 channels or as
8 RGB channels.

Continued Improvements to Media Handling

The Sequence Editor will continue to attempt to create two different internal media formats, for
different purposes. However, should one of those conversions fail, the Sequence Editor will no longer
refuse to create or open a sequence. Instead, the user is simply informed that one or both of the
conwersions failed. The Sequence Editor will then choose the best file to use for whatever purpose
based upon which of the three files exists and/or the user-specified options. If a format that is
required for a particular use could not be created, that use will simply not be available. For example,
the Beat Wizard requires that a particular internal media file be created; if it could not be created for
a particular sequence, then the Beat Wizard cannot be used for that sequence, and a warning will be
presented if you attempt to use it.

A new option, Use Internal Media, has been added to the Edit menu. This option is set per
sequence and is saved when the sequence is saved. It allows you to control whether or not Light-O-
Rama attempts to use the internal formats with the sequence. It is recommended that this option be
on. The option defaults to being on, except when a sequence created using an earlier version of
Light-O-Rama is loaded (so that media handling behaves for these sequences as it did in earlier
versions, unless you choose otherwise). More details can be found at "Use Internal Media".

VisEffects

SuperStar now supports "visEffects”. This gives the ability to apply morphs to the visualization
instead of to the sequencing grid, and allows a smooth coordinated sweep across all the lights in the
visualization.
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Import Visualization Pair

You can now import a pair of visualizations into SuperStar, as a "Row Visualization" and a "Real
Visualization". The Row Visualization is to be laid out in rows according to how you want the lights
mapped to the sequencing grid. The Real Visualization should be laid out how the light display
actually appears.

"Reverse" Keyword for Pixel Layout in CCR Fixtures

SuperStar now supports a new keyword, "reverse”, for the layout of pixels in a CCR fixture.

"Myorder" Keyword for Order of Fixtures

SuperStar now supports a new keyword, "myorder”, controlling the order of fixtures.

Bug Fixes

Musical sequences whose media files had names that included multiple consecutive periods (such
as "1983... (A Merman | Should Turn To Be).mp3") would not successfully play.

In SuperStar, if you clicked on an effect in one of the effect lists and then hit play, the effects
wouldn't get rebuilt and played for the new location you are at.

The movement and color of instant sequence effects in SuperStar would get reinitialized every 10
seconds.

The grid setting and star in use setting could change when changing between SuperStar's CCR
mode and Visualization mode.

After changing from SuperStar's Visualization mode to CCR mode, you could not add a scene to
the star.

Export of large sequences could cause SuperStar to crash.

On some computers with older versions of Windows Media Player, no matter what play speed was
selected in the Sequence Editor, the sequence would always play at normal speed.

In SuperStar, rendering a fast rotating fan with thin blades would play fine on the computer screen,
but would export as a dot.

In SuperStar, a fan longer than ten seconds would play fine on the computer screen, but when
exported would last less than ten seconds.

If a soundboard interactive group were set up in a show, and contained a single sequence on a
particular trigger, and that trigger were tripped while that sequence was playing, an error message
would occur ("ERROR STARTING SEQUENCE (This key is already associated with an element of
this collection)"). The sequence would not start, and could no longer be started during the current
run of the show.

Text masks in SuperStar were not working for imported visualizations using a matrix made up of
fixtures.

SuperStar's smooth effects would not play to white mono-color lights.

Shimmers produced in SuperStar would not stay the same color while shimmering.

If a CCR with no assigned base unit is in an imported \visualization, SuperStar will issue a warning.
You can now open a file in SuperStar by double clicking on the file in Windows. Previously,
SuperStar would crash while attempting to open the file if you did this.

In an imported visualization in SuperStar, props of two or three fixtures would be in reverse order.
In an imported visualization in SuperStar, the trailing ramp of an image would not clip the maxrix
CCRs.

What's New in Version 3.10.6
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* Bug fixes
Bug Fixes

e If you exported a sequence from SuperStar, and then opened that sequence in the Sequence
Editor, made a change to it, and sawved it, the Sequence Editor would warn you that the sequence
was created by an older version of Light-O-Rama.

e If SuperStar were already in visualization mode, and you opened a .SUP file that referenced a
visualization file that did not exist, SuperStar could crash.

What's New in Version 3.10.4

e Additional networks in SuperStar
* Bug fixes

Additional Networks in SuperStar

The number of networks in CCR mode in SuperStar has been increased from 4 to 8. Note that in
Visualization mode, you can have the full 16 networks.

Bug Fixes

¢ A fast double click in the object selection area could lock up the Visualizer.
* In SuperStar, if the "white" color control is nonzero, and you scroll some text or images using a
visualization, the text or image in the exported sequence could skip and jump in some cases.

What's New in Version 3.10.2

¢ Bug fixes
Bug Fixes

¢ In SuperStar, the clipboard could not be saved to a file.

e The Sequence Editor would sometimes give an "invalid procedure call or argument” error when
attempting to save a sequence.

¢ The Sequence Editor would have problems with MIDI files, most prominently being unable to
create new musical sequences based on MIDI files.

e Sometimes an imported visualization in SuperStar would get resized too large, and its bottom
would get chopped off.

What's New in Version 3.10.0

Sorting in the Keyboard Preferences dialog

Copy and Print in the Keyboard Preferences dialog
Better memory usage in SuperStar

New and updated fonts in SuperStar

Updated SuperStar visualizations

Eight channel Gen3 controller support in Hardware Utility
Improved network detection in the Visualizer

LOR Control Panel can restart the Show Player
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Show Player can automatically shut down and restart in certain situations
Show Player will decache sequences if memory usage is too high
Visualizer Keywords in SuperStar

Duplicate RGB channel assignment warning in SuperStar

More DMX adapters supported

LOR Diagnostic shows more information

Copy and sawe in LOR Diagnostic

Beat Wizard, VU Wizard and Waveform Display support more media types
Better support for variable bit rate MP3s

Optionally play only audio while sequencing a video sequence

Show entire head at start of morph

Acceleration for morphs

Smooth effects in SuperStar

Support for more (and less) channels in the Hardware Utility

Firmware updates

Extend length of effects in instant sequence

Instant sequence and timing map dialog settings saved

Bug fixes

Sorting in the Keyboard Preferences Dialog

The Keyboard Preferences dialog in the Sequence Editor would previously display the list of
keyboard preferences in order of the keys - for example, an entry associated with the A key would
be listed before an entry associated with the B key. Now, the list can be sorted either in that order
or in order of operation - for example, an entry that causes the "Apply Fade Down" operation to be
performed would be listed before an entry that causes the "Copy Timing" operation to be performed.

Copy and Print in the Keyboard Preferences Dialog

In the Sequence Editor's Keyboard Preferences dialog, there are now new buttons to copy the list of
keyboard preferences to the Windows text clipboard and to print the list.

Better Memory Usage in SuperStar
When building a sequence, SuperStar now uses about half as much memory as it used to.
New and Updated Fonts in SuperStar

Five new vertical fonts were added to SuperStar, and two fonts were updated with new asterisk
characters. The new fonts are:

6-5x6_Thin_Vertical.system.font
6-6x6_Thin_Vertical.system.font
8-8x8_Thin_Vertical.system.font
10-12x12_Bold_Vertical.system.font
10-12x12_Thin_Vertical.system.font

And the updated fonts are:

e 10-12x12_Thin.custom.font
e 10-12x12_Thin.system.font
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Updated SuperStar Visualizations

Two sample visualization files for SuperStar, SuperStar_ControllersBottomLeft.lee and
SuperStar_ControllersTopLetft.lee, have been updated.

Eight Channel Gen3 Controller Support in Hardware Utility

The Hardware Utility's Advanced Configuration screen used to support only 16 or 32 channel
controllers. It now also supports 8 channel Gen3 controllers.

Improved Network Detection in the Visualizer

On a very limited number of machines, the Visualizer would be unable to detect the available network
adapters. If the detection fails, an alternate method is now used.

LOR Control Panel Can Restart the Show Player

In previous versions of Light-O-Rama, if the schedule was enabled but the Show Player was not
running (for example, if it were stopped via Windows Task Manager), the LOR Control Panel would
simply change so that the schedule was disabled. Now, it will instead attempt to restart the Show
Player. This may also help get the show running again more quickly if the Show Player crashes, but
not necessarily: In at least some cases the Show Player might still be "running" in a technical sense
until the user dismisses a Windows message box saying that the Show Player had crashed.

Show Player Can Automatically Shut Down and Restart in Certain Situations

If no show is playing, and if no show is scheduled to start playing within the next sixty seconds, and
the Show Player is using over a hundred megabytes of memory (commit charge size), it will
automatically shut itself down (and will then be automatically restarted by the LOR Control Panel,
assuming the schedule is still enabled). The intention of this is a preventive measure to protect
against ill effects of possible memory leaks in the Show Player, which could otherwise build up over
time to a point that would cause the Show Player to crash.

This behavior can be disabled (so that the Show Player will never shut itself down automatically) by
unchecking "Show Player Memory Restarts"” in the LOR Control Panel's right-click popup menu.

Show Player Will Decache Sequences If Memory Usage Is Too High

During a show, whenever a sequence is about to start, the Show Player checks how much memory
(commit charge size) it is using. If it is using over a gigabyte of memory, it will attempt to reduce
memory usage by decaching sequences that it has previously loaded, until it drops down below 900
megabytes (or until it has no more sequences which it can decache). This is so as to prevent it from
caching more and more sequences until it finally runs out of memory and crashes.

If it winds up needing to play one of the decached sequences again, this means that it will have to
reload that sequence. Therefore, the sequences are decached in an order intended to minimize
loading time:

1. If a sequence is currently playing, it will not be decached.

2. If the Show Player knows for sure that a sequence is about to be played, it will not be
decached. Please note, though, that the Show Player may not always know for sure that a
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sequence is about to play, even if you know it, and so in certain situations you may
occasionally see a sequence be decached soon before being played.

3. Sequences that are in sections of the show that are already finished are considered highly
decacheable, and will be decached before any other sequences. For example, if the
Shutdown section of the show is playing, then any sequences in the Musical or Animation
sections are considered very decacheable, since they will never be played again during this
run of the show.

4. Compressed sequences are considered more decacheable than non-compressed sequences,
since compressed sequences can be loaded much more quickly than non-compressed
sequences.

5. Two compressed sequences, or two non-compressed sequences, are compared to each other
based upon the number of times that they have been played and the amount of memory that
they took to load. Generally speaking, all else equal, a smaller sequence is more
decacheable than a larger sequence, since it can be loaded more quickly. However, for any
specific pair of sequences, the larger might be decacheable if the smaller sequence were
played sufficiently more often.

Visualizer Keywords in SuperStar

You can now control various behaviors of how SuperStar will import a visualization by putting certain
keywords in the comments areas of props or fixtures in the visualization. For example, you can
mark a prop in the Visualizer so that when SuperStar imports the visualization, it will put the prop's
lights in certain specific locations in the sequencing grid.

Duplicate RGB Channel Assignment Warning in SuperStar

If you have RGB lights with duplicate channel assignments in an imported visualization, SuperStar
will warn you.

More DMX Adapters Supported

Two more DMX adapters, the DMXKing UltraDMX Micro and the DMXKing UltraDMX RDM Pro, have
been added to the list of supported DMX adapters. Both should be configured in LOR Network
Preferences to use the "ENTTEC DMX USB Pro" protocol.

LOR Diagnostic Shows More Information

In the past, LOR Diagnostic would display certain specific entries from the Light-O-Rama portion of
the Windows registry. If Light-O-Rama started using a new registry entry, and LOR Diagnostic was
not updated to include it, the information simply wouldn't be displayed at all. It now still shows those
specific entries, but also shows raw data from the entire LOR portion of the registry, so that the
information is present even if LOR Diagnostic is not specifically updated to include it.

Copy and Save in LOR Diagnostic

The LOR Diagnostic utility now has buttons enabling you to copy the utility's output to the Windows
clipboard or to sawe it to a file.

Beat Wizard, VU Wizard, and Waveform Display Support More Media Types
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The Sequence Editor's Beat Wizard, VU Wizard, and Wawveform Display now support more media
types, including video files. It also now has better support for the types that it supported in the past -
for example, they would be unable to handle certain MP3s, issuing an error message such as
"Cannot init conversion"”.

Better Support for Variable Bit Rate MP3s

In past versions, if your musical sequence used a variable bit rate MP3, and you wanted to use
certain features in the Sequence Editor (such as starting play somewhere in the middle of the
sequence instead of at the natural start of the sequence), you would need to conwert the MP3 to use
a constant bit rate (using a third party audio editor such as Audacity), or it would not work properly.
Now, you may be able to do this without conwverting to a constant bit rate. Note that it's possible that
you may still have to convert in some cases, so keep tools like Audacity in mind just in case.

Optionally Play Only Audio when Sequencing a Video Sequence

The Sequence Editor's Video Preferences dialog now has an option which can be used to make the
Sequence Editor play only the audio track of a video file in a musical sequence, as opposed to also
showing the actual video.

Show Entire Head at Start of Morph

In SuperStar, there is now an option to show the entire head at the start of a morph. This can be
used, for example, to have a morph start out 50 pixels long, and get progressively shorter until it
disappears at the end.

Acceleration for Morphs

In SuperStar, morphs can now be set up to accelerate (or decelerate). This can be used, for
example, to make a morph going up that slows down, or a morph going down that speeds up, as if
under the influence of gravity.

Smooth Effects in SuperStar

SuperStar now has three "Smooth Effects": Shockwawe, Spiral, and Fan.

Support for More (and Less) Channels in the Hardware Utility

The main test screen of the Hardware Utility now supports 32 channels, rather than 16 as in the
past. This allows the use of this screen (rather than the console) to test the DIO32 (in native
address mode) and the new CMB24D (which is a 24 channel Direct Current (DC) card).

The advanced configuration screen previously only supported 16 and 32 channel cards. It has been
updated to support the new CTB08Dg3, an eight channel card.

Firmware Updates
Sevweral new firmware updates are included:

e CCB100D-V1_16.Ihx
e CCR150D-V1_17.Ihx
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CTB16PG3-V1_07.lhx
CTB32LG3-V1_11.LHX
DIO32_V1-32.LHX
mDC_MP3_V4-22.Ihx

The CCB100D and CCR150D firmware includes additional support for 500K. The CTB16PG3 and
CTB32LG3 firmware includes support for "noisy AC" (less chance of flicker on noisy power). The
DIO32 and mDC_MP3 firmware contain many changes that have previously been posted online, but
never before distributed with the software installer.

Extend Length of Effects in Instant Sequence

SuperStar now has an additional option for instant sequences: "Extend Length of Effects”. This
option will extend the length of each effect up to the start of the next effect. This makes the instant
sequence less "blinky".

Instant Sequence and Timing Dialog Settings Saved

SuperStar now saves the settings used in the Instant Sequence and Timing Map dialog boxes.

Bug Fixes

In SuperStar, if you created a sequence in Instant Sequence, then clicked on "roll dice" and
"sequence all", it would not erase the existing sequence before creating the next sequence. You
would end up with multiple sequences stacked on top of each other.

Some memory leaks related to sequences have been fixed.

If you attempted to add an effect in visualization mode in SuperStar, and the fixtures involved did
not contain any of the colors in the effect, an error would be displayed and you would not be
allowed to add the effect. This error would prevent you from using group modify to mowve pixels on
scenes. This error has been changed to a warning, and you are allowed to proceed if you want.
After moving a selected group of effects in SuperStar, the first active selection could have been
mowved. This would result in group modify thinking that some attributes had been changed when
they had not.

In SuperStar's Import Visualization dialog box, if you type a value for "max length" and then click
OK, it would not use the value that you had typed in.

If you add a prop in SuperStar with a row and column specified, and then add a prop without a row
and column specified, it would use the row and column of the first prop for both props.

A memory leak in SuperStar, related to the conversion of an MP3 to a WAV file, has been fixed.
Non-CCR RGB strings would not process correctly in SuperStar if there were more than 48 pixels.
If SuperStar's sequencing row max length was more than 50, and if the total number of 50 pixel
CCRs was more than 24, it would make the sequence row count be 24.

If SuperStar's sequencing row max length was more than 50, the location of the SuperStar star
was not being calculated properly.

The time progress display while SuperStar was playing a sequence would flicker.

If two channel commands overlapped in SuperStar, the channel would play differently in SuperStar
than it would in the exported sequence.

If the SuperStar fonts directory contained more than twelve fonts, SuperStar would hang.

If the text in a SuperStar text action contained a double quote character ("), everything after that
character would disappear when you saved the .sup file and reloaded it.

If no method returns an available network adapter for the Visualizer, the "Local Loopback" adapter
is automatically used.

When writing a show to an SD card via the Hardware Utility, you could type in the dropdown box
which is supposed to allow you to select the show number. Doing so would cause the show
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number to be 0.

e The "cleanup sequence" in the Musical section of a show was not paying attention to the Musical
section's "Turn used lights off at the end of each sequence" option. It would instead always turn
the used lights off, no matter whether the option was enabled or not.

* If you open a SuperStar sequence and it fails to open the associated audio file, the time layers
would be blank. This has been fixed to default to a five minute length.

¢ The Hardware Utility might have crashed if an error occurred while selecting a COM port.

e When importing a visualization in SuperStar, sometimes the morph selection points would
disappear, and the next time you used them, a spurious line would get drawn.

¢ The LOR Diagnostic utility was displaying incorrect information about the configured LOR
networks, and no information about configured DMX universes.

¢ If the name of a DMX adapter began with a number, the Network Preferences program would list its
name right justified instead of left justified on the DMX tab.

e On some computers, various Light-O-Rama programs would refuse to run, saying that "Light-O-
Rama is not correctly installed", despite LOR having been installed.

¢ Undo and redo in SuperStar would sometimes not work properly; sometimes redo would not
restore all effects that had been undone, and sometimes undo or redo would cause SuperStar to
crash.

What's New in Version 3.9.0

e Comm speed changes

e Hardware Utility support for two networks in G3 MP3 Directors
e Hardware Utility support for 500K speed in G3 MP3 Directors
¢ Increased range of allowable sequencing grid lengths in imported visualizations
e New functions added in SuperStar dialogs

e Warning for channels needing a higher license lewel

e Verifier can be used on a single show or a single sequence

e New CCB/CCP firmware: Version 1.15

e New CCR firmware: Version 1.10

e New CTB32LG3/LOR160xWG3 firmware: Version 1.08

e New CTB16PCG3 firmware: Version 1.05

e New G3-MP3-Director Firmware: Version 5.22

* Bug fixes

Comm Speed Changes

Light-O-Rama networks were previously able to use communication speeds up to 115.4K. New
Generation 3 controllers, Cosmic Color Bulbs, Cosmic Color Ribbons, and Cosmic Color Pixels are
now able to support 500K, approximately four times faster. You can set your network to use 500K in
the LOR tab of the Network Preferences program. You may hawe to update your firmware to take
advantage of this new feature.

Also, network speeds are no longer referred to as distances. Instead, the actual speed of the
connection is used. "Long Range" is now called "19.2K", "Awerage" is now "57.6K", and "Short
Range" is now "115.4K".

Hardware Utility Support for Two Networks in G3 MP3 Directors

Previously, a Light-O-Rama MP3 Director was able to control a show on a single LOR network. The
new Generation 3 MP3 Directors are able to control two separate networks, and the Hardware Utility
has been updated to support this new functionality.
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Hardware Utility Support for 500K Speed in G3 MP3 Directors

Previously, a Light-O-Rama MP3 Director was able to support communications speeds up to
115.4K. The new Generation 3 MP3 Directors are able to additionally support 500K, approximately
four times as fast as earlier controllers. The Hardware Utility has been updated to support this new
functionality. You may have to update your firmware to take advantage of this new feature.

Increased Range of Allowable Sequencing Grid Lengths in Imported
Visualizations

When importing a visualization into SuperStar, you can now set the maximum sequencing grid
length anywhere from 25 to 200, rather than the previous 50 to 100.

New Functions Added in SuperStar Dialogs

Various new functions were added to some of SuperStar's dialog boxes: "Mowve pixels" was added in
the scene group modify dialog box; "Mowve endpoints” and "Reverse direction” were added in the
morph group modify dialog box; "Use Head Color" was added in the morph dialog box.

Warning for Channels Needing a Higher License Level

When opening a sequence in the Sequence Editor, a warning is presented if the sequence contains
channels that your license level cannot control. This warning appears only once per Sequence
Editor session.

Verifier Can Be Used on a Single Show or a Single Sequence

The Light-O-Rama Verifier, which can be used to check for various problems with your schedule,
shows, and sequences, used to check your schedule, the shows that are on that schedule, and the
sequences that are in those shows. It still can do that (and still does it by default), but now you can
also ask it to check just a single show (regardless of whether it is scheduled or not), or a single
sequence (regardless of whether it is in a show or not).

Note, though, that it's possible that two sequences which each pass individual checks from the
Verifier without any problems might still have problems when used together within a single show. So
it's always a good idea to run the Verifier against their show, and especially against the entire
schedule, at least once before going live with your show.

New CCB/CCP Firmware: Version 1.15

This new firmware for Cosmic Color Bulbs and Cosmic Color Pixels supports 500K communications
speed.

New CCR Firmware: Version 1.10
This new firmware for Cosmic Color Ribbons supports 500K communications speed.
New CTB32LG3/LOR160xWG3 Firmware: Version 1.08

This new firmware for CTB32LG3/LOR160xWG3 has the following changes:
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Support for 500K communications speed.

Support for LED Display sharing with the new G3-MP3-Director when the director is attached
rather than the regular Display Daughter Card.

A bug was fixed in standalone mode when the unit is used as a director for other controllers while
running a standalone sequence.

New CTB16PCG3 Firmware: Version 1.05

This new firmware for CTB16PCG3 controllers supports 500K communications speed.

New G3-MP3-Director Firmware: Version 5.22

The G3-MP3-Director is a new device that will replace the DC-MP3.

Bug Fixes

In SuperStar, a visualization with a matrix of CCRs sometimes would not clip effects to stay within
the CCR matrix. This was especially noticeable when playing image actions on the CCR matrix.
In SuperStar, if you saved an archive file, and then opened it, you could no longer export it with the
demo version.

If you did a Create QuickVis on a combination of CCR controllers and standard 16 channel
controllers, then SuperStar would place the first row of 16 channel controllers on top of the last row
of CCR controllers.

In SuperStar, only the end points of RGB light strings (strings where all the lights are the same
RGB color) were being drawn. This has been fixed to draw bulbs along the entire string.

When pressing the Play or Paste button in SuperStar, some unnecessary screen redraws were
done. These have been remowved.

Selection of an RGB fixture was not working in SuperStar.

If you change from CCR mode to Vis mode, SuperStar will now automatically rename the file by
appending "_vis" to the end of the name. This is to prevent cases where you would otherwise lose
the star channels in a sequence that was done in CCR mode.

If the Sequence Editor had hold of an audio file while SuperStar tried to create timings using that
audio file, SuperStar would crash.

If you are in "Full Range" color mode in SuperStar, and you set the color controls with the color
picker dialog box, red and green could be set to 130. This caused constant "integer out of range"
errors because the color fields in the dialog boxes had values out of range.

In the Animator, if the file that was supposed to be used as the background image of the animation
did not exist, the "Remove Image" button would be grayed out, thus giving no straightforward way
to remowe the reference to the image from the animation.

When trying to create a new musical sequence in the Sequence Editor, media files with the
extension "m4a" would not be shown unless the dropdown box controlling the types of media files
displayed was changed from "All Supported Files" to "MPEG Audio".

Added support for non-continuous lines in a light string in a visualization in SuperStar.

Added support for "superstar cool" and "superstar warm" to indicate the dimming curve to use in

SuperStar.
On a large resolution screen, you could have ended up with more than ten rows in the time layers

in SuperStar.

In SuperStar, if using an imported visualization using up and over CCRs, or wedge CCRS, images
got clipped to the first half of the sequencing rows.

One of the things that the Verifier checks is whether or not any LOR program files (such as the
Sequence Editor) are missing. There were a few such program files that it was not checking for.
SenvwoDog controllers were not being properly detected by the Hardware Utility.

If an international character was used in the name of an audio file in SuperStar, and the sequence
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was exported, the Sequence Editor would fail to open the sequence.

* In some situations, a SuperStar sequence could be erased if you saved after clicking "New
Document".

¢ A memory leak, which could affect any program using a sequence but which was most noticeable
in the Show Player during shows that were using non-compressed sequences, has been fixed.

* In SuperStar, after a paste of a group of effects and nudging the pasted effects around, sometimes
a "group modify" would modify more than it should.

* When changing configuration or layout information, SuperStar would crash if SSEdit.cfg was "read
only" (this would typically only happen if the Lightorama directory were placed in an area that the
operating system does not allow write access to). This has been fixed so that SuperStar will
instead display an error message advising that configuration and layout information could not be
saved.

What's New in Version 3.8.0

e M4A Support
e Hiding Fixture/Prop Names

e Default Channel Names Options
e Protected Sequences on SD Cards

* Bug Fixes

M4A Support

M4A media files are now supported in musical sequences.

Hiding Fixture/Prop Names

A new option has been added to hide fixture/prop names in the Visualizer when something is
selected in the editor. This can reduce editing screen clutter.

Default Channel Name Options

When creating new channels on a fixture in the Visualizer, there are now options to default the
channel name to one or more of the Fixture Name, Channel Order Number, or RGB Color (if
applicable).

Protected Sequences on SD Cards

Protected sequences can now be used on SD cards via the Hardware Utility or the Simple Show
Builder.

Bug Fixes

* When upgrading to a new version of Light-O-Rama, existing SuperStar custom fonts would be
overwritten with those from the installer. Only the system fonts, not the custom fonts, should have
been overwritten (both should be installed if not already present).

e After double clicking a .LEE file in Windows, the Visualizer's toolbar icons were sometimes not
correctly enabled.

e Pressing Delete a second time while the Visualizer's "Are You Sure?" dialog was presented
caused a second "Are You Sure?" dialog to pop up. After responding to both of them, the
simulation data could be left in a corrupted state.

* If you reduced the number of CCRs in a SuperStar sequence, saved, relaunched, and selected a

© 2015 Light-O-Rama, Inc.



What's New? 81

scene, the program would hang.

¢ In SuperStar's visualization mode, if you opened a sequence that uses an invalid visualization
path, the program would hang.

* In SuperStar, if a visualization had a matrix of CCRs, and some other CCRs as well, then image
actions could be seen on the other CCRs.

* If there was more than one prop with CCRs in it, SuperStar would add them in the order found in
the visualization. They are now sorted and added according to the row they are on.

What's New in Version 3.7.0

e Easier Visibility of Morph Paths

e Max Length of Sequencing Rows

e Wrap Around Mode

e Tree Wizard Improvements

e Performance of Creation of Standalone Sequences Improved

* Bug Fixes

Easier Visibility of Morph Paths

In SuperStar, a line is drawn from 1a-2a and 1b-2b for morph anchor points. This makes it easier to
see the path that the morph is going to take.

Max Length of Sequencing Rows
SuperStar now has a "Max Length" setting to set the length of sequencing rows from 50 to 200.
This allows the sequencing rows to be longer, so all fixtures on a row in a visualization will fit on one

row.

Wrap Around Mode

SuperStar now has a "wrap around mode", designed to be used with 360 degree trees to make it
easier to have an effect start and end in a particular place.

Tree Wizard Improvements

The Tree Wizard in the Visualizer has been streamlined. This includes a new option for a top radius,
and seweral new CCR bundle types.

Performance of Creation of Standalone Sequences Improved

The creation of standalone sequences (for example, in the Hardware Utility for an MP3 Director) has
been made significantly faster. For example, a certain very large sequence that used to take over
twenty minutes to conwert to a standalone sequence on a certain computer now takes approximately
one minute on that same computer.

Bug Fixes

e If SuperStar had never been run on a particular computer before, or its configuration had never
been changed, and you attempted to change the rotation on a new sequence (not on a sequence
loaded from a file), SuperStar would hang in certain cases.

e If SuperStar had never been run on a particular computer before, or its configuration had never
been changed, and you attempted to bring up the Layout dialog box and change to half ribbons,
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the text would be clipped so that only the first ribbons got text on them.

In SuperStar's CCR mode, if you added white text, it would have a red shadow on it.

When a visualization was used in SuperStar, in some situations the file would be renamed to
_\is.sup.

In SuperStar's visualization mode, if the "Star in Use" setting was "Yes", effects would get offset
by four rows.

In SuperStar, if the regular network was not being used, but had unit IDs in the same range as an
Aux network that was being used, channels for those unit IDs would hawe incorrectly used the
regular network instead of the Aux network.

In the Visualizer, after inserting a prop from a file, the prop/fixture buttons and/or the list of props/
fixtures shown on the main editing window could be wrong.

What's New in Version 3.6.0

Vertical Mode in Import Visualization
Bug fixes

Vertical Mode in Import Visualization

SuperStar's Import Visualization dialog now has an optional "vertical mode" sequencing grid
orientation, which can be used to more easily deal with displays that are taller than they are wide
(such as a visualization of an RGB megatree).

Bug Fixes

A bug in SuperStar was fixed related to the drawing of floods and bulbs in a visualization.

Instant Sequence was producing white effects for CCRs, but not for RGB lights. It will now treat
strings of RGB lights the same as CCRs.

SuperStar now supports reversing the order of fixtures in a prop if necessary in order to support a
matrix of RGB lights that are not a Cosmic Color Device.

Having an "&" character in a fixture or prop name in a visualization exported to a sequence by
SuperStar sometimes caused an "unterminated entity" error when the exported sequence file was
opened in the Sequence Editor.

What's New in Version 3.5.0

E1.31 supported

New Network Configuration program

Play efficiency improvements

New "QuickVis" files in SuperStar

Improved handling of half-ribbon matrix arrays in imported visualizations
Maximum Detection Rows setting for imported visualizations
Improved error reporting when importing visualizations

Change to names of channels in exported visualizations

Morphs across entire sequencing grid after importing visualization
Can select individual pixels in CCR visualization in SuperStar

New mouse selection abilities in SuperStar visualizations

Can select start and end points of morphs in SuperStar visualizations
Start and end marks of morphs more easily identifiable

Dimming cunves in exported visualizations

Support for duplicate fixtures in SuperStar visualization mode
Improved Instant Sequence effects
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e Improved balance across comm networks

e Arches with less than four segments

e Default grid color in Visualizer's options dialog

e Cancelling out of Visualizer's wizard to create fixtures

¢ Increase pointer precision in Visualizer by holding Shift

e Move only horizontally or vertically in Visualizer by holding Ctrl
e Suppress "Is this the port for shows" in the Hardware Utility

e "Color by time" in Instant Sequence

e Too-frequent SuperStar warning removed

e SuperStar group delete efficiency improved

* Bug fixes

E1.31 Supported

E1.31 protocol, also known as "streaming DMX over ACN", is now supported for DMX devices. This
allows native DMX devices to be hooked up to LOR ower an ethernet network, rather than over a serial
port. Note that one or more E1.31 gateway devices, which convert E1.31 to standard DMX, would be
required between your computer and your DMX devices.

New Network Configuration Program

A new program, the Light-O-Rama Network Preferences program, has been made. This program can
be used to set up your various network settings, such as for your Light-O-Rama networks, DMX
universes, X10 network, and so on.

This new program replaces the Sequence Editor's Network Preferences dialog. It can be launched
through the Sequence Editor's Preferences menu, the Light-O-Rama Control Panel, or as a
standalone Windows program.

Play Efficiency Improvements
Seweral efficiency improvements were made related to playing sequences, both at the startup of play

and during play itself. These would be most noticeable on very large sequences, or sequences
using many events on DMX channels.

New "Quick Vis" Files in SuperStar

SuperStar now has the ability to create "Quick Vis" files, which are simple visualizations, enabling
you to use SuperStar's Instant Sequence feature without actually having a "real" visualization.

Improved Handling of Half-Ribbon Matrix Arrays in Imported Visualizations

SuperStar's handling of half-ribbon matrix arrays in imported visualizations has been improved.

Maximum Detection Rows Setting for Imported Visualizations

SuperStar's imported visualizations feature now has a new "maximum detection rows" setting, which
enables you to control how many rows the lights from the \isualization will be imported into.

Improved Error Reporting when Importing Visualizations

SuperStar's error reporting has been improved in situations when an error occurs while importing a
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visualization.

Change to Names of Channels in Exported Visualizations

When SuperStar would export a visualization sequence, the names of exported channels used to
just be the names of the visualization's channels. Now they are the visualization channel names
plus the visualization fixture names.

Morphs across Entire Sequencing Grid after Importing Visualization

After importing a visualization into SuperStar, the unused portion of a sequencing row is drawn in dim
green and is selectable. This makes it possible to apply only one morph across the entire
sequencing grid.

Can Select Individual Pixels in CCR Visualization in SuperStar

Individual pixels can now be selected in a CCR visualization in SuperStar.

New Mouse Selection Abilities in SuperStar Visualizations

You can now select in SuperStar visualizations using Ctrl-left click and Ctrl-drag.

Can Select Start and End Points of Morphs in SuperStar Visualizations

You can now specify the start and end points of a morph in a visualization in Superstar.

Start and End Marks of Morphs More Easily Identifiable

The start and end marks of a morph in SuperStar are now cyan and magenta to help identify them.
Formerly, they were both white.

Dimming Curves in Exported Visualizations

When exporting a visualization in SuperStar, an LED dimming curve is used for CCRs and RGB
devices, while an incandescent dimming curve is used for all other lights.

Support for Duplicate Fixtures in SuperStar Visualization Mode

SuperStar's visualization mode now supports duplicate fixtures.

Improved Instant Sequence Effects

The effects generated by SuperStar's Instant Sequence are now limited by the size of each
sequencing row. This improves Instant Sequence effects to make them a bit more in sync and a bit
less choppy.

Improved Balance across Comm Networks

The buffer size for writes to serial port devices has been increased, as has the associated timeout
value. These changes improve balance across communications networks.
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Arches with Less than Four Segments

The Visualizer's Arch Wizard previously wanted four or more segments; otherwise the arch would not
actually look like much of an arch. It now appears more archlike even with less than four segments.

Default Grid Color in Visualizer's Options Dialog

The Visualizer's Options dialog now supports the default grid color option.

Cancelling Out of Visualizer's Wizard to Create Fixtures

The Visualizer's dialog to create fixtures now has a cancel button, giving the user the opportunity to
cancel out of the process.

Increase Pointer Precision in Visualizer by Holding Shift

Holding the Shift key while moving the mouse in the Visualizer now reduces the cursor speed, thus
making more precise cursor movements easier.

Move Only Horizontally or Vertically in Visualizer by Holding Ctrl

Holding the Ctrl key while moving the mouse in the Visualizer will now limit cursor movement to
either horizontal or vertical, depending upon the basic direction the mouse was mowving at the start of
movement.

Suppress "Is this the port for shows?" in the Hardware Utility

When the user selects a different COM port in the "Manual Select” dropdown box of the Hardware
Utility, the system asks if the newly selected port was "the LOR Show Port". If "Yes" was selected,
the Regular network was set to use that port. A "Don't show this again" option has been added to
that dialog, so that the user will not see it over and ower, if desired.

"Color by Time" in Instant Sequence

SuperStar's Instant Sequence feature now supports a "color by time" option, which enables you to
specify an absolute length of time (such as "four seconds") that it will take for effects in a theme to
change color.

Too-Frequent SuperStar Warning Removed

When creating a new Instant Sequence in SuperStar, it would often give a warning about not being
able to undo your action. This warning has been removed.

SuperStar Group Delete Efficiency Improved

SuperStar's group delete function has been optimized to be faster when deleting a large number of
effects.

Bug Fixes

e Lock and Unlock on the Visualizer's right-click context menu were not working correctly.
¢ The Visualizer incorrectly allowed for multiple unselected fixture/prop deletes when using the DEL
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key.

* In SuperStar, shrinking a visualization to fit the screen would not always work correctly.

¢ Various "import visualization" bugs were fixed in SuperStar.

e |f you imported a visualization in SuperStar, the first and last boxes on the first sequencing row
would be set to white, yet if you tried to add a scene, you would get an error saying that no pixels
were selected. This has been fixed so that no sequencing row boxes are selected after the import
of a visualization.

e When the Light-O-Rama Control Panel launched another program (such as the Schedule Editor),
the program would start minimized.

e When checking that the networks used by channels were configured, the Verifier would not check
if the network was a DMX universe.

e The first effect in a SuperStar Instant Sequence would not start out at the right color.

e When doing an Instant Sequence on a visualization using SuperStar's Color Wheel, and a row of
fixtures did not contain a color, there were cases where the row would not receive any visible
effects for long periods of time.

¢ In SuperStar's Import Visualization, there were cases where fixtures were not being recognized.

What's New in Version 3.4.0

e SuperStar supports images and text when in visualization mode
e Timing change in SuperStar's "forward" and "reverse"

e Expanded WAV support in SuperStar

e Visualizer can make itself shown in front of all other windows

e SuperStar's export limit based on number of channels

e Large visualizations shrunk to fit in SuperStar

* Bug fixes

SuperStar Supports Images and Text when in Visualization Mode
Images and text are supported in SuperStar while in Visualization mode. Note that it only makes

sense to use images in text in a visualization if you have a grid of lights. To use text, the grid must
be at least 5x5.

Timing Change in SuperStar's Forward and Reverse

When clicking on the Forward and Reverse buttons on the group of tape recorder buttons on
SuperStar's toolbar, it now scrolls forward or backward one second (it used to scroll two).

Expanded WAV Support in SuperStar

If the header in a WAV file is of an unknown format, SuperStar now uses default values to open the
WAV file. This is an unusual case, but it means that there are some WAV files that will now play
properly whereas they would fail to play previous to this change.

Visualizer Can Make Itself Shown in front of All Other Windows

A new option, "Force Simulation Window to Front", has been added to the Visualizer's Com/Ref
options tab (tab number 6). When this option is enabled, whenever the Visualizer receives data and
is in Simulation mode, the Visualier window will force itself to be shown in front of all other windows.
This option is off by default.

SuperStar's Export Limit Based on Number of Channels
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When in visualization mode, SuperStar now limits export based on the number of channels instead
of on the number of sequencing rows. For example, if you have a 2 CCR license, it will now allow
export of up to 300 channels when in visualization mode.

Large Visualizations Shrunk to Fitin SuperStar

If a visualization imported into SuperStar is too big, it is now shrunk to fit within the screen.
Bug Fixes

e Ifin one of SuperStar's small views, sometimes the sequencing grid was too wide.

¢ If a sequence were opened in one of SuperStar's small views, the numbers at the left of the time
layers wouldn't display properly.

e SuperStar's effect bar representing a scene for the star could have ended up being any color. This
has been fixed so that the bar is always white.

What's New in Version 3.3.0

Setting SuperStar's color control for images
Cosmic Color Bulb Support
Support for flipped Cosmic Color strings in Insert Device

Bug fixes

Setting SuperStar's Color Control for Images

When drawing an image in SuperStar, you can set the color of the color control to the color of an
image pixel by holding the Shift key and left-clicking the pixel with your mouse.

Cosmic Color Bulb Support

Support for Cosmic Color Bulb devices has been added to the Sequence Editor's Insert Device
screen (in the Cosmic Color Device section) and to the Hardware Utility's CCR/CCB Configuration
screen.

Support for Flipped Cosmic Color Strings in Insert Device

Cosmic Color Devices have a hardware setting option where the pixel numbers can be "flipped"” - i.e.
instead of pixel #1 being closest to the device and pixel #50 being furthest from it, pixel #50 is
closest and pixel #1 is farthest. The Sequence Editor's Insert Device screen's Cosmic Color Device
section now has an option to list RGB channels in the device being created from 1 to 50 or from 50
to 1, so as to more easily match up the sequence as shown on the screen with the actual hardware
device.

Bug Fixes

¢ In SuperStar, sometimes the length of an archive file would become five minutes instead of the
length of the original audio file.

¢ In the Visualizer, if the user pressed the Enter key on the Prop Properties screen, the last fixture
selected to be part of the prop may not have been saved correctly.

¢ When using the Visualizer's Prop Properties box, the system could occasionally throw a logged
error. The system correctly recovered, but the error should not have happened in the first place.
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* When using the Visualizer's Channel Wizard on RGB props along with a reference file with RGB
channels, the second and subsequent fixtures assigned to the prop could have incorrect channel
assignments.

* In SuperStar, sometimes if you modified the image an an image action and then played the
sequence, it would hang.

e Some morphs in SuperStar could have had missing pixels.

What's New in Version 3.2.4

e Play startup speed improved in the Sequence Editor
e SuperStar filename changes
e SuperStar exported timing grid changed

* Bug fixes

Play Startup Speed Improved in the Sequence Editor

The amount of time that the Sequence Editor takes to start playing a sequence has been reduced
(this is most noticeable on very large sequences).

SuperStar Filename Changes

The names of various file types that SuperStar creates have been changed: Export files are now

" _sup.Ims" instead of ".sup.Ims"; \is files are "_\vis.Ims" instead of ".vis.Ims"; archive files are
_archive.Ims" instead of ".archive.Ims". Also, exported files are named ".Ims" regardless of whether
they hawve an associated media file, with the expectation that the user will soon add a media file to
them.

SuperStar Exported Timing Grid Changed

The timing grids of sequences exported from SuperStar have been changed from 0.10 seconds to
0.05 seconds.

Bug Fixes

e |f you chose a color such as yellow-white in SuperStar's instant sequencing in CCR mode, you
would only see occasional yellow.

¢ In some cases, when "loop at end" was on and the play range started close to the end of the
sequence, play would not start properly in the Sequence Editor.

e On some Windows 7 computers, every time the Visualizer was started, it would ask the user if
they wanted to associate .LEE files to the program.

What's New in Version 3.2.0

Running sequences displayed in LOR Control Panel
New DMX adapter supported

Simple Show Builder defaults to "All Files"

SuperStar ".vis.sup" files

SuperStar ".archive.sup" files

New option for creating trees in the Visualizer

Effect type options for the tail of a morph in SuperStar
Added group modify for scene effect type in SuperStar
Updating Visualizer channels by name
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SuperStar supports DMX for visualizations

SuperStar supports multiple networks for visualizations

Visualizer from the command line

Visualizer files registered with Windows

Paste Multiple can paste to the end of a group

Sequence Editor remembers the directory of the last sequence opened or saved
Ending drawing via the keyboard

Tooltips for channel group expander buttons

Control Panel remembers whether schedule is enabled or not after shutting down

Bug fixes

Running Sequences Displayed in LOR Control Panel

During a show, the LOR Control Panel's status window now shows information about the various
sequences that are running.

New DMX Adapter Supported

The LOR USB485-ISO is now officially supported for use as a DMX adapter. It should use the "Raw
DMX' protocol.

Simple Show Builder Defaults to "All Files"

When selecting the sequences to use in the Simple Show Builder, the user is given a choice of
which sequences should be displayed so as to be able to choose from: "16 Channels", "32
Channels", and "All Files". The first two are not really based upon the number of channels in the
sequence; rather, they are based on the name of the file (for example, if "16 Channels" is selected,
all files with "16" in their names are displayed).

Previously, the default would be "16 Channels". Since many people make sequences without any
having "16" in their filenames, this would result in a blank list being displayed, often leading to
confusion as to why the Simple Show Builder was not listing the sequences. To prevent this, the
Simple Show Builder now defaults to "All Files" instead of "16 Channels".

SuperStar ".vis.sup" Files
If you load a SuperStar sequence file and then import a visualization, the filename of the SuperStar
sequence file is changed to end with ".vis.sup" instead of ".sup". For example, a SuperStar
sequence named "AwesomeSequence.sup" will be changed to "AwesomeSequence.\vis.sup" upon
importing a visualization.

SuperStar ".archive.sup” Files
If a SuperStar sequence file's name ends with ".archive.sup”, SuperStar will not let you change the
file using "Sawe". Instead, it will prompt you to use "Sawve As". If you then use "Save As", it will
rename the file to not have "archive" in the name. This is to help prevent changing an archive file.

New Option for Creating Trees in the Visualizer

The Visualizer's Tree Wizard can now also create trees that start at the center pole and go to the
base. Previously, it could only create trees where the initial point was on the base.
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Effect Type Options for the Tail of a Morph in SuperStar

When doing a morph in SuperStar, you can now do a shimmer or a twinkle on the tail of the morph.

Added Group Modify for Scene Effect Type in SuperStar

"Modify Effect Type" was added as a check box in SuperStar's Scene Group Modify dialog box.
Previously, you could set the effect type individually, but could not set it to a group.

Updating Visualizer Channels by Name

When using a reference file, the Visualizer now gives you the option to update channels based on
the channel's name or the channel's key. Previously, the only update available was "by key". Now
when updating by name, the Visualizer can update the Device, Network, Unit, Circuit, and Channel
Color to what was loaded in the reference file(s). Updating by name will help those people who
change the physical layout of their channels.

SuperStar Supports DMX for Visualizations

Previously, SuperStar supported only Light-O-Rama controllers for imported visualization files. DMX
is now also supported.

SuperStar Supports Multiple Networks for Visualizations

Previously, SuperStar supported only one network for imported visualization files. It now supports
multiple networks.

Visualizer from the Command Line

The Visualizer can now accept filenames on the command line. If you specify a filename on the
command line, the Visualizer will attempt to load it, skipping the "On Startup...” option. If it is not
successful, the "On Startup..." option will be used.

Visualizer Files Registered with Windows

The Visualizer now registers the ".lee" filename extension with Windows, so if you double click a
.lee file in Windows, the Visualizer will start and load that file automatically.

Paste Multiple Can Paste to the End of a Group

When selecting the number of times to paste \ertically, the Sequence Editor's Paste Multiple dialog
used to give a choice between pasting an explicit number of times (such as 3 or 7) and "Paste all
the way to the end of the sequence”, which would paste vertically as many times as it took to get to
the last channel in the track. It now also gives the option to paste to the end of any channel group or
groups that contain the first channel being pasted to.

Sequence Editor Remembers the Directory of the Last Sequence Opened or
Saved

When a sequence is opened or saved in the Sequence Editor, the Sequence Editor now remembers
the directory of the sequence, so that the next time a new sequence is saved, or the next time the
Existing Sequence tab of the New and Open dialog is used, it will default to that directory.
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Ending Drawing via the Keyboard

Previously, the only way to end a drawing in the Visualizer's editing window was to double click.
You can now also end a drawing by pressing either the End key or the Enter key.

Tooltips for Channel Group Expander Buttons

In the Sequence Editor, if you hover your mouse over the expander button for a channel group (the
small "+" or "-" button to the left of a channel group button), a tooltip will pop up saying the name of
the channel group it is for, and whether left-clicking on the button will cause the group to expand or
collapse.

Control Panel Remembers Whether Schedule Is Enabled or Not After Shutting
Down

The LOR Control Panel has always had the ability to start up automatically upon the computer being
started (and the Windows user logged on), and if the schedule had been enabled when the computer
was shut down, it would automatically enable the schedule upon being started as well. However, if
the Control Panel were unloaded via "Unload Light-O-Rama", it would not automatically enable the
schedule upon being started again. Now, when it is started up, it enables the schedule or not based
on whether or not it was enabled the last time it had been running.

Bug Fixes

* In SuperStar, exported CCR sequences have the RGB values "balanced" so that the colors on the
actual CCRs match the colors on your computer screen (think of this as a color correction made
to the RGB values). This was being done when in CCR mode, but when in visualization mode,
exported CCRs were not having their RGB values balanced.

¢ A SuperStar scene that used the Twinkle effect did not show that effect on the computer screen
(note that the effect did happen on the actual CCRs themselves).

¢ After selecting effects in SuperStar, Ctrl-C would not copy the effects that you had just selected.

e If you created a SuperStar sequence in CCR mode using the star, and then imported a
visualization, the channels for the star did not appear on the sequencing grid, and made it
impossible to change the star channels.

e If two different effects in SuperStar attempt to control a channel at the same time, SuperStar
throws out the shortest command. Howeer, this was not being done for the commands in an
exported sequence. The result was that sequences with overlapping channel commands played
back differently in SuperStar than they did from an exported sequence.

e After using a wizard, the Visualizer would correctly show Prop mode. However, pressing the
"Fixture" button on the main screen sometime did not correctly change into Fixture mode.

¢ Pressing the "Default” button on the Visualizer's Tree Wizard could incorrectly set the number of
pixels per segment, which could then cause an error.

¢ If you make a selection in SuperStar's star channel grid, selections in the CCR channel grid will be
cleared, and vice-versa. Previously, the existing selection would not be cleared, which could lead
to confusing effects.

¢ In SuperStar, if you loaded a sequence with timings, and then loaded one without timings, the
timing map would get stuck in Imported Timings mode, and attempting to set the frequency
spectrum would not work.

¢ If you loaded a channel configuration file as a reference in the Visualizer, and then chose to update
existing channels, the channel colors for matching virtual channels could be set incorrectly.

¢ When "Disable Shows Immediately” was done in the LOR Control Panel, the lights on native DMX
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universe devices would not be turned off.

If the Sequence Editor's "Channel Button Colors" setting were set to anything besides "None", the
color of the channel buttons' fonts would vary during play even if "Vary Color of Channel Button
Fonts" were turned off in the Play Preferences dialog.

The Sequence Editor's Edit menu's keyboard shortcut for Set Paste Mode was changed from M to
O, because M was already in use for Paste Multiple, which led to it being impossible to open the
Set Paste Mode menu via the keyboard.

After a "Disable Shows Immediately” was done in the LOR Control Panel, in some cases a
message would appear in the status log saying "tmNextAction_Timer Error: Object variable or
With block variable not set".

When selecting a show file to schedule in the Schedule Editor, the "file type" dropdown box of the
file browsing dialog would allow either "Show Files" (which was the default) or "All Files".
Selecting "All Files" would allow you to schedule some sort of file other than a show file, which
would not accomplish what you were hoping (since the Show Player only supports scheduled
shows, not any other sort of scheduled thing). The Schedule Editor now only allows you to
schedule shows.

If a track were hidden, and that track were selected from the Sequence Editor's track dropdown list
(in the Tracks and Timings toolbar), the track would become the active track (as it should), but it
would remain hidden and the display would not move to show it.

In SuperStar, if you imported a visualization file and picked a recent file to open such as
"Untitled.sup”, the program would advise that it changed the name to "Untitled.vis.sup". However,
if you do a Save As, the name would default to "Untitled.sup" instead of "Untitled.\is.sup".

When exporting a file in SuperStar, if you typed in a name such as "MySequence", it would give
an error saying that the file name has to end in ".Ims" or ".las". This has been fixed so that the
appropriate file extension automatically gets appended to such a file name.

In SuperStar, an image that was moved a short distance would stay on the screen too long.

In SuperStar, if you added some macros, selected those macros, deleted them, and then tried to
undo the group delete, they would not get restored. Also, if you selected a group of effects that
include some macros and did a group delete, it would not always undo properly, and in some
cases would cause SuperStar to crash.

Sometimes when importing a visualization file that contained RGB fixtures into SuperStar, the
channels for that fixture were not red, green, and blue.

The controller for the star in SuperStar was always being placed in the Regular network; it can now
be placed in any network.

If the Visualizer attempted to load a file that previously existed but was now missing, the error
message presented was not clear. The error message now explicitly says that the file is missing,
rather than the generic "XML error".

If you deleted the currently displayed timing grid in the Sequence Editor, it would continue to be
displayed until you manually displayed another.

When exporting a SuperStar sequence, if the name of the media file contained the "&" character,
an error would occur when trying to load the exported sequence in the Sequence Editor.

When saving a morph in SuperStar, the end intensity lewvel for white was always the same as the
start intensity level for white.

In some situations, as the Show Player was starting (after having enabled shows), the LOR Comm
Listener would shut down. This would happen when the Show Player took longer than the Comm
Listener would expect to start up, which might happen, for example, if the computer had the third-
party Universal Library and InstaCal installed for controlling digital 10 cards. The Comm Listener
now gives the Show Player a longer amount of time to start up before deciding to shut itself down.
On some computers, the LOR Comm Listener would occasionally get in a state where it would
shut down and then restart over and over, fairly rapidly. A change was made to fix this in at least
some situations.

In SuperStar's Timing Map dialog box, if you deselected "Also Set TCM" and changed the TCM
settings, it would set the TCM settings back to what they were before you changed them.
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e Ball Tree (RGB light strings where the color of the whole string of lights changes together) was not
playing back properly in SuperStar.

* In the Sequence Editor, if "Loop at End" is turned on, and the play range includes the end of the
sequence, and the sequence is a musical sequence, the loop would be done back to the
beginning of the sequence rather than to the beginning of the play range.

* If a sequence contained more than one channel, then on the Channel Configuration screen, the tab
key would mowve the focus from control to control in a strange order.

e When you zoomed channels in or out in the Sequence Editor, any channel group expander
buttons on the screen would not be redrawn into their proper new positions until you did something
like hover over them.

* In some situations, a clipboard removed from the Sequence Editor would still be partially visible in
the list of clipboards, leading to errors if it were selected.

What's New in Version 3.1.4
¢ Bug Fix
Bug Fix

¢ In most cases, the LOR Control Panel would slowly leak memory resources, eventually leading to
strange behavior such as shows stopping or crashing.

What's New in Version 3.1.2
¢ Bug Fix
Bug Fix

* SuperStar could crash at startup time. This has been fixed.

What's New in Version 3.1.0

Expand All and Collapse All for channel groups

New DMX adapters supported

Performance of ENTTEC DMX USB Pro adapters improved
Scrunching the SuperStar sequence grid for imported visualizations
Instant Sequencing with imported timings

Increased limit on SuperStar's number of fixtures per prop
SuperStar exports grouped CCR devices

Sample SuperStar clipboard files added

Bug fixes

Expand All and Collapse All for Channel Groups

In the Sequence Editor, clicking on a channel group's expander button expands or collapses the
channel group - that is, it makes the channel group's children visible, or hides them. In addition to
this, now you can expand or collapse the channel group and all of its descendents:

Holding the Shift key while clicking on a collapsed group will expand it and all of its descendants
except for RGB channel descendants; holding both Ctrl and Shift while clicking on a collapsed group
will expand it and all of its descendants including RGB channel descendants.
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If the group is expanded, holding Shift (or both Ctrl and Shift) while clicking will collapse it and all of
its descendants.

New DMX Adapters Supported

The LOR USB485B and the Lynx adapters are now officially supported for use as DMX adapters.
The LOR USB485B should use the "Raw DMX' protocol, and the Lynx should use the new "Lynx"
protocol.

Performance of ENTTEC DMX USB Pro Adapters Improved

One of the supported adapters for native DMX devices, the ENTTEC DMX USB Pro, is capable of
offloading some CPU utilization from the computer driving the DMX devices through it. Previous
versions of Light-O-Rama did not take advantage of this capability, but it does as of this version.

Scrunching the SuperStar Sequence Grid for Imported Visualizations

A new option has been added to SuperStar's Import Visualization dialog, allowing you to "scrunch"
the sequencing grid for your visualization. This allows you to pack the most light fixtures possible
into each sequencing row. For example, if you have the 2 CCR license lewel, and you are getting an
error message saying that your visualization can only have 2 green sequencing grid rows or less
during export, then you can try importing your visualization again and selecting the "Scrunch the
Sequence Grid" option, then try exporting again.

Instant Sequencing with Imported Timings

Previous to this release, in SuperStar, you could import timings, but could only use them for visual
reference. They can now be used to create an instant sequence. You can import up to three timing
channels, which will become the top three timings. After importing timings, if you open the Timing
Map dialog box, you will see that the "All Fregs" row of timings has been renamed to "Imported"”.

Increased Limit on SuperStar's Number of Fixtures per Prop

SuperStar's limit on the number of fixtures allowed in a prop has been increased from 32 to 64. This
brings the limit up to the same limit as in the Visualizer.

SuperStar Exports Grouped CCR Devices

SuperStar now exports CCRs as grouped CCR devices. This makes it much easier to see the entire
sequence in the Sequence Editor.

Sample SuperStar Clipboard Files Added

Twenty new sample system clipboard files have been added to SuperStar. Click on the Edit menu
and select "Load/Sawe Clipboard”, and you will see the new files, such as "Sys -
BubblesRiseAndPop.sch", "DiamondExpanding.scb”, and "Sys -
SharkFinForHorizontalRibbons.scb". To use one, select it from the list, click on "Load Clipboard
from File", and then click on "Paste". The effects will be pasted into your sequence starting at the
time you have selected.

Bug Fixes
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e When using the Visualizer's "Insert Fixture from Symbol" command, the symbol inserted may
have been missing a segment from the last point defined back to the first.

e When starting a simulation in the Visualizer with more than 255 virtual channels, a warning is now
shown that only the first 255 will be used.

* The Visualizer now prevents errors when loading images that are too large, or starting a new
simulation with a blank background that is too large. The absolute maximum size is now
2500x2500.

e [f you cancelled the creation of a new visualization in the Visualizer, you would incorrectly be
prompted for a save filename. Since no visualization was created, there was nothing to save.

e If you loaded a file with a bad signature into the Visualizer, any new file created in that session
could also be marked as bad.

e Depending on the size of fonts in Windows, text in the Visualizer's Options dialog may have been
cut off.

* In some situations, using certain keyboard functions (such as Ctrl-Z to undo) in the Sequence
Editor would cause the display to jump to another location (such as to the bottom of the channel
list).

e The Visualizer's Channel Wizard did not correctly assign channels when using the DMX device
type.

* In some cases, if an error occurred while the Visualizer was loading a prop file, existing prop and
fixture data could be corrupted.

¢ Importing a channel configuration file would fail if one of the channels in the channel config file was
a subsequence and that subsequence’s sequence file was missing or otherwise unloadable.

¢ In the Tapper Wizard, if "Insert a timing into the timing grid for each tap" were checked, and "Insert
effects into a channel" were unchecked, and taps were collected and then applied to the
sequence, starting over with new taps would not be able to collect more taps than the originally
collected number unless the Tapper Wizard were exited and reopened first.

e The Sequence Editor would crash if a port number greater than 32767 were entered into the
Visualizer Preferences dialog.

* For large audio files (for example, an audio file that is half an hour long), the Beat Wizard, VU
Wizard, and Waveform Display would sometimes fail with an error saying that memory could not
be allocated.

* In the Sequence Editor, when pasting from a saved clipboard which happens to be locked, the
clipboard would automatically unlock.

e When exporting a file in SuperStar, if the audio file was an MP3 file, the filename would get
exported as SSEditAudioFile.wav. This has been fixed to use the MP3 audio file name.

e SuperStar's effect bars in the time layer were sometimes white when they were supposed to be
colored.

¢ In SuperStar, Light-O-Rama controllers were assumed to never have more than 16 channels. They
can now have up to 512.

e Orange, yellow, and purple lights were not being sequenced by SuperStar's Instant Sequence
feature.

¢ SuperStar was not handling duplicate channels in a visualization (i.e. channels that are assigned
to more than one light fixture). Now, they are displayed in dark gray, and cannot be selected or
sequenced.

e SuperStar was not properly detecting rows in visualizations with props that do not contain any
lights.

* Sometimes, not all channels in a visualization were being read properly by SuperStar.

* SuperStar was not exporting macro commands when in visualization mode.

* Ifyou load and play an audio file in SuperStar, then open and play a sequence using the same
audio file in the Sequence Editor, you could get an error in SuperStar saying to shut down the
other program. If you then shut down the Sequence Editor, and try to play the audio file again, it
would not play (even if you tried to load the audio file again).

e SuperStar's Configuration Dialog box previously listed "Unit Nbr" and "Unit ID". A controller's "Unit
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Nbr" was the decimal number that equated to the controller's unit ID (which is a hexidecimal
number). This ended up being confusing, and so now only the unit ID is listed. This is now
consistent with the rest of the Light-O-Rama software suite.

What's New in Version 3.0.2

Bug fix

Bug Fix

When the Hardware Utility scans for connected controllers, it could confuse CTB16PC, CCF, and
CCB100 controllers with each other.

What's New in Version 3.0.0

The Light-O-Rama Visualizer
The Light-O-Rama SuperStar Sequencer

Channel Groups
Native DMX Devices

Paint Sequence

Compressed Seguences

Variables in Windows shell commands

New paste modes

Dimming cunes

Hide or unhide a track by left-clicking its track bar
Select columns or rows via the right-click context menu
Protected sequences

Custom keyboard maps

Rewversing pixel order in CCRs/CCBs

Effect tools' keyboard shortcuts shown in toolbar tooltips
Control over channel button colors while not playing
Seweral view settings for sequences are now persistent
Tools Panel can be completely hidden

Control over channel names in "Insert Device"

Channel names in "Insert Device" indicate network for auxiliary networks
Subseguences changed on disk automatically reloaded
Additional clipboard management capability

Locking channels in tracks

Additional info in channel button tooltips

Sequence grid tooltips show channel color

Time ranges in Beat Wizard and VU Wizard automatically set to play range
VU Wizard shows percent of time abowve threshold

New "Change Controller" dialog

Add Controller dialog allows selection of network
Additional Mouse Scroll Wheel Support

Sequence and track names are printed

Control Panel's menu reorganized

Performance of "Repeat" improved

Memory usage of undo recording improved

Verifier speed improved for channel conflict check
"Channel Property Grid" renamed to "Channel Configuration"

Bug Fixes
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The Light-O-Rama Visualizer

The Light-O-Rama Visualizer is a new program in the Light-O-Rama software package. It is intended
to give a visual representation on your computer screen of how your lights will look during a
sequence or during your show.

Please note that the Animator, which has a similar purpose, is still supported, so that existing
sequences continue to work with it. Howewer, the Visualizer is more fully featured than the
Animator, so consider using the Visualizer instead of the Animator, especially for new sequences.

The Light-O-Rama SuperStar Sequencer
The Light-O-Rama SuperStar Sequencer is a new program in the Light-O-Rama software package. It

can be used as a sort of front end for the Light-O-Rama Sequence Editor, creating sequences
visually rather than via a channels-versus-time grid.

Note that existing Light-O-Rama licenses do not cover SuperStar (except in demo mode). In order to
fully use SuperStar, your license will have to be upgraded to have SuperStar support.

Channel Groups

The Insert Device dialog can now optionally create devices as channel groups, instead of as raw
channels and/or RGB channels. A channel group is a set of channels and/or RGB channels that
can be collapsed down to a single row in the display, or expanded to show rows for all (or some) of
its members.

Native DMX Devices

Light-O-Rama now supports control of native DMX devices.

Note that only the Advanced license lewvel supports this.
Paint Sequence

The new Paint Sequence tool can be used to paint effects from another sequence into the current
sequence. This can be used to accomplish things similar to what can be accomplished with
subsequences, in a potentially clearer and easier way, without the extra complication of
subsequences.

Compressed Sequences

It may take a significant amount of time to load a large Light-O-Rama sequence. When loading one
in the Sequence Editor, in order to view or modify it, this may be an inconvenience, but the real issue
is loading one in the Show Player: When the Show Player has to load a large sequence, it may
cause a noticeable pause in your show as the sequence loads.

To resolve this issue, this release of Light-O-Rama introduces the concept of compressed
sequences. A compressed sequence is a separate save file, associated with a a sequence but
containing only enough information to play the sequence in the Show Player, and optimized for
loading speed. This can speed up loading times dramatically - for example, for a certain large
sequence that takes eight seconds to load on a certain computer, the associated compressed
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sequence only takes a small fraction of a second to load on that same computer.

Variables in Windows Shell Commands

In previous versions of Light-O-Rama, the Windows shell command associated with a sequence was
a static thing - it would be executed exactly as you had typed it. Now, they are instead templates;
you can type in pieces that will be executed exactly as you typed them, just as before, but you can
also type in variables, which will be replaced with run-time information, such as the name of the song
that is being played.

New Paste Modes

The Sequence Editor previously offered two different modes for pasting: paste by cell and paste by
time. There are now two additional new modes: stretch to fit and repeat to fit. Stretch to fit
stretches (or compresses) the copied effects so that they fit into the area that you select, while
repeat to fit repeats (or cuts off) the copied effects so that they fit into the area that you select.

Dimming Curves

Geng3 Light-O-Rama Controllers, and pre-Gen3 LOR controllers with Gen3 firmware installed, support
customizable dimming curves. A dimming curve determines the output of a circuit from the intensity
setting sent to that circuit; for example, some pieces of hardware (such as strobe lights) should
never be dimmed, and so a dimming curve can be set for such a device that sets the output at 100%
for any intensity of 50% or above, and at 0% for any intensity lower than 50%. Another example is
that different types of bulbs (such as incandescents versus LEDs) may naturally get brighter or
dimmer at different rates when going from one intensity to another, and so different dimming curves
can be used to even them out, making fades on them appear more similar to each other.

You can control what dimming cunve is used for what circuit via the Hardware Utility's new Advanced
Configuration screen.

Hide or Unhide a Track by Left-Clicking Its Track Bar

In previous ersions of the Sequence Editor, both left-clicking and right-clicking on a track's track bar
would cause that track bar's popup menu to open. Right-clicking still does, but left-clicking now
instead hides or unhides the track.

Select Columns or Rows via the Right-Click Context Menu

In previous versions of the Sequence Editor, you could select an entire row or rows, or an entire
column or columns, via the Edit menu's Select Rows and Select Columns menu items. Now, you
can also do this via the right-click context menu.

Protected Sequences

The Sequence Editor can now be used to create protected sequences, which are sequences whose
sequence grids cannot be viewed or (generally speaking) modified, but which can still be played,
control lights, be scheduled in shows, and so forth.

Control Over Channel Button Colors While Not Playing

In previous versions of the Sequence Editor, while a sequence was not playing, channel buttons
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would be displayed as grey (or black for RGB channels). Now, it still operates that way by default,
but the Channel Button Colors submenu on the View menu gives you two other options: to be
displayed using the channel's full color, or to be displayed using the channel's color at the time of
the start of the current selection.

Reversing Pixel Order in CCRs/CCBs

The Hardware Utility's CCR/CCB Configuration screen now supports reversing the pixel order of a
Cosmic Color Device (so that pixel 50 is closest to the controller, rather than pixel 1).

Custom Keyboard Maps

The behavior of keyboard keys in the Sequence Editor can now be configured, via the new Keyboard
Preferences dialog.

Effect Tools' Keyboard Shortcuts Shown in Toolbar Tooltips

If one of the effect tools on the Tools toolbar has a keyboard shortcut that applies that tool, and only
applies that tool, it is displayed in the tooltip for that effect tool's button on the toolbar.

Several View Settings for Sequences Are Now Persistent

In the Sequence Editor, several view settings for sequences are now persistent. That is, for
example, if you change the width of the channel buttons for a sequence, they will automatically be
that size whenever you open that sequence in the future (unless you explicitly change their size
again).

This information is automatically remembered outside of the sequence file itself (but associated with
it), so you do not have to save the sequence file when you make a cange to such a setting. Also,
there had been some such settings which already were persistent, but used the sequence file, so
that you would have to save the sequence whenewer you altered them; these now are instead
automatically persisted outside of the sequence file.

The following view settings are now persisted in this manner:

The width of the channel buttons

Whether the channel buttons are displayed or not

The height of a row of the grid (and of the channel buttons)
The width of the grid per unit of time

The zoom setting of the Animator

Whether the Animator's controls are shown or hidden

The zoom lewel of the waveform display

Tools Panel Can Be Completely Hidden

The Sequence Editor's Tools Panel can now be completely hidden, so that not even the narrow bar
with its wrench icon is displayed, via "Tools Panel" on the View menu.

Control Over Channel Names in "Insert Device"

The Sequence Editor's Insert Device dialog used to give no control over the names of the channels
that it would create. You can now specify the base name (such as changing the default "SD" for a
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Servo Dog device to "Animatronic Rudolph”, resulting in channel names like "Animatronic Rudolph
03.7" for unit 03 circuit 7 instead of "SD 03.7"). You can also specify that the unit ID should not be
included at all (resulting, for example, in "Animatronic Rudolph 7" for circuit 7).

Channel Names in "Insert Device" Indicate Network for Auxiliary Networks

When creating channels, the Sequence Editor's Insert Device dialog would not include any indication
of the channel's network in the channel's name. For example, a channel for unit 03 circuit 7 of a
Seno Dog device would be called "SD 03.7" no matter what network it was on. Now, if the channel
is on an auxiliary network, it will additionally include that network's identifier. For example, "SD
C03.7" would indicate that the channel is on the Aux C network, while a plain "SD 03.7" would
indicate that the channel is on the regular network.

Subsequences Changed on Disk Automatically Reloaded

If a sequence containing a subsequence was loaded, and then the subsequence was changed and
saved, and the parent sequence then played, it would play as if the subsequence had not been
changed. It will now instead play using the newly saved contents of the subsequence.

Additional Clipboard Management Capability

In previous versions of the Sequence Editor, if a saved clipboard were changed, the changes would
automatically be resaved when the Sequence Editor was closed. This is still done, but there is now
a new menu item on a clipboard's popup menu to manually resawe it, and an option on the Clipboard
Preferences menu to automatically resave. Similarly, there is now a new menu item to reload a
saved sequence (in case the contents of its sawe file were changed outside of the Sequence Editor),
and an option on the Clipboard Preferences menu to do so automatically. These changes are
intended to ease the use of clipboards by third party tools.

Additionally, a new menu item to remowe a clipboard from the list of clipboards has been added.

Locking Channels in Tracks

The channels of a track can now be locked, meaning that you will be unable to add channels to the
track, remove channels from it, move channels within it, or modify settings (such as device type and
unit) within it, unless you unlock the track first. To lock or unlock a track, use "Lock Track" (or
"Unlock Track") from the track bar's popup menu.

Additional Info in Channel Button Tooltips

In previous versions of the Sequence Editor, the tooltip that would open when the mouse hovered
over a channel button would show the name of the channel. It now shows additional information,
such as the unit and circuit.

Sequence Grid Tooltips Show Channel Button Color

In the Sequence Editor, the tooltip that opens when the mouse is hovered over the sequence grid
now displays the color of the channel of the row that the mouse is hovering over.

This new behavior can be turned off via "Use Channel Colors" in the Display Preferences dialog.

Time Ranges in Beat Wizard and VU Wizard Automatically Set to Play Range
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In previous ersions of the Sequence Editor, when the Beat Wizard or VU Wizard was opened, it
would automatically be set to operate on "the entire song". It will now instead be automatically set
to operate on the play range (the freeform play range if one exists, or the play range as set on the

Play menu if not).

Note: This behavior can be overridden, for these wizards and also the Tapper Wizard, via the "Use
Play Range for Wizards" option on the Play Preferences dialog. If this option is not enabled, then
the wizards will default to using the time range of the entire song.

VU Wizard Shows Percent of Time above Threshold

The VU Wizard now displays the percent of time that is above the specified threshold, with the
specified settings.

New "Change Controller" dialog

The new Change Controller dialog (which can be accessed from the Channel Configuration screen)
presents a list of the controllers in a track, and allows you to select one and change its physical
settings. For example, you could use this dialog to quickly change all channels for the Light-O-
Rama controller 03 on the Regular network to instead be controller 07 on the Aux C network. Note:
The "Channel Configuration" screen used to be known as the Channel Property Grid.

Add Controller Dialog Allows Selection of Network

The Channel Configuration screen's Add Controller dialog now allows the network of the controller to
be selected (for those device types that have networks). Note: The "Channel Configuration" screen
used to be known as the Channel Property Grid.

Additional Mouse Scroll Wheel Support

The mouse scroll wheel is now supported in the Schedule Editor and in the Sequence Editor's
Channel Configuration screen. Note: The "Channel Configuration” screen used to be known as the
Channel Property Grid.

Sequence and Track Names are Printed

When the "Print" function is used in the Sequence Editor's Channel Configuration screen, the
printout now includes the name of the sequence and of the track. Note: The "Channel Configuration
screen used to be known as the Channel Property Grid.

Control Panel's Menu Reorganized

In previous versions of the Light-O-Rama Control Panel, some of the menu items on its popup menu
were paired with each other. For example, to control whether or not the Control Panel should be
automatically launched whenever the computer starts up, there was a "Launch at startup" menu item
and also a "Do not launch at startup” menu item. This could be a bit confusing, as the way that you
could tell (for example) that the Control Panel would be launched at startup was that the "Launch at
startup” menu item was greyed out, so that you couldn't select it.

Now, instead, such pairs have been replaced by single menu items, which can be checked or
unchecked. For example, if "Launch at startup" is checked, the Control Panel will launch at startup,
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and if it is not, it will not; there is no longer any "Do not launch at startup” menu item.
Performance of "Repeat" Improved

The Sequence Editor's "Repeat” function is now quicker than it used to be, and also uses less
memory than it did.

Memory Usage of Undo Recording Improved

The Sequence Editor now uses significantly less memory than it used to in order to record events for
later undoing/redoing.

Verifier Speed Improved for Channel Conflict Check

One of the possible issues that the Light-O-Rama Verifier can check for is whether a sequence has
two different channels with the same physical settings (such as unit and circuit). In the past, this
check could take quite a while to perform on large sequences; it has now been speeded up
considerably. For example, for a certain sequence, the Verifier running on a certain computer would
need ten minutes to perform this check. It now needs only about a second, for the same sequence
on the same computer.

"Channel Property Grid" Renamed to "Channel Configuration”

The Channel Property Grid has been renamed to "Channel Configuration".

Bug Fixes

¢ The tooltip for the Sequence Editor's "Custom Shimmer" button was inappropriately labeled.

e If multiple sequences were open in the Sequence Editor, and they were not maximized, switching
from one sequence to another by directly clicking on a sequence would correctly activate that
sequence, but would not update the row of sequence tabs to show that that sequence is now
active.

¢ A bug in an earlier Beta release of the software, which was not released to the general public,
would sometimes cause a sequence to accumulate "extra" RGB channels, which were not
present in any of the sequence's tracks. These RGB channels weren't noticeable to a user, and
they would not affect the behavior of the lights, but their presence in a sequence could cause
certain operations, such as deleting channels, to be much slower than normal, for that particular
sequence. Such operations have now been sped up.

¢ Clipboards that were loaded from saved clipboard files would always paste as if "Paste from
foreground” was enabled.

¢ If both the Sequence Editor and the active sequence were maximized, and neither vertical scroll
bar (the one to scroll between tracks and the one to scroll within a track) were present, and the
program was running on the rightmost monitor, then when selecting an area by clicking and
dragging, you would be unable to scroll to the right while selecting.

¢ When loading a clipboard, if you selected the clipboard file's name by double clicking it in the file
browsing dialog, and the mouse happened to be over a sequence, then after the clipboard loaded,
a phantom mouse click would be applied to the sequence. So, for example, if the Fade Up tool
was selected, a fade up would be applied to the spot on the sequence where your mouse
happened to be.

¢ The Delete Controller dialog used to be unable to distinguish between different LOR controllers that
happen to have the same unit ID on different networks.

e If a show has a jukebox interactive group, and the trigger associated with that group is pushed
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while a sequence from that group is playing, the trigger should not cause the sequence to be
interrupted and the next sequence in the group to be played. This worked fine. Howeer, it would
cause the sequence that is considered to be "next" to be changed. For example, if the group
contains three sequences, A, B, and C, and A is playing when the trigger is pushed, A would
continue playing (as it should), but after A ended, if the trigger were pushed again, C, not B, would
play.

* When creating a new musical sequence, if you set the number of channels to zero, and then
specify that the channels should be created via a channel configuration file instead of via the
specified number of channels, the Sequence Editor would tell you that you need to specify more
than zero channels, and then crash.

¢ In the Sequence Editor, when the time range of a track is scrolled, the time ranges of any other
tracks in the sequence should scroll with it. However, this did not occur unless those other tracks
had already been displayed at least once since the sequence was loaded or created. It also
would not occur during play except when those other tracks were displayed.

¢ On the Hardware Utility's LOR MP3 tab, if no MP3 controller were connected, the "Set" button (to
set the unit's time) should be greyed out. In most cases, it was, but if no comm port existed (as
opposed to merely no comm port being selected) it was not greyed out, and so could be pushed.
Pushing it in such a situation would result in a crash of the Hardware Utility.

* When the track list of a sequence is changed in the Sequence Editor - for example, if a track is
mowved to another position - any tracks that had been hidden would automatically unhide.

¢ In the Sequence Editor, when a file was chosen from a file browsing dialog by double clicking on
the file, sometimes the sequence grid that was "beneath" the dialog would act as if it had been
clicked. For example, an effect tool might be applied to the grid, or a Channel Settings dialog
would open.

e [fatrack was hidden, moving it up in the list of tracks would cause it to become the first displayed
track.

* If a clipboard was saved in the Sequence Editor, and the clipboard's name was invalid in certain
ways, the Sequence Editor would crash.

e [f an iDMX1000 controller was selected in the Hardware Utility's Test Console, the "Current
Channel Range" display would be incorrect.

e The "Mowe to Track Number..." menu item on a channel button's popup menu was enabled even if
there was only one track.

What's New in Version 2.9.4

Up to sixteen Light-O-Rama networks supported

Old MC-P only affects the Regular Light-O-Rama network

Feedback for attempting to copy or cut to a locked clipboard

Vary color of channel button fonts

Unqualified file name used on Sequence Editor tabs

Standalone sequences no longer download commands for auxiliary networks

Bug Fixes

Up to Sixteen Light-O-Rama Networks Supported

Previous versions of Light-O-Rama could support Light-O-Rama controllers on up to four different
networks ("Regular”, "Aux A", "Aux B", and "Aux C"). This has been increased to sixteen (in
addition to the original four, "Aux D" through "Aux O").

Old MC-P Only Affects the Regular Light-O-Rama Network

Old MC-P compatibility mode is required if you have certain old Light-O-Rama controllers (MC-P
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controllers purchased prior to November 15, 2003). This compatibility mode causes significant
overhead on the communications protocol. In previous versions of Light-O-Rama, if you turned on
Old MC-P compatibility mode, it would affect all of your Light-O-Rama networks. Now, instead, it
only affects the Regular Light-O-Rama network; it does not affect any auxiliary Light-O-Rama
networks. So, you can now put all of your old MC-P controllers on the Regular network, and your
other controllers on other networks, so that they are not affected by the communications protocol
owverhead.

Feedback for Attempting to Copy or Cut to a Locked Clipboard

In the Sequence Editor, if the currently selected clipboard is locked, copying or cutting does nothing.
This is so as to awid accidentally overwriting the data on a clipboard that you want to keep.
Howewer, there is nothing stopping you from hitting "Ctrl-C" or "Ctrl-X', attempting to copy or cut, and
in previous versions of Light-O-Rama, doing so would give you no indication that something was
amiss until you later attempted to paste, and wound up pasting whatever had previously been on the
clipboard, instead of what you thought you had just copied or cut. Now, the Sequence Editor will
beep, to indicate that the attempted copy or cut did not take effect.

Vary Color of Channel Button Fonts

In the Sequence Editor, you can control whether or not the color of channel buttons changes during
play (based upon the lighting effects happening on those channels). In early versions of Light-O-
Rama, the text on the buttons was always black, and stayed black no matter what, which meant
that sometimes the text was not readable.

In a relatively recent release, this was changed so that the color could be either black or white,
depending upon which gives a more readable contrast with the background color of the button itself.
Howewer, some users found it to be distracting when a channel button's font would switch between
black and white during play, and so you can now control whether or not this happens.

You can control it temporarily (until the next time the Sequence Editor is started) via the Vary Color
of Channel Button Fonts item on the Play menu, or set your default preference (which will take effect
every time the Sequence Editor is started) via Also vary their font colors on the Play Preferences

dialog.

Unqualified File Name Used on Sequence Editor Tabs

When the Sequence Editor has multiple sequences open, it displays a tab strip across the top, with
one tab per sequence. Each tab has the name of an open sequence; clicking on a tab causes that
sequence to be displayed. In previous versions, the name of the sequence would include its
directory name, if the sequence was not stored in the default directory for sequences. This could
lead to some very wide tabs. Now, only the unqualified filename, without any directory information,
is displayed.

The fully qualified filename can still be found via "Sequence Info", on the View menu.

Standalone Sequences No Longer Download Commands for Auxiliary Networks

If a sequence that used multiple Light-O-Rama networks was downloaded to a standalone controller
(via the Hardware Utility's MP3 tab or via the Simple Show Builder), previous versions of Light-O-
Rama would warn you of that fact, because standalone controllers only send commands out owver a
single comm line, and therefore the multiple networks would all get amalgamated into a single one
when downloaded. Now, instead, only commands for controllers on the Regular Light-O-Rama
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network are downloaded.

Bug Fixes

The Hardware Utility previously used Old MC-P_compatibility mode when it should have not done
so, and did not use it when it should have.

On some computers, the Clipboards panel would not show its full height, leading to most of its
functionality being unavailable due to being offscreen.

Downloading large sequences for standalone controllers, such as via the Hardware Utility's MP3
tab, was much slower than it had been; its speed has now been increased.

Depending upon how Windows is set up, the LOR Control Panel would sometimes be unable to
launch the various other LOR applications (such as the Show Player).

The Hardware Utility and Simple Show Builder would previously allow you to download any type of
media file for a standalone sequence, such as WAV files or WMA files, despite the fact that only
MP3 files are supported by the controllers. They will now give an error message if you attempt to
download a media file other than an MP3 file.

What's New in Version 2.8.12

Sequence Editor Can Keep Lights On at End of Play, and Turn Them Off Manually
Bug Fixes

Sequence Editor Can Keep Lights On at End Of Play, and Turn Them Off
Manually

In previous versions of Light-O-Rama, the Sequence Editor would automatically turn off all lights in a
sequence when that sequence finished playing. It can now optionally keep them turned on, via the
new "Lights Off at End" menu item in the Play menu. The lights can subsequently be turned off

manually via "Lights Off Now".

Bug Fixes

If, while importing a channel configuration file, you double-clicked the channel configuration's
filename in the file browsing dialog, and if your mouse was over a sequence grid at the time, then
after the file was imported, depending upon where your mouse was, this could have caused the
grid to behawe as if you clicked your mouse on it. For example, if you were over a channel button,
the Channel Settings dialog for that channel could have opened.

If DMX effects were used in a sequence, and the Sequence Editor's Vary Color of Channel Buttons
setting was turned on, then during play, for certain DMX effects, the sequence grid could
temporarily go blank as displayed in the Sequence Editor (though the behaviour of your actual
lights would not be adwersely affected).

In certain situations, such as after an undo, the selected channel from the channel dropdown list in
the Animator would spontaneously change to being the first channel in the list.

If you manually edited certain registry settings related to disk file paths (note: doing this is not
recommended) which Light-O-Rama normally sets itself, leaving off a backslash at their ends
would lead to unexpected results.

If an RGB channel (as opposed to one of its constituent channels) was used to draw in the
Animator, and that RGB channel was deleted from the sequence, the cells of the Animator using
that RGB channel would not be blanked out.

If a constituent channel of an RGB channel (as opposed to the RGB channel itself) was used to
draw in the Animator, then in certain situations, the cells of the Animator using that constituent
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channel could have been blanked out inadvertently.

* In certain situations, very small fades (for example 0% to 1%) over relatively long spans of time
would cause other effects to spontaneously appear on the channel.

e The Color Fade tool would give an option to insert DMX effects even if DMX editing was disabled.

e |f the Color Fade tool was used to make DMX effects, and those DMX effects were themselves
fades, they would not be sent to the controllers. They now are sent, but (as of the time of this
writing) LOR hardware does not support fading DMX effects, and so they are converted to regular
fades.

What's New in Version 2.8.10

e The Advanced OpenGL Settings Dialog
* Bug Fixes

The Advanced OpenGL Settings Dialog

The new Advanced OpenGL Settings dialog can be used, experimentally, to try to investigate or work
around strange graphics issues. Howeer, this is not recommended; such problems can typically be
better resolved in other ways, such as updating your computer's graphics card's drivers.

Bug Fixes

¢ The Set Paste Mode submenu in the Sequence Editor's Edit menu did not have a shortcut key
associated with its Paste from Foreground option.

¢ On some computers, selecting a sequence from the Sequence Editor's Windows menu would
cause a portion of the display to remain showing the previous sequence, until something like a
refresh was done.

¢ When the Chase tool was used with Paste from Foreground turned off, and the chase was done
either from the bottom left to the top right or vice versa, in some cases it would not properly
overwrite existing effects outside of the actual things being chased with off effects.

e The "+" key is supposed to invoke the Repeat tool, but only the "+" key on the standard part of the
keyboard was doing so, while the "+" key on the numeric keypad did nothing.

¢ When more than one sequence was open in the Sequence Editor, and they were maximized,
clicking on the "X' to the right of the menu bar would close the active sequence (as it should), but
that sequence's tab would remain open in the row of sequence tabs. Subsequently clicking on
that tab, for the closed sequence, would cause the Sequence Editor to crash.

e Stopping play of a sequence in the Sequence Editor would sometimes cause the column of cells
that happened to be at the time of the start of play to become selected.

What's New in Version 2.8.8

* Bug Fixes
Bug Fixes

e Various things in the Animator, such as drawing and erasing, were much slower than normal.

e When a sequence was loaded, the Animator would not remember whether its controls were hidden
for that sequence or not.

e Attempting to write a musical sequence to an SD card (for a standalone controller) would result in
a "subscript out of range" error message.

What's New in Version 2.8.6

© 2015 Light-O-Rama, Inc.



What's New? 107

¢ RGB Channels

e Color Fade Tool

* Repeat Tool

e Intelligent Fade Tool

e Fill Tool

¢ Chase Tool

e Paste from Foreground

¢ Insert Device

e Tools Panel

¢ Recent Tools

e Saved Tools

¢ Clipboards

e Sequences Created with Equally Spaced Timings in Freeform Grids
e Select Multiple Files in the Hardware Utility's MP3 Tab
e Tabbed Sequences Display

e Tools Menu Hotkeys Changed

e Keyboard Editing Keys Changed

e Off Effect via Delete Key

e Keyboard's Background/Foreground Selectors' Behavior Changed
e Shimmer and Twinkle Display Update

e Text of Channel Buttons Changes Color During Play

e Offline Registration Utility

* Bug Fixes
RGB Channels

An RGB channel represents a light or string of lights that can change colors - for example, a pixel on
a Cosmic Color Ribbon. It consists of three "normal” channels, representing the three component
colors - red, green and blue. Previously, to sequence such a device, you would have to sequence
those three channels for the three component colors individually - that is, you would set up the
seqguence to have those three channels, and you would (for example) set the red channel to fade up,
the green channel to hold steady, and the blue channel to fade down.

Now, you still can sequence the three component channels individually, but instead you could
simply add an "RGB channel” to the sequence, and use it to deal more directly with the resulting
colors. For example, instead of telling the red channel to fade up, the green channel to hold steady,
and the blue channel to fade down, you would simply tell the RGB channel to fade from cyan to
yellow.

Color Fade Tool
The Color Fade tool is a new tool that can be used to tell RGB channels how to behave. For
example, to specify that the RGB channel should fade from cyan to yellow over a certain time range
in a sequence, you would select the Color Fade tool, with its colors set to cyan and yellow, and
apply the tool to that time range of the sequence.

The Color Fade tool can also be used to do fills, by clicking the selected area instead of clicking and
dragging.

Repeat Tool

The Repeat tool takes whatever is contained in the selected area of the sequence and makes a new
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copy of it immediately following the selected area. Using the tool again (without changing what area
of the sequence has been selected) will make another new copy immediately following the first, and

using it again will make a third new copy immediately following the second. This can be repeated as
many times as you like, making as many back-to-back copies of the selected area as you want.

Intelligent Fade Tool

The Intelligent Fade tool is similar to the Fade Up and Fade Down tools. Howewer, using it makes
either a fade up or a fade down, depending upon whether you click and drag left to right or right to
left.

It can also be used to do fills, by clicking the selected area instead of clicking and dragging.

Fill Tool

If you apply the Fill tool to an area that has no effects (i.e. the lights are off in that channel at that
time), it will automatically make a fade from the intensity that precedes the empty area to the
intensity that follows the empty area. For example, if there is a fade up from 0 to 75, followed by the
lights being off, followed by a fade down from 50 to 25, and you apply the Fill tool to the area where
the lights are off, it will change that area so that it becomes a fade down from 75 to 50.

The Fill tool can also be used in a similar way on RGB channels, where it will change an empty area
so that it fades from the color preceding the empty area to the color following the empty area.

The Fill tool behaves a little differently than most other tools. With most tools, if you click and drag
an area, that area will be selected, and when you let up on the mouse button, that tool will be
applied to the selected area. The Fill tool, however, does not select an area, and it is applied as
soon as you click, and as soon as you drag to a new area, too. This, combined with the fact that
the Fill tool does nothing if it's used on an area that already has an effect, hopefully makes it quick
and easy to fill a large and complicated area of the sequence just by clicking once and dragging
around to the appropriate spots without letting go of the mouse button.

Chase Tool

The Chase tool takes a pattern and "chases" it through the selected area. That is, when you click
on a spot in the sequence, and then drag through other channels and through time, then when you
let go of the mouse button, it will take the pattern in the selected area's corner where you initially
clicked and copy it through the remaining channels in the selection, offsetting it a little bit in time
with each subsequent channel.

Paste from Foreground

"Paste from Foreground" is a new pasting option. When it is turned on, any portions of the
clipboard's copy buffer that have "off* effects won't actually be pasted when you select "Paste". That
is, copied "off" effects won't overwrite what you already have in your sequence.

Insert Device

The channel button popup menu now gives a new way to add channels to a sequence: "Add Device".
When this is selected, a dialog will open asking the type of device to add (such as an LOR/CTB 16
or a Cosmic Color Ribbon) and some settings for that device (such as its unit ID). The appropriate
number of channels will then be added to the sequence, and they will automatically be populated
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with the appropriate unit IDs, circuit IDs, and so forth.

Tools Panel

The left-hand side of the Sequence Editor now has a new Tools Panel, with a few subpanels ("Sawved
Tools", "Recent Tools" and "Clipboards"). The panel can be pinned to the display so that it is
always open, or it can be hidden so that it appears only as a small tab on the left of the Sequence
Editor, with the full panel sliding out when the mouse goes over that tab. The individual subpanels
can also be collapsed or expanded.

Recent Tools

The Recent Tools subpanel of the Tools Panel on the left-hand side of the Sequence Editor shows
buttons representing the tools that were used recently (such as "Fade Up 25-75", "Shimmer Down
100-0", or a color fade). Clicking on one of the buttons will make that tool the currently active tool.

Not all tools are put on the Recent Tools subpanel's list; only those that would take more than one
mouse click to activate are put there. For example, "Toggle" and "Shimmer" do not get put on the
list, since you could activate those in a single mouseclick (from the Tools toolbar).

Right-clicking on a tool's button enables you to put the tool on the Saved Tools list.

Saved Tools

The Saved Tools subpanel of the Tools Panel on the left-hand side of the Sequence Editor is similar
to the Recent Toolssubpanel, except that it shows only those tools that you have decided to save.
Once you put a tool on the Saved Tools list, it will remain there (until you explicitly remowe it), even
after the Sequence Editor has been stopped and restarted.

Clipboards

In previous versions of the Sequence Editor, there was only a single clipboard for copying and
pasting. Now, the Sequence Editor starts with a single clipboard, but you can easily add more of
them, and quickly switch between which one is in use at the moment, using the new Clipboards
subpanel of the Tools Panel on the left-hand side of the Sequence Editor. That is, you now can have
seweral different things copied at the same time, all of which can be pasted into your sequence.

The Clipboards subpanel also allows you to save a clipboard, so that its contents will be available to
be pasted even after you stop and restart the Sequence Editor, and to lock a clipboard, so that it
cannot be copied to (but still can be pasted from), to prevent accidental overwriting of a clipboard that
you want to keep.

It also allows quick access to pasting options such as Paste by Cell, Paste by Time, and Paste
from Foreground.

Sequences Created with Equally Spaced Timings in Freeform Grids

Previously, if you chose to create a sequence with equally spaced timings (such as "a timing every
tenth of a second”), the sequence'’s first timing grid would be a fixed timing grid. You can now
optionally make it either a fixed timing grid or a freeform timing grid.

Select Multiple Files in the Hardware Utility's MP3 Tab
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You can now select multiple files simultaneously in the Hardware Utility's MP3 tab (by using
standard Windows methods, such as Shift-click).

Tabbed Sequences Display

When more than one sequence is open, the Sequence Editor now shows a single one of them,
maximized, with tabs across the top having the names of the open sequences. Selecting any
particular tab will cause the Sequence Editor to switch to display that sequence.

If you want to see multiple sequences at once, you can unmaximize the currently displayed
sequence.

Tools Menu Hotkeys Changed

Several hotkeys for various menu items on the Tools menu have been changed, to try to minimize
overlap and to give unique hotkeys to as many "high profile" tools as possible.

Keyboard Editing Keys Changed

The keys assigned to several keyboard editing shortcuts have been changed, to make room for new
functions (such as the Chase tool and Fill tool).

Off Effect via Delete Key

One changed keyboard editing shortcut which it is worth explicitly pointing out (because it has been
requested by several people) is that the Delete key will now apply the "Off* tool to the selected area.

Keyboard's Background/Foreground Selectors' Behavior Changed

Previously, background and foreground effects mode could be enabled by certain keystrokes. To
turn them off, there was a different keystroke for enabling "regular” effects. Now, instead of
keystrokes to enable those modes, there are keystrokes to toggle them between being enabled and
disabled.

Shimmer and Twinkle Display Update

In the sequence grid, shimmer and twinkle effects are now displayed as a little heavier than they
used to be, to hopefully make them more easily recognized.

Note that this change is only from the point of view of how they look displayed on your screen in the
Sequence Editor; their behavior on your actual lights is unchanged from what it was before.

Text of Channel Buttons Changes Color During Play

During play, the Sequence Editor can be set up to change the colors of channel buttons to represent
the current intensity of the associated channel. The text of the channel name on that channel
button, however, was always black. Depending upon the color of the channel and its current
intensity, this could sometimes make the button difficult or even impossible to read. Now, the color
of the text of a button will be either black or white, depending upon which would be easier to read at
that moment for that channel.
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Offline Registration Utility

Previously, if a user had a computer that was not connected to the internet, they could only register
that computer by calling in to Light-O-Rama Customer Support. LOR Customer Support had a
program called the "Offline Registration Utility" which they then used to get the user's computer
activated.

This program is now distributed by the LOR installer, along with all the other programs (such as the
Sequence Editor). So, if a customer has two machines, one of which is connected to the internet
but the other of which is not, they can register their offline computer by using the Offline Registration
Utility on the online computer, without calling in to LOR Customer Support.

Offline registration via LOR Customer Support is still available, in case (for example) the customer
has only one computer, and it is not connected to the internet.

Bug Fixes

In the Sequence Editor, when "Paste by Cell" was set, and a copy and paste was done including
an event that was not completely coincident with a cell, in some situations the events pasted
wouldn't appropriately match the events copied completely.

In the Sequence Editor, dragging a channel button in order to mowve that channel would not work
properly if the visible channel range was scrolled up or down while dragging.

Various issues were fixed when converting a sequence from being a musical sequence to an
animation sequence, and vice versa.

When the DMX Tool, Fade Tool or Intensity Tool windows were closed by clicking on their "X’
buttons, the next time that they were displayed, they would be displayed in an entirely new
location instead of in the spot where they had been when they were closed.

The "Paste" button on the Sequence Editor's toolbar would not be enabled until after a copy (as
opposed to a cut) had been done. That is, if you started up the Sequence Editor and immediately
did a cut, the Paste button would still be greyed out even though you had cut something.

If you double-clicked somewhere on the New and Open dialog, for example to open a sequence by
double-clicking its filename, then depending upon where your mouse was, when the dialog closed
and the sequence opened, it could have caused something to happen such as a channel's
settings dialog being opened, or the current tool being applied to a cell in the sequence.

What's New in Version 2.7.6

This version fixes the following bugs:

e The Schedule Editor only displayed a thin portion of its vertical scroll bar.
¢ In certain situations, the Sequence Editor could possibly crash after having undone the adding of

timings.

What's New in Version 2.7.4

Show on demand

Show Player can preload sequences

Shows can be shut down gracefully

LOR Control Panel improvements

Shuffle mode options

Maximum Light-O-Rama circuit number is now 512
New iDMX1000 firmware: version 1.41
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e New DIO32 firmware:version 1.30
e New DC-MP3 firmware: version 4.10

* Bug fixes

Show On Demand

You can now cause a show to be played without having scheduled it. This is done via the "Show On
Demand" menu item of the Light-O-Rama Control Panel's popup menu.

Please note that this feature is available only for license levels Basic Plus and higher.

Show Player Can Preload Sequences

In previous versions of Light-O-Rama, when the Show Player played a show, a sequence in that
show would not be loaded until the first time it was used in the show. Depending upon the size of
the sequence and the power of the computer, it could take a human-noticeable amount of time to
load a sequence, so this could lead to undesired delays between sequences (the first time they are
played during a given run of a show).

This is still the default behavior, but you can now optionally set the show to preload sequences, so
that they will all be loaded as the first step in the show, before any of them are played.

Shows Can Be Shut Down Gracefully

In previous ersions of Light-O-Rama, selecting "Disable Shows" from the Light-O-Rama Control
Panel's menu would cause the currently running show to stop immediately, abruptly stopping any
sequences that happened to be playing. This can still be done (by selecting "Disable Shows
Immediately"), but you can now shut down a show gracefully instead (by selecting "Disable Shows

Gracefully").

This will cause the show that happens to be playing (if any) to be put into shutdown mode; any song
that happens to be playing will be allowed to finish, after which the show's Shutdown section will run.
When the Shutdown section finishes, the show will stop, and shows will be disabled.

LOR Control Panel Improvements

Several improvements were made to the Light-O-Rama Control Panel:

e The "Current" and "Scheduled" sections of its status window were often mostly redundant (if the
currently playing show was the show that was scheduled to be playing at the current time). The
"Scheduled" section has now been replaced by a "Next" section, which shows what will happen
after the current show.

e Those sections would update only after a noticeable delay of several seconds. They now update
in a much more real-time fashion.

e Similarly, the first log messages that were displayed would be delayed; they are now real-time.

e The Control Panel's light bulb icon in the system tray now is different colors depending upon the
state of the system: If scheduled shows are enabled, it is blue; if they are disabled, but shows on
demand are enabled, it is orange; if shows are disabled entirely, it is red.

e Seweral new log messages were added, hopefully giving a more informative view into what the

Show Player is doing.

Shuffle Mode Options
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In previous ersions of Light-O-Rama, when the Musical Section of a show was set to shuffle the
sequences instead of playing them in order, any sequence could be randomly chosen to play at any
time. This meant that, for example, the same sequence could play twice (or more) in a row, or some
particular sequence could be played a second time before some other particular sequence was
played even once.

The Show Editor now allows you to control the way that sequences are shuffled: You can choose
whether or not a single sequence is allowed to be played twice in a row, and you can choose
whether or not all sequences must be played once before some sequence is played a second time.

Existing show files will continue to behave in the same manner as they did before (unless and until
you change their settings): a sequence can be repeated back-to-back, and can be played a second
time before all other sequences have been played once.

The default for new shows is exactly the opposite: no sequence will be played twice in a row, and no
sequence will be played a second time before all sequences have been played once.

Maximum Light-O-Rama Circuit Number Is Now 512

In previous versions of Light-O-Rama, the maximum allowable circuit number for a Light-O-Rama
controller was 256. It is now 512. At the present time, this is primarily useful for controlling DMX
devices.

New iDMX1000 Firmware: Version 1.41

A new version of the firmware for the iDMX1000 has been released (version 1.41). It contains the
following enhancements:

¢ |t now has native address support (i.e. there is no longer a need for multiple unit IDs for a
single iDMX1000). The old method of having a single iDMX1000 use multiple unit IDs is still
supported, as "legacy mode". An iDMX1000 will be in native mode or legacy mode depending
upon the unit ID it is set to: If its unit ID ends in a "0" (such as "10", "20", or "30"), it will be in
legacy mode, where it actually uses sixteen unit IDs of sixteen channels each (e.g. setting
the unit ID to 10 will cause it to use unit IDs 10 through 19 and 1A through 1F). Ifits unit ID
ends in anything other than a zero, it will use only that single unit ID, but it will support all its
channels on that single unit ID.

¢ Previously, only DMX addresses up to 256 were supported. Now, addresses up to 512 are
supported (but only in native mode).

¢ Previously, only 64 "intelligent channels" were supported at a time - i.e. only 64 channels
could simultaneously be doing shimmers, twinkles, and/or fades. Now, 128 intelligent
channels are supported at a time.

New DIO32 Firmware: Version 1.30

A new version of the firmware for the DIO32 motherboard has been released (version 1.30). This
version adds native address support - that is, there is no longer a need to use multiple unit IDs for a
single DIO32; it can now support all channels on a single unit ID.

Please note that in order to take advantage of this new functionality, you will not only have to use the
new firmware, but you will also have to change a jumper on the board which tells it whether to
operate in native mode or legacy mode. Please refer to your DIO32 documentation for details.
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New DC-MP3 Firmware: Version 4.10

A new version of the firmware for the DC-MP3 has been released (version 4.10). It contains the
following enhancements and fixes:

¢ Previously, an individual sequence could only last for up to ten minutes. It can now last up to
44 hours.

¢ Previously, only certain manufacturer's SD cards were supported. A much larger variety is
now supported (list to be compiled - although it will more likely be a list of unsupported cards
rather than a list of supported cards).

e Support for SD cards with the FAT32 file system was added.

e Support for SDHC (high capacity) SD cards was added.

¢ Previously, shows could be set to play every hour or every half hour; they now can also be set
to play every 15 minutes or every 10 minutes.

¢ Digital output (DO) pins 1 through 6 now operate. They react to commands for unit ID FO,
channels 1 through 6. They only react on the DC-MP3 that is controlling the show; for
example, they will not react on a DC-MP3 controlled via the PC network.

e Under some circumstances, shows would start at midnight, without having been scheduled to
do so. This has been fixed.

Bug Fixes

Protection against several possible crashes was added to the Light-O-Rama Control Panel.
Although it is not known if any of these actually caused any crashes, it is known that some
customers hawe had the Light-O-Rama Control Panel crash.

When disabling shows, or when unloading Light-O-Rama, the LOR Control Panel would hang
frozen for a noticeable amount of time before becoming responsive again (in the case of disabling
shows) or closing (in the case of unloading).

The Light-O-Rama Control Panel's status window would sometimes incorrectly state that the next
show would start at 12:00 AM on Sunday.

Sometimes, lighting commands were quickly repeated back-to-back. This would not cause any
noticeable problems with how the sequence looked, but it did cause a minor increase in network
traffic, or standalone/SD sequence file size.

What's New in Version 2.6.2

Light-O-Rama Diagnostic distributed by installer
Bug fixes

Light-O-Rama Diagnostic Distributed by Installer

The Light-O-Rama Diagnostic is a troubleshooting tool that displays various information about your
Light-O-Rama configuration. It used to be available only as a separate download from
lightorama.com, but now is installed as a standard part of the Light-O-Rama Software Package.

Bug Fixes

On Windows 98 SE machines, running a show of sufficient length would eventually cause an error
message to pop up, saying that an error occurred in "Formhook_aftermessage”. Clicking "OK"
would close the error message, but it would soon pop up again, and again and again. If it was left
without clicking "OK" to close it, eventually the show would stop abnormally.

In the Sequence Editor, "Sequence Info", from the "View" menu, would sometimes display the
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incorrect directory of the media file associated with a musical sequence.

* If a channel was set up to be a subsequence, and the sequence file assigned to it did not exist or
otherwise could not be loaded, then loading of the main sequence would fail when the loading of
the subsequence failed. The result of this was that the main sequence could not be opened, and
so the problem could not be fixed by modifying the subsequence filename associated with the
channel. Now, the main sequence will successfully load, and the missing subsequence will
simply not do anything during play. Note that the Light-O-Rama Verifier will still show this error.

e [f you set the name of a channel to include an ampersand, then in the Sequence Editor, the name
would be displayed on the channel's button improperly. The ampersand would be missing, and
the character after it would be underlined (indicating that it could be used as a hotkey for that
button).

e [f the Sequence Editor was used on a computer with multiple monitors, and the cursor was
hovered ower a spot on a sequence grid that was on a monitor to the right of the primary monitor,
the tool tip would pop up in the wrong place (on the far right side of the primary monitor).

e Hitting the escape key closes most dialogs, but it did not close the Beat Wizard, VU Wizard, or

Tapper Wizard.
What's New in Version 2.6.0

Undo/redo recording can be disabled

All license levels now use unencrypted save files

Hardware Utility shows version of connected MP3 Director's firmware
New DC-MP3 firmware: Version 3.3

e New Senwo Dog firmware: Version 1.02

Bug fixes

Undo/Redo Recording Can Be Disabled

Certain very large operations in the Sequence Editor could take a very long time to do. For
example, skewing a track inwlves changing all of the timings, effects, and loops in the track; in a
large sequence with many channels, this could take a prohibitively long time. Much of the time
spent is actually due to recording the changes so as to later be able to undo and redo them.

For situations like this, undo and redo recording can now be disabled, via the Edit menu. You will
not be able to undo any changes that were made while undo recording was disabled, but the
changes that you make will be made more quickly.

All License Levels Now Use Unencrypted Save Files

In previous versions of Light-O-Rama, when a sequence was saved using either a Basic license or
else the unlicensed Demo ersion of the software, the sequence file would be encrypted instead of
being saved in plain XML. Now, this encryption is done only for the unlicensed Demo version; a
Basic level license (or any other level license) will cause files to be saved unencrypted.

Hardware Utility Shows Version of Connected MP3 Director's Firmware

Previously, the Hardware Utility's LOR MP3 tab would show whether an MP3 Director was connected
or not. Now, if one is, it additionally shows the MP3 Director's firmware version.

New DC-MP3 Firmware: Version 3.3

Version 3.2 of the DC-MP3 firmware (DC_MP3_V3-3.lhx) adds one new feature and fixes two bugs:
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e Qutput number 8, which was previously unused, will now be high (+5 wlts) when a show is active,
and zero when no show is active.

e When a sequence started playing, in some rare cases the music and the lights would start off
significantly out of sync with each other.

e A bug was causing trigger number 6 to interact with trigger number 3 in some cases.

New Servo Dog Firmware: Version 1.02

Version 1.02 of the Servo Dog firmware (SernvoDog_V1-02.1hx) fixes a bug where if channels 1 and 8
were in digital output mode, there would be crosstalk causing random results.

Bug Fixes

¢ Certain ways of scrolling through the channel list in the Animator window were not working.

e Skewing a track would not work if the timing grid currently in use by the track was a fixed timing
grid.

¢ In the Servo Dog Utility, when a channel button was clicked, if another channel button had
previously been selected, there was a chance that the configuration of the channel that was
clicked would be set to the same values as the configuration of the channel that had previously
been selected.

¢ In the Hardware Utility, controllers that were connected via Easy Light Linkers were not showing
up in all cases.

What's New in Version 2.5.6

¢ Bug fixes
Bug Fixes
¢ |f a show was scheduled starting on Saturday and ending on Sunday, instead of playing through, it

would continuously shut down and restart. A common symptom of this is that the first sequence
in the show's musical section would play over and over.

What's New in Version 2.5.4

¢ Bug fixes
Bug Fixes
e X10 controllers were not successfully being controlled in some situations.

e When a sequence was loaded, the zoom level of its waveform display was being set to a default
value, rather than to the zoom level the sequence had been saved with.

What's New in Version 2.5.2

The following changes were made in this version:

¢ LOR Control Panel's status window now displays a log
e Support for configuring Cosmic Color Ribbons
e Circuit IDs greater than 16 supported

© 2015 Light-O-Rama, Inc.



What's New? 117

e The Light-O-Rama SernwoDog Utility
* Bug fixes

LOR Control Panel's Status Window Now Displays a Log

The Light-O-Rama Control Panel's status window now displays a log of what is occurring with shows.
For example, it displays messages indicating that a show or a sequence is stopping or starting,
that an error occurred playing a sequence, and that an interactive trigger was detected.

Support for Configuring Cosmic Color Ribbons

The Hardware Utility's Configuration screen now supports configuring Cosmic Color Ribbons.

Circuit IDs Greater than 16 Supported

In previous \ersions, the circuit IDs of Light-O-Rama controllers could range from 1 to 16. They now
can range from 1 to 256 instead.

Note that not all Light-O-Rama controllers have more than sixteen circuits, and of those that do, not
all support this new feature yet (instead, they use more than one unit ID, each with sixteen possible
circuit IDs). Currently, the only Light-O-Rama controller that can be set to use more than sixteen
circuit IDs for a single unit ID is the Cosmic Color Ribbon. Support for this feature in some other
controllers is planned for the future, at which time firmware upgrades may be necessary to take
advantage of it.

The Light-O-Rama ServoDog Utility

The Light-O-Rama ServoDog Utility is a new program which can be used to configure Light-O-Rama
SenwoDog controllers.

Bug Fixes

e If an error opening a comm port occurred when the Hardware Utility was being started, this could
lead to strange errors later, such as the Hardware Utility unexpectedly closing in certain
situations.

e If the musical section of a show contained sequences that could not be played due to errors, then
in some situations the first sequence of the musical section of the show might repeat several
times in a row.

e On some computers, when a Light-O-Rama program (such as the Sequence Editor) was started, it
would open in Demo mode very frequently, despite having previously been activated (and without
having upgraded to a new version).

¢ In the Sequence Editor, if you clicked the space bar to start play while the mouse button was
down, then when play ended, you would be in "mouse dragging" mode, no matter whether you
subsequently released the mouse button or not.

e If you used a countdown in the Tapper Wizard, sometimes the song would not start after the
conclusion of the countdown.

¢ Various problems would occur if you set the default Sequences and Audio directories to be top
level directories of a drive (for example, "C:\Sequences" and "C:\Audio" rather than "C:\LOR
\Sequences" and "C:\LOR\Audio").

¢ In some situations, deleting a track from a sequence would cause the track dropdown list and the
timing grid dropdown list to misbehave.
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What's New in Version 2.4.10

The following changes were made in this version:

Exporting/importing channel configuration with tracks improved

e Commands sent to Holiday Lights Designer regardless of licensing level
Hardware Utility supports DIO32 servo configuration

Refresh command made quicker

* Bug fixes

Exporting/Importing Channel Configuration with Tracks Improved

In previous \ersions of Light-O-Rama, exporting and importing channel configuration from and to
sequences that have more than one track could lead to strange, and probably undesired, results.
This was due to the interaction between channels that were in more than one track of the sequence
and channels that were in more than one track of the configuration file. If the positions of such
channels did not match up between the sequence and the configuration file, then the resulting
settings of those channels would be changed in a predictable, but probably undesired, way.

In this version, the method of importing has been altered, so as to give (hopefully) better results:

Unlike in previous versions, the first step to importing channel configuration, before any channels are
actually imported from the configuration file, is now to check the sequence for channels that are in
more than one track. If any such channels are found, then all copies of each channel, except for the
first of each channel, are removed from the sequence.

Next, channels are imported from the configuration file. But unlike in previous versions, if a channel
is in more than one track of the configuration file, instead of overwriting the settings of an existing
channel in the sequence every time the channel is encountered in the configuration file, that is only
done on the first encounter of the channel. Instead, on subsequent encounters of the same channel,
a copy of the appropriate channel from the sequence is inserted into the track at the appropriate
position.

This has two potential side effects to watch out for (although both of these seem minor compared to
the side effects caused in previous versions):

First, if a track in the sequence is composed entirely of channels from previous tracks, and the
channel configuration file has no track in the same position, then all channels will be removed from
that track. Since the track has no channels, it will then be removed from the sequence. Howeer,
note that these channels have not been removed from the sequence - they have only been removed
from the track. They are still in the earlier tracks.

Second, a channel from the sequence with no corresponding channel in the configuration file could
get "pushed down" towards the bottom of the sequence's track, if the channel configuration file
contains channels in that track which are copies of channels from earlier tracks.

Commands Sent to Holiday Lights Designer Regardless of Licensing Level

Different licensing levels can control different numbers of controllers; for example, the Basic level can
control two controllers, while the Advanced level can control an unlimited number of controllers. If a
seguence contains a lighting effect for a controller that the license level cannot control, the effect is
simply not sent to the controller.
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In previous \ersions, this also applied to sending commands to Holiday Lights Designer: lighting

effects could be sent to Holiday Lights Designer only if they could be sent to an actual controller,
based on the license level. Now, lighting effects can always be sent to Holiday Lights Designer,

regardless of the licensing lewel.

Hardware Utility Supports DIO32 Servo Configuration

The Hardware Utility can now be used to configure the DIO32 for servos.

Refresh Command Made Quicker

The Hardware Utility's Refresh command, used to scan a Light-O-Rama network for controllers, now
works more quickly than it did before.

Bug Fixes

e |f a show contains some sequences in a "Magic Toy" interactive group, and a trigger in that group
is triggered, any playing sequences that happen to be from that same interactive group should be,
but were not, stopped, before the newly triggered sequences start.

e The Channel Property Grid would allow you to remowve the last channel from a track, which would
lead to undesired behavior. It now no longer allows the last channel to be removed from a track.

¢ There must be a channel in every track; Light-O-Rama should prevent you from removing the last
channel from a track. Due to bugs, though, it's possible that the last channel could be removed
from a track; in such a case, if the sequence were saved, it could not thereafter be reloaded. In
this version, the sequence can now be loaded, but any tracks without channels will automatically
be remowved from the sequence during the load.

e Input triggers would work correctly only for the first eight circuits of a controller. They now work on
the full sixteen.

What's New in Version 2.4.8

The following changes were made in this version:

e Tapper Wizard improvements

e Animator's twinkle effect made more realistic

e Fade Tool Settings and Intensity Tool Settings can be toggled on and off
¢ New keyboard shortcuts for selecting the current tool

e Keyboard editing while using the Animator made easier

¢ File saving made safer

e Track bar of active track highlighted

* Bug fixes

Tapper Wizard Improvements
The Tapper Wizard was improved in several ways:

¢ |t now knows about timing grids. You can select an existing grid to use, or create new grids to
use, from within the Tapper Wizard itself.

¢ Inserting timings and inserting lighting effects can now be done independently of each other - you
can do either or both.

e You can play a particular part of a song, rather than the whole song. When the Tapper Wizard is
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first opened, its play range will automatically be set to the active track's freeform play range, if
there is one, or to its normal play range (such as play full sequence or play visible screen) if not.

e You can set the play speed, either to normal speed, half speed, or double speed.

e |t can be used repeatedly without closing, with or without tapping again. For example, after
applying your taps to the sequence, you could collect a whole new set of taps, or you could apply
your existing taps to the sequence again, in a new way (such as applying them to a different
channel, or with different flash and fade times), all without ever closing the Tapper Wizard.

e |t supports undo and redo within itself, you do not hawe to close the Tapper Wizard to undo or redo
its changes.

e |t no longer relies on helper forms to collect information (such as the length of time that a flash
should take); this information is now set via fields on the Tapper Wizard itself.

e The settings that you choose, such as whether to use a countdown, how long that countdown
should be, whether to use the mouse, the keyboard, or both, what kind of effects or timings should
be inserted, and so forth, are remembered, so that you do not have to change them every time that
you enter the Tapper Wizard.

Animator's Twinkle Effect Made More Realistic

Recent efficiency improvements to the Animator increased the speed it could redraw at. This had
the side effect of making its twinkle effects twinkle too quickly, almost looking like shimmers. The
Animator's twinkle effect has now been slowed back down, to more closely resemble the twinkle

effect on actual lights.

Please note that this change does not affect the way that twinkle behaves on your lights at all; they
will behave exactly as they always hawe. It only affects how twinkle is represented in the Animator
(which is an approximation, not an exact representation, of how it looks on actual lights).

Fade Tool Settings and Intensity Tool Settings Can Be Toggled On and Off

In previous versions, clicking of the Fade Tool Settings toolbar button would open the Fade Tool
Settings dialog, as would clicking on the Tools menu's Fade Tool Settings item. The only way to
close the dialog was to click on its Windows close button, or to use the escape key. Now, the
toolbar button (or the menu item) can be used as a toggle - clicking it once shows the dialog;
clicking it again hides it.

A similar change was made for the Intensity Tool Settings dialog.

New Keyboard Shortcuts for Selecting the Current Tool

When editing sequences via the keyboard, previous versions would allow you to hit the Enter key to
apply the current tool to the selected area of the sequence. Alternatively, to apply a different tool,
you could hit some other key, specific to that tool; this would leave the current tool the same as it
was. For example, if the current tool was the shimmer tool, you could hit Enter to apply a shimmer,
or "T" to apply a twinkle.

Howeer, the current tool itself could not be selected except via the toolbar, or menu items on the
Tools menu. It can now be selected via the keyboard as well, by using Shift in addition to the
desired effect's normal key. For example, Shift-T will change the current tool to change the current
tool to be the twinkle tool. Note that this leaves the sequence itself untouched (but you can still hit
Enter to apply the current tool to the sequence, or one of the specific keys to apply some other tool).

Due to this change, certain existing keyboard shortcuts had to be remapped. Specifically, Shift-S,
Shift-T, Shift-l, Shift-U and Shift-D used to change the current custom tool to be a custom shimmer,
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twinkle, intensity, fade up, or fade down, respectively. These have been replaced with Ctrl-Shift-S,
Ctrl-Shift-T, Ctrl-Shift-I, Ctrl-Shift-U, and Ctrl-Shift-D, respectively.

Keyboard Editing while Using the Animator Made Easier

When you click on a control in the Animator, after that control's operation has completed, the focus
is now immediately given back to the sequence grid. The effect of this is that you can continue
using the keyboard to edit the sequence without needing to mouse-click on it every time you change
something in the Animator.

File Saving Made Safer

Previously, when the Sequence Editor saved a sequence, it would delete the backup file of that
sequence, then rename the existing save file to the backup, then write a new version of the sawe file,
then verify that it could load the new version of the sawve file. If it could not load the new version, it
would give a warning message saying so, and giving the name of the backup file.

Instead, it now writes the sequence to a temporary file, then verifies that it can load that temporary
file. Only ifit can load the temporary file does it then proceed to delete the backup file, rename the
existing sawe file to the backup, and finally rename the temporary file to the real sawve file name.

Track Bar of Active Track Highlighted

In the Sequence Editor, the track bar of the currently active track in a sequence is now colored
green, so as to make it easily distinguishable from the other tracks.

Bug Fixes

¢ In the Sequence Editor, if the total time of a track was increased, and that track was currently
using a fixed timing grid, an error message would pop up saying that timings cannot be added to
fixed grids.

¢ If the Windows option "Hide extensions for known file types" was turned on, the New and Open
dialog's "Existing Sequence" tab would not properly display the type of each file.

What's New in Version 2.3.8

This version fixes the following bugs:

¢ In the Sequence Editor, when the mouse was mowed to the left of the channel bar, an error
message would sometimes pop up, saying "Invalid centisecond for finding timing", followed by a
negative number. This would always happen when the mouse was dragging, and sometimes
happen otherwise.

e On some computers running Windows Vista, installation would fail, giving an error about
Microsoft's MDAC component.

What's New in Version 2.3.6

This version fixes the following bug: Upon upgrade from a previous version of Light-O-Rama, if the
user chose a different directory to store sequence and audio files than was chosen for the previous
version, the post-install process would neglect to copy the files from the old directory to the new one.
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What's New in Version 2.3.4

The following changes were made for Light-O-Rama version 2.3.4:

Timing grids

The Light-O-Rama Verifier

Beat Wizard and VU Wizard improvements

Initial play of sequences sped up

Events straddling the start of a play range are played

New and Open dialog improvements

New musical sequence's initial channels can be based on a channel configuration file
New musical sequence's artist, album, and song names pulled from MP3
Support for normally closed input triggers

Interactive triggers can be tested in the Hardware Utility

Maximum and minimum intensities read from controller

Extra Information in sequence grid tooltips

Control Panel's status window can be minimized

Fades are smoother in the Animator

Animator CPU utilization improved

Animator redraw throttling configurable

Zooming with the Animator's autosize mode

Bug fixes

Timing Grids

A timing grid is a collection of timings. A sequence can have more than one timing grid, but only
one (per track) is displayed at any given time. You can quickly change which timing grid is
displayed at any time by selecting from the Tracks and Timings toolbar's timings dropdown list.

There are two types of timing grids: fixed timing grids, which have timings at equal distances from
each other, and which cannot hawe timings added, remowved, or mowved, and freeform timing grids,
which can hawe timings anywhere, and which can hawe timings added, removed, or moved.

Timing grids are intended to better fulfill a role that was fulfilled in previous versions of Light-O-Rama
by tracks: Allowing different sets of timings to be used on the exact same channels.

For example, perhaps you have a song for which you would like some lighting effects sequenced to
the sound of the bass drum, and other lighting effects sequenced to the sound of the lead guitar.
You could simply add timings for both, but this could make it easy to forget which timing is for which
instrument; it could also make the display seem too cluttered with timings.

To solve this problem in previous versions of Light-O-Rama, you could duplicate the track to a new
track, so that you had two different tracks in the sequence, both with the same channels as each
other. The two tracks could use different timings, one track representing the bass drum and the
other representing the lead guitar.

You can still do that in this new version of Light-O-Rama, but you can now instead solve the problem
by using timing grids. Instead of adding a second track, you could add a second timing grid. One
timing grid would represent the bass drum, and the other would represent the lead guitar. You could
quickly switch which timing grid is displayed using the Tracks and Timings toolbar's timings
dropdown list, changing back and forth between drum and guitar as appropriate, all with only a single
track.
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The Tracks and Timings toolbar also has a timings button; clicking on it will open a popup menu with
various timings grid-related options, such as adding a new timing grid or deleting an existing one.

When this new version of Light-O-Rama opens a sequence created with a previous version (in which
there was no such thing as a timing grid), it will automatically create one freeform timing grid per
track in the sequence.

The Light-O-Rama Verifier

The new Light-O-Rama Verifier program can be used to check for certain types of problems with your
Light-O-Rama configuration, schedule, shows, and sequences. By using the Verifier, you may be
able to fix these problems before they cause any issues when your show is played.

Beat Wizard and VU Wizard Improvements

In previous ersions, the Beat Wizard and the VU Wizard would always add timings, regardless of
whether they were also adding effects or not. They can now add timings and effects independently
of each other.

Also, when inserting effects, they can now optionally snap them to the timings being used.

Initial Play of Sequences Sped Up

The amount of time that it takes for a sequence to start playing the first time after it is loaded (or
after it is changed or the play range is changed) has been decreased.

Events Straddling the Start of a Play Range Are Played

In the Sequence Editor, if the play range is set to anything other than the full sequence, and an
effect event starts before the play range starts but ends during (or after) the play range, previous
versions of Light-O-Rama would not control the lights based upon that event. Instead, now, the
portion of the event within the play range is sent to the lights (for example, if the event is a fade up
from 0% to 100% from 36 seconds to 38 seconds, and the play range starts at 37 seconds, the
lights will be sent a command to fade up from 50% to 100%).

New and Open Dialog Improvements

Several improvements were made to the Sequence Editor's New and Open dialog:

In previous versions, the dialog was a fixed size, which could not be changed. It can now be resized
or maximized, and will remember its sizing and positioning even after the Sequence Editor is closed
and restarted.

The dialog's Existing Sequence tab used to always show a list of folders and sequences in a single
way. It now has an option to change the view, similarly to Windows Explorer. For example, if the
"Details" view is selected, then in addition to file names, details such as file sizes and modification
dates will be displayed. Clicking on a column header in the "Details" view will sort the files by that
column; clicking on it again will sort in reverse order. The dialog will remember the selected view and
sorting behavior even after the Sequence Editor is closed and restarted.

The Existing Sequence tab now also has a "Search" box. If you type something into this box, only
files with that somewhere in their name will be listed. Wildcard characters (*, ? and #) are supported
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in the search box.

The Standard Toolbar's "Open" button would previously always open the dialog to the "Existing
Sequence" tab. It now instead opens it to whichever of "Existing Sequence" or "Recent Sequence”
was most recently used.

New Musical Sequence's Initial Channels Can Be Based on a Channel
Configuration File

When you create a new musical sequence, the New Musical Sequence dialog now lets you base the
initial channels for the sequence off of the contents of a channel configuration file, rather than simply
specifying a number of channels.

New Musical Sequence's Artist, Alboum, and Song Names Pulled from MP3

If you create a musical sequence based on an MP3 file, the New Musical Sequence dialog
automatically uses the artist, album and song names from the MP3 itself (if the MP3 is tagged with
this information). You can still change these in the dialog if you wish.

Support for Normally Closed Input Triggers

Previous versions of Light-O-Rama only supported normally open circuits for use as input triggers.
Normally closed circuits are now supported as well, via the Hardware Utility's LOR controller
configuration screen.

You may need to update the firmware of your controller in order to take advantage of this new
feature.

Interactive Triggers Can Be Tested in the Hardware Utility

The Hardware Utility's LOR controller testing screen can now be used to test input triggers from LOR
controllers.

Maximum and Minimum Intensities Read from Controller

The Hardware Utility's LOR controller configuration screen can now read the maximum and minimum
intensity settings of a Light-O-Rama controller from the controller itself.

You may need to update the firmware of your controller in order to take advantage of this new
feature.

Extra Information in Sequence Grid Tooltips

The tooltip displayed in the Sequence Editor when the mouse hovers over a cell in a sequence now
includes more information than before, including details on the effect event being hovered ower.

You can configure various settings about the tooltips, such as how long they take to open and how
they close, via the Display Preferences dialog.

Control Panel's Status Window Can Be Minimized

The status window of the Light-O-Rama Control Panel can now be minimized to the Windows task
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bar.

Fades Are Smootherin the Animator

The Animator used to display fades in a somewhat jerky manner, only updating the display after the
color of a cell has changed by a fairly significant amount. Depending upon the speed of the fade,
this would lead to fades more as steps through several intensities rather than as actual fades (note
that this only affected the appearance of the Animator, not the appearance of any real lights that you
had hooked up via controllers). Fades should now appear more smoothly in the Animator.

Animator CPU Utilization Improved

Various changes were made to the Animator to decrease the amount of CPU time that it takes to
display the animation.

Animator Redraw Throttling Configurable

During play, the Animator only redraws the animation every so often, rather than every time that
something changes. This is to try to ensure that it does not use too much CPU time. In the past,
the amount of time between redraws was a certain constant value; now, you can modify it in the
Display Preferences dialog, to try to strike an appropriate balance between CPU usage and
smoothness of display for your individual computer.

Zooming with the Animator's Autosize Mode

When the Animator's controls are hidden, expanding and contracting the Animator's window is
supposed to also automatically resize the drawing area within the window. However, due to certain
sizing requirements, the drawing area can only be certain possible sizes for any given animation.
So, when the window was manually resized by clicking and dragging a side or a corner, the drawing
area would remain the same size, until the window got large enough to hold the next possible size,
at which time the drawing area would "jump" to the new size.

To make this autosizing quicker and easier, the ability to manually resize by dragging a side or a
corner of the window has been replaced by "zoom" buttons on the toolbar, which will immediately
resize the window (and the drawing area) to the next possible size.

Bug Fixes
This release fixes the following issues:

¢ If the same show had been scheduled twice back-to-back, it would have simply continued playing
rather than stopping and restarting.

e If a channel was set up to represent a subsequence, changing the subsequence file associated
with the channel would not cause the channel's main sequence to be marked as having unsaved
changes.

¢ If a musical sequence based on a MIDI file was playing in the Sequence Editor, and was paused
or stopped before its natural end, and the sequence had used the MIDI Wizard, then the Sequence
Editor would not send out MIDI commands saying to stop sounds. This caused whatever notes
happened to be playing when the sequence was paused or stopped to continue playing
indefinitely.

¢ If the VU Wizard were used to toggle cells on and off during part of a song, as opposed to the
entire song, it would sometimes get the toggling backwards, turning on cells that should have
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been turned off, and vice versa.

If the VU Wizard were used to toggle cells on and off during part of a song, as opposed to the
entire song, it would not necessarily get the state of the first or the last cell in the range correct.
If the VU Wizard were set up such that the entire selected area of the song was below the
specified peak threshold, an error box would appear, saying "Subscript out of range".

If an animation had a background image, and the Animator's controls were hidden, resizing the
window would not necessarily keep the image's proportions as they were.

If the Animator's controls were hidden, resizing the window would only automatically resize the
animation if it had a background image.

The menu items on the Wave Form submenu of the Sequence Editor's View menu would not
become checked until one of them (or the View Waveform button on the Standard Toolbar) was
clicked.

When the Sequence Editor's New and Open dialog is first opened, its dropdown list of folders did
not include all of the immediate child folders of "My Computer".

In the Hardware Utility's Test Console, clicking the "All Off* or "All On" buttons would mowe the
intensity sliders appropriately, but would not update the text boxes beneath them to say the new
intensities.

If Windows suspended while the Sequence Editor was open, and a USB adapter was in use for an
LOR comm port, then when Windows resumed, the Sequence Editor would be locked up.

The Hardware Utility would shut down without warning if "Lights Off* or "All Off* were pressed while
the LOR comm port was set to a port number that could not be initialized.

The Hardware Utility would shut down without warning upon trying to initialize an X10 CM-11A
device on a port that had (till that point) been assigned to LOR devices.

What's New in Version 2.1.6

This version fixes the following bugs:

If the waveform display were used with a completely silent audio file, the Sequence Editor would
crash.

If a sequence had a Windows shell command, and it were saved to a different filename than it had
been loaded with, future changes to the Windows shell command in one of the two sequences
would affect the Windows shell command in the other sequence as well.

Shows scheduled by the Simple Show Builder, and run via the PC, would not necessarily end at
their appropriate time.

What's New in Version 2.1.4

This version fixes the following bugs:

In certain situations, adding a sequence to an MP3 Player Showlist would fail, with an error
message saying "Path/File Access error".

Sequences downloaded to an MP3 director would have their final lighting effect cut off prematurely.
The Sequence Editor's New Musical Sequence Preferences dialog would not allow you to change
the default timings to certain values ("MIDI Wizard", "Beat Wizard", and "VU Wizard") if you
opened the dialog via the "New Musical Sequence Preferences” menu item on the Preferences
submenu of the Edit menu.

What's New in Version 2.1.2

The following changes were made for Light-O-Rama version 2.1.2:
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* Licensing

e Custom fade/intensity twinkles and shimmers

e Triggered interactive sequences

e Show startup options

¢ Windows shell commands

e DMXintensity

e The New and Open dialog

e Keep lights on at end of play

e Automatic channel settings for newly created sequences
e Events can be dragged with timings

e Change in behavior for mouse switching tracks

e Animation sequences in the musical section cut off at end of show
e "Max Units" in Hardware Utility changed to "Max Unit ID"

* Bug fixes

Licensing

The Light-O-Rama Software Package must now be registered with a valid license in order to unlock
its full potential. There are seweral different license levels, each with different features available.
Additionally, Light-O-Rama can be run without a license, as a Demo version; the Demo version
cannot be used to actually control lights, though.

Existing customers who have purchased earlier versions of the Light-O-Rama software package are
entitled to a free license of the highest level ("Advanced").

For details about registering and about the features available with the different licenses, please see
Registering Light-O-Rama and Feature Comparison.

Custom Fade/Intensity Twinkles and Shimmers

In previous versions of Light-O-Rama, twinkling or shimmering the lights could only be done at full
intensity. You can now use new custom tools to twinkle or shimmer the lights while fading them up
or down, or at some intensity other than full intensity.

Existing Light-O-Rama controllers may need firmware upgrades to take advantage of this new
feature; if a custom twinkle or shimmer is sent to a controller without the upgrade, it will react as if it
were a "regular” twinkle or shimmer - i.e. it will twinkle or shimmer at full intensity.

Triggered Interactive Sequences

In addition to being able to control lights, some Light-O-Rama controllers can now act as input
triggers. This allows sequences to be played on demand during a show - for example, your display
may have a group of buttons that people can press, each of which will cause a different song to be
played.

For details, please see the help file page "Interactive Groups".

Show Startup Options

In previous ersions of Light-O-Rama, the sequences in a show would start playing immediately at
the show's scheduled start time. There is now more flexibility with regards to this; for example, you
could hook a big red button labeled "Start the Show" up to one of your Light-O-Rama controllers, and
the show will not be started until that button is pushed.
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For details, please see "Show Startup Options".

Windows Shell Commands

Your sequences can now be configured so that, whenever one is played, Light-O-Rama will execute
any arbitrary Windows command that you associate with that sequence.

An example of how this might be useful: If you broadcast the songs playing during your show over
the radio, and have hardware allowing you to broadcast RDS ("Radio Data System") information, you
can now set your sequences up so that, whenewver one is played, Light-O-Rama will tell Windows to
tell your RDS program to broadcast the name of the song for that sequence.

For details, please see the help file page "Windows Shell Commands".

DMX Intensity

A new effect, "DMX Intensity”, has been added. This can be used to specify 256 possible intensities
(from O to 255), rather than the regular 101 possible intensities (from 0 to 100). This is useful for
DMX devices, which can take up to 256 possible intensities.

Note: The DMX intensity tool is not available by default in the Sequence Editor - for example, by
default, no toolbar button will be displayed for it. To enable the tool, select "Allow DMX Editing" from
the DMX Preferences menu.

The New and Open Dialog

The Sequence Editor's new "New and Open dialog" allows you to create a new sequence, or open an
existing one. This dialog is opened by default when the Sequence Editor starts up (although this
behavior can be suppressed), and also when something like "New" or "Open" is selected from the
File menu or the Standard toolbar.

Keep Lights On at End of Play

For most sections in a show, you can now use the Show Editor to specify whether or not sequences
in that section will automatically turn their lights off when they end playing.

There are two exceptions: First, the Background section does not allow this setting. Second, the
Interactive section allows you to control this for each interactive group individually, rather than for the
section as a whole.

Automatic Channel Settings for Newly Created Sequences

When creating a new musical sequence or new animation sequence, you now have the option to
automatically configure the channels in the new sequence to use standard Light-O-Rama controllers.
The first channel will be set up to use Light-O-Rama unit 1 circuit 1, the next unit 1 circuit 2, and so
forth, then on to unit 2, and so forth. All such channels will be configured to use the regular LOR
network.

Events Can Be Dragged with Timings

When a timing is dragged in the Sequence Editor, to change the time it is at, there is now an option
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to also drag any effect events that start or end at that timing along with it.

This option is controlled via the Edit menu's "Drag Events with Timings" checkbox.

Change in Behavior for Mouse Switching Tracks

Switching to another track via the mouse in the Sequence Editor now causes the selected area for
that track to be set to the cell that was clicked, even if that cell is within what used to be the
selected area for that track. In particular, if a tool other than "Select” is enabled, that tool will be
applied to the new selection, not the old one.

Animation Sequences in Musical Section Cut Off at End of Show

In previous versions, when a show reached its scheduled end, if a sequence from the musical
section of the show happened to be playing, that sequence would continue playing to its natural end
before the shutdown section of the show would begin. Now, that is only the case for musical
sequences; if the sequence is an animation sequence, it will abruptly stop at the scheduled end of
show, regardless of the fact that it is in the musical section of the show.

"Max Units" in Hardware Utility Changed to "Max Unit ID"

When the Hardware Utility is asked to automatically detect units, it must individually search for each
possible unit ID. This may take some time to do. To speed this up, the Hardware Utility allowed
you to specify a maximum number of units to search for, in a box labelled "Max Units". For
example, if you set "Max Units" to "3", the Hardware Utility would search for a controller with unit ID
01, another with unit ID 02, and a third with unit ID 03. It would not check for any unit IDs past 03.
Howe\er, this often led to the following confusion:

Unit IDs are given in hexadecimal notation. So, for example, the next unit ID after 09 is not 10, but
OA. That is followed by OB, 0C, 0D, OE, and OF, and only then does 10 come. So, if a person's
highest unit ID was 10, they might be mislead to thinking that they should input "10" into "Max
Units". But "Max Units" was merely a count, not an ID, meaning that the Hardware Utility would
only search for the first ten possible unit IDs, i.e. 01 through 09 and OA. Therefore, unit 10 would not
be found (as it is actually the sixteenth possible unit ID).

To get rid of this common source of confusion, "Max Units" was changed to "Max Unit ID". So now,
for example, entering "10" will search for unit IDs 01 through 09, unit IDs OA through OF, and unit ID
10.

Bug Fixes
This release fixes the following issues:

¢ If the Play Again button on the Standard Toolbar of the Sequence Editor were hit quickly two times
in succession, an error message box would appear.

¢ If the "turn a channel on and off" feature of the VU Wizard were used on only part of a musical
sequence, it would correctly turn the channel on and off in that part, but would additionally turn
everything in the channel past that part off.

¢ In certain situations, when scrolling through tracks in the Sequence Editor, the track bar for some
tracks would not be displayed, and instead part of the previously displayed channel grid would be
displayed where the track bar should have been.

¢ |f certain Light-O-Rama entries in the Windows registry were mistakenly deleted (for example, by a
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third-party registry cleaning program), and a musical sequence were modified and saved, the name
of the sequence's media file would not be saved along with it, and you would be unable to modify
the sequence again to tell it the name of the media file. This effectively means that the musical
sequence would be "transformed" into an animation sequence. This no longer occurs. Note,
though, that Light-O-Rama still might not be able to play the sequence, as those registry entries
tell it where to look for media files. But after the issue with registry is corrected, Light-O-Rama will
now play those musical sequences as normal.

¢ |f a sequence had a channel that was set up to be a Light-O-Rama controller, but did not have its
unit ID set, that sequence would not play in the Show Player.

* Removing a channel that was in more than one track from a track would not cause the sequence
to be marked as having unsaved changes.

* If paste by cell is enabled, and effect events copied from a larger cell are pasted to a smaller cell,
those events are "shrunk" to fit into the smaller cell. If such an event had to be shrunk to less
than a centisecond in length, pasting would fail, giving an error message "Start time cannot be
less than end time". Now, events shrunk to less than a centisecond are simply skipped when
pasting.

e When creating an SD card for an MP3 Director, a valid COM port is no longer required.

e Some machines were having problems downloading standalone sequences to controllers. The
reliability of downloading has now been improved.

* When setting a unit ID via the Hardware Utility, the dropdown boxes allowing you to select a unit
1D only show unit IDs from 01 up to the unit ID specified in the Hardware Utility's "Max Unit ID"
setting. Previously, though, changing "Max Unit ID" would not change the values listed in the
dropdown boxes, until the Hardware Utility was closed and then restarted. Now, the new values
will be available immediately, without needing to close and restart.

What's New in Version 2.0.16

The following changes were made for Light-O-Rama version 2.0.16:

e Simple Show Builder updated
* Bug fixes

Simple Show Builder Updated

Previous releases of Light-O-Rama version 2 included the same Simple Show Builder as was used in
Light-O-Rama version 1. It therefore could not be used with sequences that were created using the
version 2 Sequence Editor.

Simple Show Builder has now been updated so that it can be used with sequences that were
created using either version 1 or version 2.

Bug Fixes
This release fixes the following issues:

¢ Various tools such as the Beat Wizard, VU Wizard, and Waveform Display had problems with
certain audio files, resulting in an error message saying "Can' init conversion" appearing, after
which these tools would be unusable with those files. This release fixes this issue (at least in the
known situations that it happened in).

¢ The Beat Wizard would crash when used with certain audio files on some customers' machines.

e |f either "Close All Files" or "Close All Files Except This" was used, and one of the sequences
being closed had its Animator window open, an error message would pop up saying "Error
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Loading Animation Form".

What's New in Version 2.0.14

The following changes were made for Light-O-Rama version 2.0.14:

New play ranges

Freeform play mode

Space Bar to play; enter to apply tool
Subdividing cells

Skewing tracks

Wawveform height

Wawveform display modes

Wavweform colors

Bug fixes

New Play Ranges

Two new play ranges have been added to the Sequence Editor: "From Selection” plays from the start
of the selection to the end of the sequence, and "To Selection" plays from the start of the sequence
to the end of the selection.

Freeform Play Mode

You can now use the keyboard to select an arbitrary time range for future playing. Please see
"Freeform Play Mode" for details.

Space Bar To Play; Enter To Apply Tool

In the Sequence Editor, the space bar can now be used to start a sequence playing, and then to
stop it. If a freeform play range has been selected, that range will be played; otherwise, play will be
in "from selection” mode - that is, it will start at the start of the current selection, and go until the end
of the sequence. This can be used to effectively pause and unpause play.

In previous versions of Light-O-Rama, the space bar was used to apply the current effect tool to the
selected cells. That is now done using the enter key instead.

Subdividing Cells

The Sequence Editor can now subdivide the selected cell or cells into a new number of cells (which
you select). Each cell is subdivided into the specified number of cells, and all of the new cells within
any particular old cell will be of the same length (or as close to the same length as possible).

For example, if you select two cells, the first from 3 seconds to 7 seconds, and the second from 7
seconds to 7.5 seconds, and ask the Sequence Editor to subdivide them into two cells each, you
will wind up with four cells: From 3 to 5, from 5 to 7, from 7 to 7.25, and from 7.25 to 7.5.

This can be done via "Subdivide Timings" on the Timings submenu of the Edit menu, or via
"Subdivide Timings" on the right-click context menu.

Skewing Tracks
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The Edit menu of the Sequence Editor now has a new menu item, "Skew Track". This lets you move
all of a track's events, timings, and loops by a specified amount of time, either to the left (i.e. earlier
in time) or to the right (i.e. later in time).

Waveform Height

In previous versions of Light-O-Rama, the waveform of a musical sequence was either displayed or
not. Now, ifit is displayed, it can be displayed at two different heights: full height and half height.
Full height is the same as the height that was used in previous versions of Light-O-Rama.

Half height and full height (and "off") can be selected from the Wave Form submenu of the View
menu.

Waveform Display Modes

The waveform of a musical sequence can now be displayed in three different ways: "full mode",
showing zero wlume at the center and loud wlumes above and below it; "fold mode", showing zero
at the bottom and folding the two halves of full mode onto the top; "top mode”, showing zero at the
bottom and the top half of full mode abowe it. "Full mode" is the same as the way the waveform was
always displayed in previous versions of Light-O-Rama.

To set the display mode, right-click on the waveform, and select the desired mode from the listed
choices in the popup menu.

Waveform Colors

The colors used to display the waveform of a musical sequence are now configurable. To choose
new colors, right-click on the waveform, and select "Change Colors" from the popup menu.

Bug Fixes

This release fixes the following issues:

¢ In the Channel Property Grid, if a channel was set up with a device type but no unit number and/or
circuit number, it might later be displayed (in both the Channel Property Grid and the Channel
Settings dialog) as if it had a unit number and/or circuit number set (although it still did not).

e When printing from the Channel Property Grid, unit numbers of some Light-O-Rama controllers
would be mislabelled, as would device types of certain non-Light-O-Rama controllers.

* If a sequence was changed, but not yet saved, and "Revert to Saved" was selected from the File
menu, the sequence would be properly reloaded, but could not be played again until it was closed
and reopened.

e Seweral dialog windows had a problem where, if the dialog was closed by hitting the enter key
rather than by clicking the OK button, changes to the last field modified might not be acted upon.

e |f a channel was in two or more tracks, and had a shimmer effect, the effect would not be
displayed properly in the Animator.

* If a sequence was playing in the Sequence Editor, and some other sequence was not playing but
had its Animator open, clicking on that Animator's play button would set off a string of errors.
Now, instead, it simply does not start play (while the other sequence is playing).

¢ A problem with undoing and redoing changes in sequences with loops was fixed.

e Highlight Current Event on the Play menu is supposed to control whether or not the current event
is displayed with a thick border (as if it were the selection) during play. It did so, but it also
mistakenly controlled whether the selection was displayed or not while play was not happening.

e |f a musical sequence's media file did not hawe its "Ready for Archiving" flag turned on (in the file's
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properties in Windows Explorer), the Sequence Editor would not play the sequence, complaining
that the media file could not be found.

e [f the Sequence Editor played a musical sequence at quarter, half, double or quadruple speed, and
the directory its media file was in contained a period in its name, sometimes the wrong media file
would be played.

What's New in Version 2.0.12

This release fixes the following issues:

¢ A show would pause indefinitely if the Show Player was asked to play a musical sequence whose
media file was missing.

¢ Musical sequences played during the startup and shutdown sections of a show would control the
lights, but would not play audio.

e Commands for X10 channels were often getting lost.

What's New in Version 2.0.8

This release contains the following bug fixes:

¢ The Tapper Wizard's dropdown list allowing you to select the track to use did not work properly,
leading to the taps being put into whatever track had been selected at the time that the Tapper
Wizard was opened, rather than into the one that was selected in the list.

e The VU Wizard's option to operate on only a portion of the song, as opposed to the entire song,
did not work properly.

¢ Importing channel configuration into a sequence did not mark that sequence as having unsaved
changes.

e Communication with the controllers is kept alive during the loading of sequences. This is to fix an
issue where, after the loading of a large sequence, the PC would have to resynchronize with the
controllers due to communication having been paused. This resynchronization could have taken
some time, causing strange effects immediately after synchronization.

e |f an error occurs while communicating with the controllers, Light-O-Rama tries to reestablish
communications, in the hopes that the error was merely a temporary glitch. However, for certain
types of errors, it would not try to do so, leading to the communications being permanently down.

What's New in Version 2.0.4

Version 2.0.4 fixes a bug where X10 channels were not being controlled during shows.

What's New in Version 2.0.0

The following new features, changes, and fixes have been made for Light-O-Rama version 2.0.0:

Tracks

Sequence-in-sequence play
Background and foreground effects
Universal undo and redo

Channel positioning

Mouse scroll wheel support

Pasting timings between sequences

Video playback
Intensity and fade presets
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The Beat Wizard

The VU Wizard

Recording of individual instruments in the MIDI Wizard
Multiple Light-O-Rama networks

More media support

Animator background image

The Channel Property Grid

Pasting effects: by time or by cell

Holiday Lights Designer support

XML sequence files

Microsoft Windows Vista support

Animator window CPU usage decreased

Animator's maximum rows and columns increased
Sequence Editor's keyboard support improved

New look for the shimmer effect

Channel settings form directly accessible via the channel's button
Bug fixes and internal improvements

Tracks

Previously, a sequence was composed of channels, loops, and timings. Now, instead, a sequence
is composed of tracks. Tracks, in turn, have channels, loops, and timings.

Two tracks in the same sequence can have different channels, or they can share channels with each
other. They hawve different sets of loops and timings than each other. In an animation sequence,
tracks can be of different lengths than each other.

¥ Bushes. las

Track 1: Tenth Second Timings -
390

Time Scale ||||||||1|'=]rTI|||||||2|'m-TI|||||||

Bushes [Green §§ §§ 3%
Bushes (Red §§% §§g §

1| | »
Track 2: Half Second Timings
Time Scale ||||||||1|'=]I{I|||||||:|Z'I]I{I|||||||$'I][|I|||||||i|1'u[|lll
Buzhes [Green) §
Bushes (Red] S

1

Two tracks, with the same channels, in one sequence
A brief example of how this may be useful:

In a musical sequence, you may want to have some timings representing a bass drum, other timings
representing a guitar, and yet another representing something totally unrelated to the song. Before
tracks, in Light-O-Rama version 1, you could add all of these timings to your sequence, but it might
be difficult to remember, while building the sequence, which timings were for which purpose. The
more unrelated timings that you added to the sequence, the more confusing the sequence as a
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whole would become.

Now in Light-O-Rama version 2, instead, you can build a single sequence with multiple separate
tracks, each with only one of those sets of timings, making each set of timings cleaner and simpler
to understand. Plus, you can share channels between two or more tracks, have different channels
in different tracks, or both.

Sequences are initially created with a single track. Another track can be added via the Edit menu's
"Add New Track" or "Duplicate Track" items (the latter of which will share all channels in the current
track with the new track), or via new items on the channel buttons' popup menus ("Copy to New
Track" and "Mowve to New Track").

To share an individual channel between multiple tracks, do not simply set two different channels to
use the same unit number, circuit number, et cetera, as this will likely have unexpected and
undesired results. Instead, use the "Copy to New Track" or "Copy to Track Number ..." function on
the channel's popup menu:

Bughes |lareem)
Bushes [Rer"
Change Mame
II:l_ Change Colar
Change Channel Settings

Ve Sigels |2|'m{l| N |E|“'-"{I
Insert Channel Above

second Timings

Buzhes [Gree

Insert Channel Below §

Bushes [Rer  Insert Multiple Channels Abave % 3%
Insert Multiple Channels Below

Delete Channel

Remowe Channel from Track

Copy ko Wew Track,
Copy bo Track Murnber ...

Share a channel with another track by copying it to the other track

If a sequence has more than one track, the tracks are separated in the display by a track bar,
labelled (for example) "Track 1" or "Track 2". If the track has been given a name, it will also be
displayed here (for example, "Track 2: Front Yard Mini-trees"). Clicking on this bar gives a popup
menu containing various track-related items:
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" -

U 2trlas [E=H =<2

Time Scale Change Track Mame

Bushes [Green] Mowve Track Up

Buzhes [Red) Move Track Down

ﬂ_l Inzert Track Above

Track 2 Snowman
I1 _|]|]I Insert Track Below

Time Scale

Showman [Eves) Duplicate Track

S howrnan [Pipe) Change Total Time

4 | Delete Track

Hide Track

Click on atrack bar for various track-related menu items

Sequence-in-Sequence Play

A channel in a sequence can now be set to represent another sequence (rather than representing a
physical circuit), known as a "subsequence"”. This is done in the Channel Settings dialog, by
changing the "Device Type" to "Sequence” (rather than to "Light-O-Rama Controller”, "Digital 10
Card", or so forth), and choosing the filename of the sequence in the "Sequence" box:

¥ Channel Settings

Mame |Bushes Animation
Color I
Device Type
| [
| [
| [
Seguence  [Busheslas [

aF. Cancel |

Channel settings for sequence-in-sequence play

A subsequence will play only when the channel that it is a subsequence of is turned on, and will
continue playing as long as the channel is on. If the channel is turned off and then turned back on,
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the subsequence will start over from its beginning.
TIP: Don't try to control the same physical circuit with both a channel in a subsequence and a

channel in the main sequence. Doing so will probably cause unexpected results, as the two
channels will vie for control of the circuit.

Background and Foreground Effects

Turning on background effects or foreground effects in the Sequence Editor will affect the behavior of
tools (such as "Fade Up", "Twinkle", "Set Intensity", et cetera) in the following manner:

If "Background Effects" has been turned on, the tool only applies to those selected cells that are
completely off (that is, at intensity zero for their entire duration).

If "Foreground Effects" has been turned on, the tool only applies to those selected cells that are not
completely off.

Some examples:

¥ (new sequence 2)*
Time Scale ||||||||1|'I'-"{IIIII||I

Channel 1

Channel 2
Channel 3

Channel 4

Before abackground fade up

¥ (new sequence 2)* |:||E [E|
1.00 2.I]I|]

Time Scale

Channel 1
Channel 2

Channel 3
Channel 4

After abackground fade up
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¥ (new sequence 2)*

Time Scale

1.00
!

Channel 1
Channel 2

Channel 3

Channel 4

Before aforeground fade up

¥ (new sequence 2)* =l
Time Scale 1.00 :.“]'.]

Channel 1

Channel 2

Channel 3

Channel 4

After aforeground fade up

Universal Undo and Redo

The Sequence Editor's undo and redo used to only work for the effect tools (such as "on", "off", "fade
up", "twinkle", and so forth). You can now undo and redo a much wider variety of things - adding

channels, moving timings, changing loops, drawing in the Animator, and many others.

¥ Light-0-Rama Sequence Editor v2.0.0
File Mau(® vieww Tools Play  Window Help
[l IUndo Delete Channel Chrl+2 H

Al

ok el

Examples blf things that can be undone and redone

Channel Positioning

Channels can now be moved up and down in the Sequence Editor. There are two ways to do this:
First, the channel buttons' right-click popup menu now includes "Mowve Up" and "Move Down", which
will move the channel by one spot. Second, a channel button can now be mouse dragged to a new
position.

Mouse Scroll Wheel Support

The mouse scroll wheel now works in the Sequence Editor. Scrolling with the wheel causes the
displayed channels in the active sequence to scroll.
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Pasting Timings between Sequences

Previously, timing ranges copied from a sequence could only be pasted into that same sequence.
Now, a timing range copied from one sequence can be pasted into a different sequence.

Video Playback

The Show Player and the Sequence Editor can now use video files (in addition to the previously
available audio files) to create sequences. The video output can be displayed during play.

In the Sequence Editor's Edit/Preferences menu, there is now a new item called "Video
Preferences”, which gives control over how video files will be used (both in the Sequence Editor and
during scheduled shows):

Q Video Preferences ﬂ

play Yide

[ Dizplay fudio Yizsualizations
[+ Use Full Screen tode

r I1ze Audio Track Only When Sequencing
With Video Media

Select Full Screen Monitor |

ok Cancel |

Edit/Video Preferences

These options can also be temporarily changed in the Sequence Editor via the View/Video menu.
Howewer, changes made this way will only affect the Sequence Editor (not the Show Player), and will
only last during the current use of the Sequence Editor - that is, the next time that the Sequence
Editor is started, the video preferences as set in "Edit/Preferences/Video Preferences will be used
again).

¥ Light-0-Rama Sequence Editor v2.0.0

File Edit BUEES Tools Play Window Help

D |@|I=_J v Channel Buttons u ME@J

v Time Scale
Alm|% | B E| )

Animation

':||'||'|I-'-I | 15

Show gudio Yisualizations

Time 5o -

Eull Screen
Sequence Info
Track Info

Intensity and Fade Presets

View/Video

© 2015 Light-O-Rama, Inc.



140

Light-O-Rama v4.3.4

The Sequence Editor's Set Intensity, Fade Up and Fade Down tools now have ten preset values (or

ranges). The old "Tool Options" dialog was replaced with the Fade Tool Settings and Intensity Tool

Settings dialogs to set these presets:

¥ Intensity Tool

Intenszity

Fade Down PPPOPROPBPO®
Fade Settings, with fade up 50-75% and fade down 100-0% selected

The Sequence Editor comes with default preset values (such as 10%, 20%, and so forth) build in; if
you want to change any of the presets, you can do so by clicking the settings tool's "EDIT" button:

¥ Intensity Options |E|

|ntenzity Settings
Seftingl |10 percent
Setting2 [20  percent
Setting 3 F percent
Setting 4 Iﬁ percent
Sething 5 Iﬁ percent
Seftingf |50 percent
Setting? |70 percent
Setting 5 W percent
Setting 9 W percent
Setting 10 (o0 percent
Rewvert | Cancel | Accept

Changing an intensity preset to 37%
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¥ Intensity Tool

The preset has now been changed to 37%

The values of the presets for both intensities and fades can also automatically be set using Load
Intensities and Fades from Current Sequence, of the Tools menu. This will figure out the most
commonly used percentages for both intensities and fades existing in the current sequence, and set
the preset values to them.

The Beat Wizard

The Sequence Editor's new Beat Wizard can be used to automatically analyze a song to try to
determine its beat, and to populate a musical sequence with timings or effects based upon that beat.
The Beat Wizard can be found in the Sequence Editor's Tools menu. It is also available as one of
the options for creating a new musical sequence, and for creating a new track.

© 2015 Light-O-Rama, Inc.



142

Light-O-Rama v4.3.4

¥ Beat Wizard

— Time Range

% The entire zong [0:00.00 to 4:47.90)
£ Just part of the song:

Erom: [r:00.00 To: [4:47.40 Update |

Light-0-F ama thinks thiz zong has about 177 beatz per minute in this time range.

— Tempo
' |se the detected tempo [177 beats per minute]
 Usze a fazter related bempo:

|21 Faster (354 BPM) =]

7 Use a slower related tempa:

IE:.: Slower (B8 BPM) ;I with beat offzet: ID vI
— Preview

Start | [ I: I: [~ I: I: I: [Time: 0:00.00 / 4:47.90

&

—'hat Ta Do with Beats

IJzing this track: ITTE"Ek 1 j

And theze timings:l ® [nnamed timing grid] j

Or add a new tirming grid: Mew Fived Grid | Mew Freeform Grid |

¥ |nzert a timing into the timing gnd far each beat
[~ Tum on a channel exvery =0 many beats:

ILlnit .1 j thiz many beats: |4 with beat offzet; ||:|

[T Snhap effects ta timings within |4 bundredths of a second

Apply and E it | Apply | E xit | | ue] | Hedo |

The Beat Wizard

The VU Wizard

The Sequence Editor's new VU Wizard is a VU meter-like tool that can be used to automatically
populate a musical sequence based upon peaks in the audio. The VU Wizard can be found in the
Sequence Editor's Tools menu, and is also available as one of the options for creating a new musical

sequence, and for creating a new track.
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VU Wizard 126
Time Range

f# The entire sang [0:00.00 ta 5:32.38]
(" Jugt part of the sohog;

From: [o-oo.on Tor [B:32.88 _ Update |

Attack and Decay

Attack: ill d
ac : ER. 2 millseconds Update
Decay: millizeconds g

B2
Frezets: YU Meter | F'ealrillF'mgrgm Peak Meter ‘
eter
Peal: Threzhold Time O 54%
& Total | |
= Left |
" Right |
Presiew

Start |Time: 0:00.00 / 6:32.88

YWhat Ta Do with Peaks
IJzing this track: |Tra|:k 1 ﬂ
&nd these timings: | * [Unnamed timing grid) ﬂ

Or add a new timing grid: Mew Fived Grid Mew Freeform Grid |

[+ Inzert a timing into the track whenever the peak threshold is crossed
| Turn a channel on when above the threshaold, and off when below:

|Unit 07 1 |

B |4_ hundredths of a second

Apply and E sit | Apply | E xit | | |

The VU Wizard

Recording of Individual Instruments in the MIDI Wizard

The MIDI Wizard can now automatically create lighting effects for a musical sequence based on the
notes played by individual instruments in a MIDI file.
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* MIDI Wizard X
Flayback Caontral
RECORD ‘ CAVE ‘ 1. Chooge which instrument pou wish ta record, -
Flay | 2. Chooge how many channelz you wish to uze. For each
|0:00/1.02 channel zelected, one note will be recorded. The notes
| ¥ | | RECORDING CLEAR that will be recorded are marked ' they are the most

Effects Summalyl Warious Effects  Individual Motes ]

Chanrnel Selection

24 channels are reguired for the
zelected effect.

Instrument: |ﬁcoustic e ﬂ Number of Channels: |24 channels j

[v Minimur On Centizeconds: |3 Avaiable Channels

[~ Map Unselected Motes by Octave |Unit 4
pddone | [F
Motes To Record Channels To Record
CCDDHE F Fit G GEA AHB Selected Channels
Octave A [T TTTTTTTTT HEEEEEEEEEEEE 071 - Unit 02.4 »

Botsved [ ([ % | HEEEEENEEENE | 02-Unies
Octsve 1 [ VOO VROSOOOR | | | | | | | | | | ||| | |%unoz
Octsve 2 SRRSO OOROTOOEO | | [|  [ | [[[ | oelunkoos
ctave 3 N8| RO | [ | | | | [ | |l | foumord
getave [ [ [ | CECCCCCCEe || fo-unon
et o O e A RV
e O o A e
etave? [T | e || | unons
etave 8 [T ([T 111 | [ || 2wz
Qetave [T [T EEREREEE 13-Unito1 8

14 - Unit 01.3
15 - Unit 01.10 b

Remove One Clear

The MIDI Wizard's can automatically create lighting effects based on the notes played in a MIDI file
Multiple Light-O-Rama Networks

Previously, only a single COM port could be used for Light-O-Rama controllers. Now, up to four
Light-O-Rama networks can be used simultaneously on the same computer, on different COM ports.

The same unit and circuit number can be used on multiple networks simultaneously and
independently, with different effects happening on the different networks.
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¥ Channel Settings [$__<|
Marne |Ehannel 2
Colar I
Device Type |Light-D-Hama Contraller j
Metwork | Regular j
Lnit
CircLit A C

k. Cancel |

Up to four different networks can be used for LOR controllers

More Media Support

Various new media file types (including Windows Media Files and certain types of videos) are now
supported for musical sequences.
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Open Media File

-

by Recent
Documents

@
Desktop

s,

kdy Documents

by Computer

o
8

-
i

by M etwark,
Places

Look, i | = Media

7

=~ & Eef E-
i fising.aif &) Aisling.rmi
B bisling. aifc B aisling. snd
B bisling. aiff Aisling . way
B hisling. asf E| Aislirg . wrn
B fisling. au s Aisling . wma
|| dislirg. avi || Asislirg v
|| &isling. iy
B disling. mid
| Aisling. midi
|| &isling. mp2
o Aisling.mp3
|| &isling. mpa
|| &isling. mpe
|| &isling.mpeg
|| &isling. mpg
File name: | ﬂ Open |
Files of bpe: |l Supparted Files -l Cancel

Various supported mediatypes

Animator Background Image

A sequence's animation can now be set up to have a background image, such as a picture of a

house on which Christmas lights are to be placed.
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® Animation for. (new sequence 4}

4| »[m|

Size

Zoom {0

Background Image

Select
Remove

[ Simulate night time

The Animator, with abackground image
The Channel Property Grid

The Sequence Editor's new Channel Property Grid is a window showing information about all of the
channels in a sequence (their color, device type, unit number, et cetera), and allowing changes to

those properties in a (hopefully) convenient manner. This can be accessed via the Sequence
Editor's Tools menu.

© 2015 Light-O-Rama, Inc.




148 Light-O-Rama v4.3.4

Q Channel Configuration ﬂ
Track: |Track 1 j
Name Color  Device Type Metwork Unit Cicut Sequence
[Front Bushes [Green) L | [GantO-Rama Contrclh v | [Regular [l 1
[Front Bushes [Red] I [Light-0-Rama Contoll | [Regular [m 2
[windows _ | [GahtO-Rama Contral v | [Regular [m 3
[Bumblebee Animation I [Cight-0-Rama Contralh + | [Regular [l |4
|Sn0wman [Main) 4 |Light-D-Hama Controllnﬂ |F|egular |D1 |5
[Snawman (ms Up) | [Gaht0-Rama Contral v | [Reqular [m B
[Snowman [&ms Down] | [GahtO-Rama Contralh v | [Reqular [ |7

|Sn0wman [Camcob Pipe) I |Light-D-H anma Controlluﬂ |F|egular
|Sn0wman [Button Moze] | | |Light-D-H A& Controlluﬂ |F|egular

[on
o

[ Ix | |x [x [x |x |x |x |x [x |x |x

Lo Led L fLefLed e d L Lef Lo Le f e L f e fhe ] Lo Lo
Lo Led L fLefLed e d L Lef Lo Le f e L f e fhe ] Lo Lo
Ll Led LefLefLed e d L L f Lo Le f e Laf e fhe ] Lo Lo

[Srowman [Coal Eye #1) | [Light-0-Rama Conbioll ~ | [Regular [m [10
[Snowman [Coal Eve #2] | [Cight-0-Rama Contoll | [Reguiar o [11
[Snowman (01 Silk Hat) L | [Cigrt0-Rama Contioh = [Regular [ [12
[Front Trees [Red] I [Light-0-Rama Contoll | [Regular o [13
X[ [Front Trees (Blue) I [Uight-0-Rama Contralh v | [Reqular [m 14
[Front Trees [¥ellow) | [GahtO-Rama Contral + | [Reqular [l |15
%] [Side Bushes | [Cight-0-Rama Contoll | [Reguiar o |18
it | Add Controller | T Controller| Delets Eontroller| Add Charnels | oK | e

The Channel Property Grid
Pasting Effects: By Time or By Cell
When pasting effects in the Sequence Editor, you can now choose to insert the events into the

destination based upon either the length of the copied events or else the relative lengths of the
copied and destination cells.

For example, consider timings at 0 seconds, 1 second, and 2 seconds. Between 0 and 1 is a fade
up, and between 1 and 2 is a fade down:

¥ (new sequence 5)*

1.0

.00 2.00
Ly o

Time Scale

Channel 1

Even?é to b'encopied

These events will be copied, and pasted to the time starting at 5 seconds. There are timings at 5
seconds, 7 seconds, and 7.5 seconds:

¥ (new sequence 5)*
Time Scale 5.00 EIFI][II

7.00
TP L

Channel 1

Where they will be pasted to

If "Paste by Cell" is selected, then there will be a fade up from 5 to 7, and a fade down from 7 to 7.5
(this is the same way that pasting always behaved in version 1 of Light-O-Rama):
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¥ (new sequence 5)*

Tirne Scale 5.00 ||5=][|| ?I'[I[II

Frgprrrrrnriai | I T Y A I | [ Y I |

After pasting by cell

If "Paste by Time" is selected, then there will be a fade up from 5 to 6, and a fade down from 6 to 7.
The timings at 7 and 7.5 are ignored; only the original lengths of the events are used:

¥ (new sequence 5)*

Time Scale 5.00 Eliﬂ[|| i:'l]l{l

Channel 1

After pasting by time

You can switch between these two modes by selecting "Set Paste Mode" in the Sequence Editor's
Edit menu.

Holiday Lights Designer ™ Support

Light-O-Rama can now interact with Holiday Lights Designer™, a third-party application by
Holidaysoft®.

Holiday Lights Designer™ can be used to virtually place lights and decorations on images of your
home or business, and Light-O-Rama can now send Holiday Lights Designer™ commands during
play to make those virtual lights behave as your real lights would during a show.

To send commands to Holiday Lights Designer™, first set the Holiday Lights Designer Preferences
in the Sequence Editor under the Edit menu. After this is done, commands can be sent from the
Sequence Editor by turning on "Control Holiday Lights Designer" in the Play menu, or from the Show
Player by selecting "Holiday Lights Designer On" in the Light-O-Rama Control Panel.

Version 4.0 or above of Holiday Lights Designer™ is required to take advantage of Light-O-Rama
interaction.

For more information about Holiday Lights Designer™, please see the Holidaysoft website.

XML Sequence Files

Sequence files (and channel configuration files) are now saved as XML files. LOR 2 understands
both these new sequence files and the old LOR 1 style sequence files.

If an LOR 1 file is modified and saved by LOR 2, it is automatically updated to the new LOR 2 style.
This means that LOR 1 will no longer understand the updated file. Howewer, to be safe, a copy of the
original LOR 1 sawe file is automatically created, and labelled as an LOR 1 file. For example, if the
LOR 1 sequence file "lights.las" is converted to an LOR 2 file, then a copy of the original LOR 1 file
will be created, named "lights.las.vl.bak".

Microsoft Windows Vista Support
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Various changes were made to better support Light-O-Rama on the Microsoft Windows Vista
operating system.

Animator Window CPU Usage Decreased

The Sequence Editor's Animator window now uses significantly less CPU during play than it used to.

Animator's Maximum Rows and Columns Increased

The Animator window now supports up to two hundred rows and columns:

¥ Animation for (new sequence 5)

| »(m|

Size
Rows 200
Columns {200

Update

Zoom  Lcora e

| T
Drrawing

Chanrel 2 j
" Eraze

" Wiew

Background Image

Select
_ e |

-

Animation with 200 rows and 200 columns

Sequence Editor's Keyboard Support Improved

Several changes were made to make using the keyboard easier in the Sequence Editor. For
example:

e The "enter" key now chooses the "OK" button on most forms;
e The "escape" key now chooses the "Cancel" button on most forms;
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e The "tab" key circulates between controls in a more sane order;

e Many Alt-key shortcuts were added to various forms;

e The various menus were reorganized so as to cause less conflict among their various items'
shortcut hotkeys.

New Look for the Shimmer Effect

The shimmer effect is now drawn (in the Sequence Editor) using diagonal lines, instead of the
previous \ertical lines. This will hopefully make them stand out more against the background of
vertical lines which represent timings.

Note that this change is simply for display of the sequence in the Sequence Editor; the actual
appearance of the shimmer effect on controlled lights is unaffected by this.

Some channels with shimmer effects

Channel Settings Form Directly Accessible viathe Channel's Button

In the Sequence Editor, left-clicking and right-clicking on a channel button used to both bring up a
context menu of channel-related functions (such as adding, deleting, and moving channels). Right-
clicking still does that, but left-clicking now brings up the channel's settings form instead:

_ Channel Settings x|
Narne |Unit 0711
oo I |
Device Type |Light-I:I-F| ama Controller j
Network | Reqular ﬂ
Lrut ||:|-| j

Circuit | 1 j
SeguUEnCE | J

Advanced Settings |

] Cancel |

The Channel Settings form

Bug Fixes and Internal Improvements

Seweral bug fixes have been made, including but not limited to the following:
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If a show includes a musical cleanup sequence, it is supposed to be played after each song.
Instead, it was being played only at the end of the show, just before the first shutdown
sequence.

Some musical sequences, when played in the Sequence Editor, would reach the end of their
audio file, but would not cause the Sequence Editor to exit from play mode.

Certain audio files would not play their audio.

The Sequence Editor incorrectly determined the total length of certain audio files.

When a musical sequence was played in the Sequence Editor using the "Visible Screen" play
range, the display would sometimes jump to an adjacent portion of the sequence, rather than
remaining on the initially visible portion of the sequence.

Attempting to delete the first timing in a sequence (at time zero) would cause the Sequence
Editor to crash.

Attempting to resize multiple timings (simultaneously) using the Sequence Editor's "Resize
Timings to ..." function (on the right-click popup menu) would cause the Sequence Editor to
crash if the sequence happened to be more than 5:27.67 long.

When the Sequence Editor displayed fades using gradual changes in colors (as opposed to
when it displayed them using ramps), it would sometimes draw the end of a fade event past
where it should have been.

The Tapper Wizard's option to not use a countdown before the song begins did not work.
When a sequence was playing at a speed other than the normal speed (for example, through
the "Play Speed" menu item in the Sequence Editor, or due to a loop that was set up to
increase or decrease speed each time through), if a fade up or a fade down was done, the
lights would not properly take the speed of the sequence into account when determining how
quickly to fade. For example, a fade up from 0 to 100% that normally takes one second,
played at half speed, should fade up from 0 to 100% in two seconds. Instead, it would fade up
from 0 to 100% in the first second, and then remain at 100% for the entire second second.
When the Cleanup or Delay portion of a show was modified in the Show Editor, the Sawe
button would not become enabled.

The Sequence Editor's audio waveform display (and its positioning line) did not exactly match
up with the time of the rest of the display. This was especially noticeable at very high zoom
lewels.

When moving a timing in a sequence by clicking and dragging it in the Sequence Editor,
sometimes the timing before the selected one would be mowed.

When a musical sequence was opened in the Sequence Editor, and the "View Wawe Form by
Default" option was selected, if the sequence's audio file no longer existed (or otherwise could
not be opened), the Sequence Editor would crash.

If a musical sequence was played in the Sequence Editor, and the sequence's audio file no
longer existed (or otherwise could not be opened), nothing would appear to happen. The
Sequence Editor now instead shows an error message box describing the problem.

Various internal improvements have been made as well.

What's New in Version 1.5.0

The following new features, changes, and fixes have been made for Light-O-Rama version 1.5.0:

e Tapper Wizard Behavior Change

e Channel Deletion Fix

e Channel Button Feedback during Loops Fixed

e Animator Fix

Tapper Wizard Behavior Change
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When the Tapper Wizard's "toggle" and "snap to existing events" options are used together, both the
beginning time and the end time of each toggle are snapped to existing events. This causes the
combination to behawe in a way that is probably more similar to what most people would expect.

Channel Deletion Fix

Various problems occurred when the last channel in a sequence was deleted. These have been
fixed.

Channel Button Feedback during Loops Fixed

When the Sequence Editor was used to play a sequence with a loop, and the end of the loop was
reached, just before going back to the beginning of the loop, the channel buttons' color displays
would sometimes briefly act upon the event just after the loop. This has been fixed. Note that it did
not affect the actual display of lights; it only affected the display within the Sequence Editor itself.

Animator Fix

If the Animator was sized so that scroll bars were necessary, the "draw" and "erase" functions would
act upon the wrong cells. This has been fixed.

What's New in Version 1.4.0

Time Scale

Copy and Paste Timings

Animation Saved in Channel Configuration Export
Right-Click in Animator Now Erases

Duration in Status Bar

Play Again

Seweral Zoom Improvements

Delete Selected Events

Animator Efficiency

Manual Stop Stays in Position

Program's Main Window Remembers Its Position
Bug Fixes and Internal Improvements

Time Scale

In the Sequence Editor, at the top of each sequence, a time scale is optionally displayed. Also,
during play, the button to the left of this scale now displays the current time offset.

Whether the time scale is displayed or not for any particular sequence can be controlled via the View
menu, or via a button on the toolbar. It can be turned on or off by default using the Display
Preferences dialog on the Edit menu.

Copy and Paste Timings

In the Sequence Editor, you can now copy and paste timings - that is, make new cells having the
same duration and relative positions as some existing timings.

To copy a set of timings, select the range of cells that you want to copy, and then copy them in one
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of three ways:

¢ Select "Copy Timing" from the Edit menu;
* Select "Copy Timing" from the right-click context menu;
* Using the keyboard, hold the "Shift" key and simultaneously hit the "Delete" (or "Del") key.

Once these timings are copied, you can paste them in one of several ways:

¢ Via the right-click context menu:

e "Paste timing at (the centisecond that was right-clicked)";

e "Paste timing at ...", which brings up a dialog box asking the centisecond to paste to
(defaulting to the centisecond that was right-clicked");

e "Paste timing multiple", which is similar, but also asks how many times you would like to
paste the timings consecutively, or if you wish to keep pasting them all the way to the end
of the file.

* Via the Edit menu, using "Paste Timing". This is the same as the right-click menu's "Paste
timing multiple", except that the starting centisecond defaults to the start of the current
selection, rather than the right-clicked centisecond.

e Using the keyboard, hold the "Shift" key and simultaneously hit the "Insert" (or "Ins") key.
This is the same as "Paste Timing" from the Edit menu.

Animation Saved in Channel Configuration Export

When a sequence's channel configuration is saved (using "Export Channel Configuration” from the
Edit menu of the Sequence Editor), the sequence's animation is saved along with it. When the
channel configuration is later imported into another sequence (using "Import Channel Configuration”
from the same menu), the user is given the option to import the animation as well.

Right-Click in Animator Now Erases
The right mouse button can now be used to erase cells in the Animator.
Duration in Status Bar

The status bar along the bottom of the Sequence Editor now shows not only the total time and
selected time range, but also the duration of the selected time range.

Play Again

You can now tell the Sequence Editor to "play again”. This causes it to play the last thing that you
asked it to play, regardless of the current play settings. For example, if you choose a certain time
range, with the play range set to "Selection"”, the Sequence Editor will play that selection. After play
ends, you may fix some problem that you noticed, which causes the selected time range to change.
If you wanted to play the same time range again, previously, you would have to re-select that time
range. Now, you can instead simply hit "Play Again".

There are two ways to do this: Via the "Play Again" item of the Play menu, and via a new toolbar
button.

Several Zoom Improvements

Seweral zoom improvements have been made in the Sequence Editor:
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e The "Zoom In" and "Zoom Out" buttons on the toolbar have been replaced by individual buttons
for "Zoom Channels In", "Zoom Channels Out", "Zoom Time In", and "Zoom Time Out".

e Preferred zoom settings can now be saved or restored via the Zoom Preferences dialog on the
Edit menu. The saved zoom preferences are used by default when opening or creating new
sequences.

¢ Keyboard shortcuts now exist to zoom in various directions: Alt-Up and Alt-Down to zoom
channels in and out, and Alt-Left and Alt-Right to zoom time in and out. Also, Alt-Page-Up
and Alt-Page-Down to go to the minimum or maximum channel zoom settings, and Alt-Home
and Alt-End for the minimum and maximum time zoom settings.

Delete Selected Timings

In the Sequence Editor, several timings can now be deleted at once, by selecting a range of timings
and choosing "Delete Selected Timings" from the right-click context menu.

Animator Efficiency

The Animator has been made more efficient, using less CPU during play. This improves the
jerkiness that was seen on some machines during play while the Animator window was open.

Manual Stop Stays in Position

When you manually stop play of a sequence (as opposed to letting it stop by reaching its natural
end), the Sequence Editor now continues to display the screen that was being displayed when play
was stopped.

Program's Main Window Remembers Its Position

When you start the Sequence Editor, its main window is now opened in the same position that it
was in the last time it was closed.

Bug Fixes, Internal Improvements

Seweral bug fixes and internal improvements have been made.

3 Feature Comparison

The Light-O-Rama software package must be registered, with a valid license, in order to be used to its
full potential. Each license contains two separate types of license levels: the main license level and the
SuperStar license level.

The main license lewvel cowers all of the Light-O-Rama software package except for the Light-O-Rama
SuperStar Sequencer. Sewveral different main license levels exist, each having different features: Basic,
Basic Plus, Standard, Advanced, and Pro. Additionally, there is an unlicensed Demo version (which is
the same as the Basic version, except that it cannot be used to actually control lights, and has
encrypted sawe files).

The SuperStar license level covers the Light-O-Rama SuperStar Sequencer. Its possible levels have
names such as 2_CCR, 24 _CCR, 60_CCR, and the like, indicating the number of Cosmic Color Ribbons
you can use with SuperStar. Additionally, there is an unlicensed Demo version which does not allow
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export to an actual sequence.

Any reference in this help file to a "license level" or "feature level" refers to the main license level, not to
the SuperStar license lewel, unless specifically noted otherwise.

You will be given a chance to register your Light-O-Rama software at the time that you install it. To
register after that time, or to upgrade to a higher level license, please see the "Register Light-O-
Rama" (or "Upgrade Light-O-Rama") menu item on the Sequence Editor's Help menu, or on the Control
Panel's popup menu.

The following chart summarizes what features are available with each license level, with detail on each
coming after the chart.

If a feature is listed as "(demo mode)", it means that the feature can be used with this license to see
what it's like, but it won't be fully supported. For example, if you try one of the Sequence Editor's demo

mode features while building a sequence, you won't be able to save your changes to that sequence.
Please see the details for each feature for exactly what "demo mode" means for that feature.

Any features not listed here are available with all license levels.

FEATURE DEMO BASIC BASIC PLUS |[STANDA| ADVAN| PRO
RD CED
Number of LOR 0 > 4 8 UNLIMIT|UNLIMIT
Units Supported ED ED
Number of Tracks 2 2 2 4 UNLIMIT|UNLIMIT
Supported ED ED
Full Access XML No YES YES YES | YES | YEs
Data Storage
Beat Wizard (demo mode) (demo mode) YES YES YES YES
VU Wizard (demo mode) (demo mode) YES YES YES YES
Video Playback
(Windowed No No YES YES YES YES
Mode)
Show On No No YES YES | YES | YES
Demand
Schedule Shows
Based on Day of | (demo mode) (demo mode) YES YES YES YES
Year
Startup
Seguencesin (demo mode) (demo mode) (demo mode) YES YES YES
Shows
Shutdown
Seguencesin (demo mode) (demo mode) (demo mode) YES YES YES
Shows
Background
Seguencesin (demo mode) (demo mode) (demo mode) YES YES YES
Shows
Sequence in (demo mode) (demo mode) (demo mode) (demo YES YES
Seguence mode)
MIDI Wizard (demo mode) (demo mode) (demo mode) fﬁgg‘eo) YES YES
l';_;;gﬁ (demo mode) (demo mode) (demo mode) fﬁig‘; YES YES
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FEATURE DEMO BASIC BASIC PLUS [STANDA| ADVAN| PRO
RD CED
Sequences
Show Startup No No No No | YES | YES
Options
Execute Windows|
Shell Commands No No No No YES YES
Full Screen Video No No No No YES YES
Playback
Multiple Networks| No No No No YES YES
Create Protected No No No No YES YES
Sequences
DMX Intensity No No No No YES YES
Native DMX
Devices No No No No YES YES
Supported
Dasher
Controllers No No No No YES YES
Supported
X10 Controllers No No No No | YES | YES
Supported
Digital 10 Cards No No No No | YES | YES
Supported
BSOFT Digital 10 No No No No | YES | YES
Cards Supported
Pixel Editor (demo mode) (demo mode) (demo mode) (demo | (demo YES
mode) | mode)
Intensity Files
and Enhanced No No No No No YES
Networks

Number of LOR Units Supported

Except for the Advanced and higher license lewvels (which support an unlimited number of Light-O-
Rama controllers), each license level will send lighting commands to a limited number of Light-O-
Rama controllers: Basic supports a single controller, Basic Plus supports four, and Standard
supports eight.

Whether a particular controller is supported or not depends on its unit ID. For example, the Basic
license level will send lighting commands only to unit ID numbers 1 and 2, while the Standard
license level will send lighting commands to any unit that has a unit ID between 1 and 8.

Regardless of whether a particular unit will be sent lighting commands, you can always use the
Sequence Editor to build sequences using that unit; Light-O-Rama simply will not control the lights
for that unit unless you upgrade to a higher license leel.

The unlicensed Demo version will not send lighting commands to any controllers, so you cannot use
it to actually control your lights.

Number of Tracks Supported

A sequence may have multiple tracks; however, certain license levels will only support a limited
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number of tracks in any given sequence. The Demo, Basic, and Basic Plus lewvels support two
tracks per sequence, Standard supports four, and Advanced and higher support an unlimited number
of tracks per sequence.

You will not be able to add new tracks to a sequence if it already has the maximum supported
number. Howewer, you can still open sequences that have more tracks (for example, a sequence
that was created by someone who has a higher license level than you do). In this case, the extra
tracks will be displayed in the Sequence Editor, but you will not be able to modify them, and any
lighting effects in those tracks' channels will not actually control your lights during play.

Full Access XML Data Storage

When a sequence is saved using a licensed version of Light-O-Rama, its save file uses a standard
XML format, which is designed to be understandable by people. Technically advanced users may
feel comfortable editing these XML-based sequence files directly with a text editor, or even building
their own tools that can be used with these files (although please be careful when doing so, as it is
not terribly difficult to make a small mistake which may render the sequence file incomprehensible to
the Light-O-Rama software package).

On the other hand, when a sequence is saved using the unlicensed Demo \ersion, it is saved
encrypted, and so the file itself cannot be easily understood or modified by anyone or anything
except the Light-O-Rama software package. Additionally, data from an encrypted sequence cannot
be copied and pasted, except on the computer that the sequence was originally encrypted on.

No matter whether a sequence is saved using the open XML format or using encryption, the Light-O-
Rama software itself will still be able to use it.

If you create an encrypted sequence using the unlicensed Demo version, and later purchase a
license, you can unencrypt the sequence by resaving it on the same computer it was originally
encrypted on, using your licensed version of the software.

Beat Wizard

The Beat Wizard can be used to analyze a song to try to determine its tempo, and to automatically
place timings and lighting effects into a sequence based upon that tempo. It is fully supported in
license lewvels Basic Plus and higher.

It is not supported in license level Basic (nor in the unlicensed Demo version). However, you can still
try it out in a "demo mode" to see what it is like; after trying it on a sequence, you will not be able to
save your changes. You will be given a warning about this when you try it, along with a chance to
back out before committing to using it. Additionally, if you do decide to use it, and your sequence
already has unsaved changes, you will be given a chance to save them before you actually use this
feature.

VU Wizard

The VU Wizard can be used to analyze a song to find peaks in the audio - much like a VU meter -
and to automatically place timings and lighting effects into a sequence based upon those peaks. It
is fully supported in license lewvels Basic Plus and higher.

It is not supported in license level Basic (nor in the unlicensed Demo version). However, you can still
try it out in a "demo mode" to see what it is like; after trying it on a sequence, you will not be able to
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sawe your changes. You will be given a warning about this when you try it, along with a chance to
back out before committing to using it. Additionally, if you do decide to use it, and your sequence
already has unsaved changes, you will be given a chance to save them before you actually use this
feature.

Video Playback (Windowed Mode)

You can build musical sequences based on audio files (such as MP3) or on video files (such as
WMV). When a musical sequence is played, the sound will always play, but the actual video (or
audio visualization) will only be displayed for license levels Basic Plus and higher. License level
Basic will not display video (or audio visualization).

Additionally, your license level may or may not support video playback in full screen mode; see "Full
Screen Video Playback" for details.

Show On Demand

Using license level Basic Plus or above, you can cause a show to be played without having
scheduled it. This is done via the "Show On Demand" menu item of the Light-O-Rama Control
Panel's popup menu.

Schedule Shows Based on Day of Year

The Light-O-Rama Schedule Editor can be used to schedule shows to play in two different ways: by
the day of the week (such as "from 6:00 PM to 9:00 PM on Friday") or by the day of the year (such
as "from 9:00 AM to 9:00 PM on December 25th").

Howewer, scheduling based on the day of the year is fully supported only in license levels Basic
Plus, Standard, and Advanced.

Using the Basic license level, you will still be able to use the Schedule Editor based on the day of
the year in a sort of "demo mode" to see what it is like, but the Light-O-Rama Show Player will not
actually play shows that are scheduled this way - it will only play shows that were scheduled by the
day of the week.

Startup Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections. Among
these is the Startup Section. Sequences in the Startup Section are played immediately upon the
show starting up, one at a time, in order. After all of them have been played, the main portion of the
show (i.e. the Animation Section and the Musical Section) begins.

Howe\er, this section is fully supported only with the Standard or higher license lewels.

Using the Basic and Basic Plus license lewels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like. Howewer, the Light-O-Rama Show Player will
not actually play the sequences in a show's Startup section; instead, the show will simply begin play
directly with the Animation Section and the Musical Section.

Shutdown Sequences in Shows
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The Light-O-Rama Show Editor can be used to build shows with several different sections. Among
these is the Shutdown Section. When the scheduled end time for the show is reached, the main
portion of the show (the Animation Section and the Musical Section) stops, and the sequences in
the Shutdown Section are then played, one at a time, in order. After they hawe all finished, the show
is truly finished.

Howe\er, this section is fully supported only with the Standard or higher license lewels.

Using the Basic and Basic Plus license lewels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like. Howewer, the Light-O-Rama Show Player will
not actually play the sequences in a show's Shutdown section; instead, when the scheduled end
time for the show is reached, the Animation Section and the Musical section will stop, and the show
will be ower.

Background Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections. Among
these is the Background Section. All sequences in the Background Section will play
simultaneously, looping back to their starts when they reach their ends, throughout the entire course
of the show.

Howe\er, this section is fully supported only with the Standard or higher license lewels.

Using the Basic and Basic Plus license lewels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like. However, the Light-O-Rama Show Player will
not actually play the sequences in a show's Background Section.

Sequence in Sequence

Sequences can themselves contain subsequences - a parent sequence containing a child sequence.
The parent sequence can be set to start or stop the child sequence at any given point during play.

Howewer, subsequences are only fully supported with the Advanced license level or higher.
Using other license lewels, you will still be able to use subsequences in a sort of "demo mode", to

see what they are like, but you will not be able to save changes to your sequence after having done
Sso.

MIDI Wizard

The MIDI Wizard can be used to automatically insert timings and lighting effects into a musical
seqguence that is based upon a MIDI song. For example, it can make your lights chase each other
in time to the music, or turn certain channels on or off based upon what notes are being played.

Howewer, the MIDI Wizard is fully supported only with the Advanced license level or higher.

Using other license levels, you will still be able to use the MIDI Wizard in a sort of "demo mode", to
see what it is like, but you will not be able to save changes to your sequence after having done so.

Execute Windows Shell Commands

Using the Advanced license lewel or higher, Light-O-Rama can optionally tell Windows to execute
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any arbitrary command that you specify when a particular sequence is started. An example of how
this might be used: If you broadcast the songs playing during your show ower the radio, you might
set your sequences up so that they tell Windows to tell your RDS ("Radio Data System") program to
also broadcast the name of the song, allowing people with RDS-enabled radios to see the name of
the song currently playing in your show.

Triggered Interactive Sequences

In addition to being able to control lights, some Light-O-Rama controllers can also accept input,
acting as triggers to start particular sequences on demand during a show. For example, as part of
your display, you could have several buttons for people to push, each of which will play a particular
song.

Howe\er, this feature is fully supported only with the Advanced license lewvel.

Using other license lewels, you will still be able to use this section in the Show Editor in a sort of
"demo mode", to see what it is like. However, the Light-O-Rama Show Player will not actually play
any sequences which are triggered during your show.

Show Startup Options

Normally, the sequences in a show will start playing immediately at the show's scheduled start time.
The Advanced license level or higher allows more control over this; for example, you could hook a
big red button labeled "Start the Show" up to one of your Light-O-Rama controllers, and the show will
not start until that button is pushed.

For details, please see "Show Startup Options".

Full Screen Video Playback

When a musical sequence is based upon a video file (such as a WMV file), the Advanced license
level or highercan show the video in full screen mode (and similarly, it can show full screen audio
visualizations for musical sequences based upon audio files).

Lower license levels cannot show full screen video (or full screen audio visualizations), but they may
still be able to show video and visualizations in a window instead of in full screen. See Video
Playback (Windowed Mode) for details.

Multiple Networks

The Light-O-Rama Software Package can send lighting commands to Light-O-Rama controllers over
seweral different Comm ports simultaneously. This has several potential uses, especially for people
with large numbers of controllers, or lights spread out physically far from each other.

Howe\er, this is supported only in the Advanced license lewel or higher. Other license lewvels will
send lighting commands to Light-O-Rama controllers only over a single Comm port.

Create Protected Sequences

The Light-O-Rama Sequence Editor can be used to create protected sequences, which are
sequences which cannot be modified (generally speaking) or viewed in the Sequence Editor, but
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which can still be played, control lights, scheduled in shows, and so forth.

Howe\er, this is supported only in the Advanced license lewvel or higher. Other license levels can use
protected sequences, but cannot create them.

DMX Intensity

Light-O-Rama allows the possible intensity of most lighting effects ranges from 0 to 100, i.e. a
percentage of full intensity. DMX devices, however, are capable of taking 256 different intensities
(from O to 255), rather than 101. Light-O-Rama supports this possibility via the DMX Intensity tool.

However, this is only supported in the Advanced license leve or higherl. Other license levels will not
have access to the DMX Intensity tool.

Native DMX Devices Supported

The Advanced license lewel or higher can send lighting commands to DMX devices, in addition to
Light-O-Rama controllers. Lower license lewvels can only send lighting commands to Light-O-Rama
controllers.

Dasher Controllers Supported

The Advanced license level or higher can send lighting commands to Dasher controllers, in addition
to Light-O-Rama controllers. Lower license lewvels can only send lighting commands to Light-O-
Rama controllers.

X10 Controllers Supported

The Advanced license lewel or higher can send lighting commands to X10 controllers, in addition to
Light-O-Rama controllers. Lower license lewvels can only send lighting commands to Light-O-Rama
controllers.

Digital 10 Cards Supported

The Advanced license lewel or higher can send lighting commands to digital 10 cards, in addition to
Light-O-Rama controllers. Lower license lewvels can only send lighting commands to Light-O-Rama
controllers.

BSOFT Digital 10 Cards Supported

The Advanced license level can send lighting commands to BSOFT digital 10 cards, in addition to
Light-O-Rama controllers. Lower license lewvels can only send lighting commands to Light-O-Rama
controllers.

Pixel Editor

The Light-O-Rama Pixel Editor can be fully used only with the Pro license level. Lower license levels
can use the Pixel Editor in a sort of demo mode, but will be unable to use it to create intensity files,
which are needed to actually control your lights based on your work in the Pixel Editor.
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Intensity Files and Enhanced Networks

The Pro license level can use intensity files and enhanced LOR networks. These can help with
displays inwlving very large numbers of independent lighting elements. Lower license lewvels cannot
use these features.

4 Light-O-Rama Concepts

Light-O-Rama allows your computer to control your lights and other equipment in synchronized displays.
Such a display is organized in a few levels:

At the lowest lewel, a sequence contains commands to be sent to your Light-O-Rama hardware, which
will actually control your lights. For example, a sequence might contain a command to turn on one
string of lights while making another string twinkle, and two seconds later, fading the first string down
while fading the second string up. A sequence can contain commands for many circuits.

Sequence

A sequence contains commands for individual strings of lights

Typically, people build a sequence per song that they want in their display (known as musical
sequences), each one containing all of the lighting commands for its particular song. People also build
animation sequences, not associated with any particular song, and often build one for each independent
part of their display - for example, one animation sequence to control a group of snowmen having a
snowball fight, and another to control a tin soldier firing a cannon.

Sequences can be grouped together into shows. A show allows several sequences to be played at the
same time, or sequentially, or in random order. A show can contain different sections - for example,
some sequences might be played only at the beginning of a show, others only at the end, others in
between, and still others for the entire duration of the show.
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4.1

Sequence Sequence Sequence

A show contains sequences to be played together, or in order, or randomly
Finally, shows can be scheduled to be played at certain times. Only one show (at most) can be playing

at any given time, but any number of shows can be scheduled for different times, and the same show
can be scheduled to play at many different times.

N

A schedule is used to play shows at specific times

Sequences

A sequence is a set of commands to be sent to lights - for example, a sequence may command the
lights to turn on when the sequence starts, turn off a second later, stay off for a tenth of a second, start
twinkling for the next two seconds, and then fade up, from completely off to completely on, during the
next three seconds.

A sequence can control multiple sets of lights independently of each other. Each set of lights should be
hooked up to a particular circuit on a particular controller; each such circuit is referred to as a "channel”.
Additionally, for RGB devices, capable of changing color, three independent channels (a red, a green
and a blue) can be grouped together into a single RGB channel.

There are two types of sequences: animation sequences and musical sequences. Musical sequences
are associated with songs (or sound effects, videos, et cetera); the lights can be made to turn off and on
(and do other effects) in sync with the music. Animation sequences are not associated with songs.
Many sequences can be played simultaneously, but at most one musical sequence can be playing at a
time - all others must be animation sequences. This means that you can control some of your lights in
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sync to a song via a musical sequence, while simultaneously controlling other lights independently, via
animation sequences.

The Light-O-Rama Sequence Editor is used to create and modify sequences. After creating sequences
with the Sequence Editor, you can package sequences together into a show, using the Show Editor, and
then schedule shows to be played at certain times using the Schedule Editor. The Show Player (if Player (if
enabled, via the "Enable Schedule" on the Light-O-Rama C Control Panel) will i ) will monitor your schedule and
play your shows at the appropriate times.

For example, here is a simple sequence, containing six channels, as represented in the Sequence
Editor. As time passes (from left to right), you can see that the first channel is turned on, then it is
turned off and the second channel is turned on, then that is turned off and the third channel is turned on,
and so forth, through the six channels:

¥ Light-0-Rama Sequence Editor v2.2.5 Advanced

File Edit Yew Tools Play ‘Window Help

D|@|ﬂ|ﬂ| ﬁ,|%|l| ale| BlaBm@ = | &)l pp =)

Time Scale

Uit 1.1

Uit 07.2

Urit 01.3

Urit 01.4

Urit 0.5

Urit 0.6

lTulal Time: 300 | Selected Time: 0.00 - 0.50 | Selected Duration: 0.50 | Select . A
A simple sequence, with lights turning on and off, chasing through six channels

The vertical lines in the grid, representing distinct points in time, are known as timings. These timings
do not have any direct effect on how your lights will look; instead, they allow you to select time ranges
for lighting effects to happen, using various tools in the Sequence Editor.

Timings are grouped together into timing grids. A sequence can have more than one timing grid; which
one is currently displayed can be controlled via the "Timings" dropdown box in the Tracks and Timings
toolbar. For example, the timing grid currently displayed in the sequence shown abowve has a timing
every half a second, and is shown in the dropdown box as "Fixed Grid: 0.50". "Fixed Grid" in this means
that the timings are all a certain length of time apart, and that they cannot be mowed, deleted, or added
to; "0.50" is that length of time (in this case, half a second).
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In addition to "fixed" timing grids, a sequence can also have "freeform" timing grids. In a freeform timing
grid, timings can be at any location, and can be moved, added, and deleted. For example, here is the
same sequence, but now with a freeform timing grid displayed:

* Light-0-Rama Sequence Editor v2.2.5 Advanced

File Edit Yew Tools Play ‘Window Help

D|@|ﬂ|ﬂ| §%|%|B| alco| Elal_l_l__l ol 4| b Dy

Time Scale

Uit 01.1

Uit 07.2

Urit 01.3

Urit 014

Urit 01.5

Urit 0.5

lTulal Time: 300 | Selected Time: 0.00- 0.70 | Selected Duration: 0.70 | Select . A
The same sequence, with afreeform timing grid

Note that the timings in this freeform grid are not the same distance from each other. Also note that the
timings and the effects do not line up with each other - there is no reason that they would have to. This
is so as to allow flexibility in where effects can be applied, without cluttering the display with many
timings.

For example, perhaps you might want a sequence to have some effects that are following the drumming
in a song, and other effects that are following the lead guitar. You could simply add timings representing
both the drumming and the guitar to a single timing grid, but if you do, it could be difficult to remember
which timing is for which instrument; also, the display might become cluttered with so many timings.
So, instead, you could put the timings for the drums into one timing grid, and the timings for the guitar in
another timing grid, and use the dropdown box to easily switch between the two timing grids as
appropriate. The effects that you add using the timing grid for the drums will not necessarily line up with
the timing grid for the guitar, nor the effects added using the timing grid for the guitar with the timing grid
for the drums, but neither should they.

A sequence can contain multiple tracks. A track is a group of channels. Each track can have its own
channels, or can share channels with other tracks, or both. Each track can be switched to display any
particular timing grid at any time, independently of every other track.

Animation sequences (but not musical sequences) can be set up to use loops. When playing a
sequence that contains a loop, when the end of the loop is reached, the sequence will jump back to the
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beginning of the loop. It will do this a certain number of times (that you specify), and then will continue
past the end of the loop. Each time that it jumps back, you can make it go through the loop faster,
slower, or the same speed as before. There can be many loops in a sequence (set up for different time
ranges), and loops can even contain other loops.

Each sequence can have an animation associated with it. This lets you draw how your lights will be laid
out. When you play a sequence in the Sequence Editor and display its animation, the drawing will
behawe just like your lights will - your drawing will turn on and off, fade up and down, and so forth.

A sequence can also contain another sequence as a subsequence. The subsequence can be turned on
or off at different points in the main sequence, and its effects will play only when it is turned on.

For more detailed information on sequences, please refer to the following sections:

e The Sequence Editor
e Animation Sequences
e Musical Sequences

e Tracks

e Channels

¢ RGB Channels

.
-
o

}%
n

e Animations

* Subsequences
¢ Windows Shell Commands

4.1.1 Animation Sequences

An animation sequence is a sequence that is not associated with a song (or video, or other audio file).
This is as opposed to a musical sequence.

There are some other differences between animation sequences and musical sequences:

¢ Animation sequences can contain loops, which musical sequences cannot;

e Tracks in an animation sequence can be of different lengths, while tracks in a musical sequence
must be the same length;

e Various song-related tools such as the Beat Wizard, MIDI Wizard, VU Wizard and Tapper Wizard
are only available for musical sequences.

e Generally speaking, only one musical sequence can be played at a time (although there is an
exception to this, described in the help page on musical sequences), whereas many animation
sequences can be played simultaneously.

To create an animation sequence in the Sequence Editor, use the New Animation dialog.
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o Mew Animation Options @

o iz the authar of ||
thiz new animation’?

How marny channels should thiz |E
ahirnation uge?

[vw Automatically zet up channels to use standard LOR controllers

Haow |ong should this animation be? |-| 0000

Haw much time should be in between timingz
{+ A tenth of a second
" Half a second

" A gecond
" Some other value: 010

" Don't add any imingz
[v Use a fiwed timing grid

[v Uszeloops.

[ Save these choices as defaults.

[ Don't azk me thiz again.

k. Caricel

The New Animation dialog

4.1.2 Musical Sequences

A musical sequence is a sequence that is associated with a song (or video, or other audio file), allowing
you to synchronize the song with lighting effects. This is as opposed to an animation sequence.

There are some other differences between animation sequences and musical sequences:

¢ Animation sequences can contain loops, which musical sequences cannot;

e Tracks in an animation sequence can be of different lengths, while tracks in a musical sequence
must be the same length;

e Various song-related tools such as the Beat Wizard, MIDI Wizard, VU Wizard and Tapper Wizard
are only available for musical sequences.

¢ Generally speaking, only one musical sequence can be played at a time (although there is an
exception to this, noted below), whereas many animation sequences can be played
simultaneously.

The exception to the rule that "only one musical sequence can be played at a time" is that musical
sequences put into any section of a show other than the musical section are, effectively, treated as
animation sequences. That is, their associated songs will not be played, and more than one of them can
be played simultaneously.
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To create a new musical sequence in the Sequence Editor, use the New Musical Sequence dialog.

" )

o Mew Musical Sequence Options @

Author of this new "
gequence [optional]

Kahmba.mp3

Atizt |tr. Seff
Title |.alimba
Album Mirja Tuna

[ Usze LOR [nternal Media Format [fikes most playback, izzuesz with media)

Channel Setup

- Select channel count - can Mumber of channels used |5
be changed later [v Using standard LOR controllers

Ilze a zaved channel
i ! .
configuration template | J

Initial Timing

Usze a'wizard to create timings Uze equally zpaced timings
- “Wizards can be uzed later -- Fised arids must be set now
" " & tenth of & second
" Use the Tapper \Wizard " Half a second
* Usze the Beat ‘Wizard " & second
7 Usze the VU ‘Wizard " Same other value:
" Don't add any hmings |D'1 0
v

| Save az defaults.

0K Cancel

[ Don't ask me thiz again.

The New Musical Sequence dialog

41.3 Channels

A channel is a part of a sequence, representing a particular circuit on a particular controller, which you
hawve lights hooked up to. The Sequence Editor can be used to assign effects to channels, to make the
lights turn on and off, fade, shimmer, twinkle, and so forth.

Channels hawe several properties that define exactly which string of lights they relate to:

* Device type, which is the type of controller (for example, a Light-O-Rama controller or an X10
controller);

¢ Network, which is the COM port that this channel's controller is hooked up to the PC ower;

e Unit, which is the unit ID of the controller, allowing different controllers to be distinguished from
each other;

e Circuit, which represents one particular string of lights hooked up to the controller.
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Not all device types hawe all of these properties - for example, X10 controllers have a unit ID, but no
circuit number. Please see the help pages on the various types of controllers for details.

Additionally, there is a "special" device type: a subsequence. A channel set up with this device type
does not represent a strand of lights. Instead, it represents another sequence, that the main sequence
can turn on and off at different points in time.

Channels also have names and colors associated with them. These have no effect on the way that your
lights will look; they only effect how the sequence is displayed in the Sequence Editor. It could be
conwvenient to set them up in meaningful ways. For example, you might want to name the channel
associated with a string of red lights running through the bushes in your front yard as "Front Bushes
(Red)", and set its color to some shade of red.

In the Sequence Editor, channels are represented as horizontal rows. On the left side of a row is a
channel button, labelled with the name of the channel; on the right side is a grid showing what effects are
assigned to the channel at what times. For example, the following sequence has six channels, and they
are named, simply, "Channel 1" through "Channel 6". One of them ("Channel 4") has an effect: a fade
up, from zero seconds to one second:

¥ (new sequence 1)* M=11E3
Time Scale 1.00 2.00 3.00

Channel 1

Charinel 2
Channel 3
Chatitel 4 -
Chatirel 5
Channel B

4 |

A sequence with six channels - one on each row - and afade up on the fourth channel

To turn a channel on or off at a certain time, or do other effects such as fades or twinkles, select the
effect that you want, and click on the cell or cells for the times that you want that effect to take place.
See Editing Sequences Using the Keyboard and Editing Sequences Using the Mouse for more details on
this.

Between the channel buttons and the grid is a thick grey vertical bar. You can change the size of the
channel buttons by clicking and dragging this bar. Clicking the bar (without dragging) will hide the
channel buttons entirely; clicking it again will make them reappear. You can also control whether
channel buttons are displayed or hidden from the View menu, and from the standard toolbar, and set
your default preference in the Display Preferences menu.

Clicking on a channel's button brings up the Channel Settings dialog. This allows control over various
things like the channel's name, color, unit, and circuit:
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¥ Channel Settings [E|

Mame Frort Bushes [Fed)
Color N
Device Type |Light-D-Hama Contraller j
Metwork Regular |
Uit 03 Bd
Circuit |7 |

| =

ak. Canicel |

The Channel Settings dialog

Right-clicking on a channel's button brings up a popup menu with various channel-related tools:

Change Mame
Change Color
Change Channel Settings
Test Physical Channel ON
Test Physical Channel OFF

Inzert Device »
Inzert Channels »
Inzert RGE Channels »

Convert to RGE Channel
Convert to Group

Duplicate Children to Mew Group
Degroup

Delete Channel

Femove Channel from Track

Copy to Other Track [
Move r

The Channel Button Popup Menu

Channel buttons can be dragged up and down to rearrange their order. This has no effect on your lights;
it only affects the order that they are displayed in the Sequence Editor.
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414

When you play a sequence in the Sequence Editor, its channel button flashes with the color that you
selected as it turns on and off; it will also fade up and down, shimmer, twinkle, and so forth, just as your
lights will. If you do not wish to see the channel buttons change color during play, you can turn it off
temporarily in the Play menu or the standard toolbar, or set your default preference in the Display
Preferences menu.

The Channel Configuration screen can be used to view and change many channels' settings at once:

« Channel Configuration ﬂ
Track: |Track1 j
Name Color  Device Type Metwork Unit Cicut Sequence
[Frert Bushes [Green] L | [Cigr0-Rama Contioh = [Regular [m 1
[Front Bushes [Red] I [Light-0-Rama Contoll | [Regular [m 2
[windows _ | [GahtO-Rama Contral v | [Regular [m 3
[Bumblebee Animation I [Cight-0-Rama Contralh + | [Regular [l |4
|Sn0wman [Main) 4 |Light-D-Hama Controllnﬂ |F|egular |D1 |5
[Snawman (ms Up) | [Gaht0-Rama Contral v | [Reqular [m B
[Snowman [&ms Down] | [GahtO-Rama Contralh v | [Reqular [ |7

|Sn0wman [Camcob Pipe) |Light-D-H anma Controlluﬂ |F|egular
|Sn0wman [Button Moze] | | |Light-D-H A& Controlluﬂ |F|egular

[on
o

[ Ix | |x [x [x |x |x |x |x [x |x |x

Lo Led L fLefLed e d L Lef Lo Le f e L f e fhe ] Lo Lo
Lo Led L fLefLed e d L Lef Lo Le f e L f e fhe ] Lo Lo
Ll Led LefLefLed e d L L f Lo Le f e Laf e fhe ] Lo Lo

[Srowman [Coal Eye #1) | [Light-0-Rama Conbioll ~ | [Regular [m [10
[Snowman [Coal Eve #2] | [Cight-0-Rama Contoll | [Reguiar o [11
[Snowman (01 Silk Hat) L | [Cigrt0-Rama Contioh = [Regular [ [12
[Front Trees [Red] I [Light-0-Rama Contoll | [Regular o [13
X[ [Front Trees (Blue) I [Uight-0-Rama Contralh v | [Reqular [m 14
[Front Trees [¥ellow) | [GahtO-Rama Contral + | [Reqular [l |15
%] [Side Bushes | [Cight-0-Rama Contoll | [Reguiar o |18
it | Add Controller | Ty . | Delets Eontroller| Add Charnels | oK | e |

The Channel Configuration screen, showing several channels simultaneously

A channel can be in a single track, or shared among more than one track. By default, there is one track
in a sequence, and all channels in the sequence are in that track. To share a channel between tracks,
do not simply set up two different channels having the same unit number, circuit number, et cetera in the
two tracks; this will have unexpected and undesired results, as the two different channels will compete
with each other for control of the same circuit. Instead, share a channel by copying it to the other track.
There are several ways to do this; see the help page on tracks for details.

For RGB devices, which can change colors, three separate channels (a red, a green, and a blue) can be
grouped together into a single RGB channel.

For more detailed information on how to create and modify channels in the Sequence Editor, please see:

Channel Buttons

Channel Settings

Channel Buttons' Popup Menu
The Channel Configuration Screen

RGB Channels

An RGB channel is a group of three channels - a red channel, a green channel, and a blue channel -
representing a single pixel on an RGB device (which can change colors), such as a pixel on a Cosmic
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Color Ribbon. In the Sequence Editor, an RGB channel is represented by a black row in a sequence (as
opposed to normal channels, which are represented by grey rows). Lighting effects on an RGB channel
are represented in the row as colors:

Time Scale
it 07.4
rit 07.5
rit 07.65
Urit 07,7

et 01.5

K i

A sequence with an RGB channel followed by several normal channels

To the left of an RGB channel's button is a small button with red, green, and blue stripes. Clicking on
this button will expand the view of the RGB channel so that its constituent red, green, and blue channels
can also be seen (and clicking it again will collapse the view to hide those constituent channels):

Unit 01.4

Urit 1.5
rit 01.5
Uit 01.7
it 01.5

1 »
The same sequence, with the view of the RGB channel expanded so that its constituent channels can be
seen

The RGB channel's lighting effects can be modified by applying tools (such as Shimmer or Toggle or
Fade Up) to its constituent channels, but they can also be modified directly by using the Color Fade tool
on the RGB channel itself. This tool allows you to specify a start color and an end color; when applied to
a time range in the RGB channel, it will cause that time range to gradually fade from the start color to the
end color.

An important thing to note here, though, is that the colors displayed on your screen in the Sequence
Editor are not necessarily the same colors that will appear on your actual RGB device, and in some
cases may actually be very different. Different RGB devices may produce different colors when their
constituent R, G, and B channels are sent the exact same intensities. So, you may have to experiment
a bit to figure out colors as displayed in the Sequence Editor that wind up looking the way you want on
your actual RGB devices.

Another tool which may be particularly useful for RGB channels is the Fill tool, which (on a normal
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channel) allows you to click an empty area and cause it to become a fade from the preceding intensity to
the following intensity. For example, if you have a normal channel which has a fade up from 40 to 60,
followed by the lights being off, followed by a fade down from 80 to 20, then applying the Fill tool to the
area where the lights are off will cause that area to become a fade up from 60 to 80 (because the effect
preceding the empty area ended at intensity 60, and the effect following the empty area started at 80).
On an RGB channel, the Fill tool will instead cause a color fade from the preceding color to the following
color, hopefully allowing you to quickly set up smooth color transitions across several different colors.

The Chase and Repeat tools may also be of particular use on RGB channels. The Chase tool causes
the lighting effects in a single channel (or RGB channel) to be applied through a range of following
channels (or RGB channels), offset in time a bit with each passing row, so that the effect seems to be
"chasing" through the channels (or RGB channels) as time passes. The Repeat tool causes one or
more copies of the lighting effects in your selection to be applied immediately following your selection.

Other tools, such as Shimmer or Toggle or Fade Up, can also be applied to RGB channels. Doing so
will cause the tool to be applied to each of the RGB channel's constituent channels. For example,
applying the Fade Up tool, with intensities 0 to 100, to an RGB channel will cause each of the red,
green, and blue channels to fade up from 0 to 100, thus making the RGB channel itself fade from black
to white.

Such tools can also be directly applied to the constituent channels of an RGB channel (as opposed to
the RGB channel itself), allowing for finer grained control over the behaviour of the RGB channel.

Clicking on an RGB channel's button will open the RGB Channel Settings dialog, allowing control over
various settings such as the units and circuits of the constituent channels:

P )

RGE Channel Settings ==
Hame RGE pl

=

v Automatically link channel zettings

[ Usze LOR legacy mode [maximum circuit number = 16]

Red Green Blue

Device Type |LOR  =||toR  ~<||LloR |
M etwark, |Hegular ﬂ |Hegular J |Hegular J
Ui |01 | |0 || =]
O (R | | -

0k, Cancel

The RGB Channel Settings dialog

Right-clicking on an RGB channel's button will open up a popup menu with various channel and RGB
channel-related tools:
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Time Scale

RGE pl |
RGE pl |1
RGE pl [
Unit 0.4

Unit 01.5
Uit 01.6
Uit 01.7
Unit 01.8

ol

Change Mame

Change Color
Change RGE Channel Settings

Insert Device k
Insert Channels | S S
Insert RGE Channels [

Convert to RGE Channel

Delete RGE Channel —T
Remowve RGEB Channel from Track

Copy to Other Track r

Mowve k

The RGB Channel Button Popup Menu

RGB channels can be added to a sequence in a few ways, all via the Channel/RGB Channel Button
Popup Menu. First, the "Insert Device" menu item has options to insert a Cosmic Color Device or a
generic RGB device, both of which will result in RGB channels being added to the sequence. Second,

the "Insert RGB Channels" menu item will create new RGB channels. Third, existing regular channels

can be converted to RGB channels via the "Convert to RGB Channel" menu item.

4.1.5

Channel Groups

A channel group is a set of channels or RGB channels (or, conceivably, other channel groups) that is
nested together, so that it can be collapsed down to a single row in the sequence's display, or
expanded to show all of its members, or (in some cases) partially expanded to show some of its
members. When a channel group is first created (or when a sequence with one is first opened or
created), the channel group is shown as a single row:

Time Scale

+

Unit 01

Ell

1.00 2.00 3.00
1 ! !

3

An unexpanded channel group

To the left of the channel group's row is a small white button with a "+" sign. Left-clicking on this
expands the channel group to show all of its rows (and the "+" sign changes to a "-" sign):
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Time 5cale RN |1|'I'_"{I

2.00 3.00
RN A A

-l Unit01.1

Uit 07.2

Unit 071.3

Unit 07.4

Unit 01.5

Unit 1.6

Unit 071.7

Unit 07.8

Unit 01.9

Unit 01.10

Unit 07.11

Unit 01.12

Unit 01.13

Uit 01.14

Unit 01.15

Unit 01.16

o | 3
The same channel group, fully expanded

Clicking the small white button again collapses the channel group back to a single row:

[ e B | L T e L e | [ |
mar ||| | | |
1 4

The same channel group, collapsed again.

+

Time Scale 1|P[|I

2.00 3.00
11 11

If you hold the Shift key while clicking, not only the channel group, but also all of its descendants (with
the exception of RGB channel descendants) will be expanded if it is collapsed, and all of its descendants
collapsed if it is expanded. Holding both the Ctrl and Shift keys will cause all of its descendants
(including RGB channels) to be expanded if it is collapsed, and all of its descendants to be collapsed if it
is expanded.

Depending upon how many channels are in the channel group, right-clicking on the small white button
may partially expand the channel group, showing the first and last channels, plus some approximately
equally spaced channels in between:
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Time Scale

1I]I|]

2.00 3.00
TP

=l Unit01.1

Uit 01.6

Unit 07.11

Unit 01.16

1

The same channel group, partially expanded.

Right-clicking on the small white button again may partially expand it further, showing more channels:

Time Scale

1I]I|]

2.00 3.00
P i

=l Unit01.1

Urit 07.3

Unit 01.5

Uit 07.7

Unit 01.10

Unit 01.12

Unit 07.14

Unit 01.16

<

The same channel group, partially expanded further

If you keep right-clicking, eventually the channel group will be fully expanded, after which another right-
click will collapse it back to a single row. Exactly how many right-clicks it takes to go from collapsed to
fully expanded depends upon the number of channels in the channel group.

If you hover your mouse over the button, it will show the name of the channel group it operates on, and
whether clicking on it will cause that group to expand or collapse.

When a channel group is collapsed, the effects displayed on its row are the events of its first channel (or
RGB channel). Howevwer, applying a tool to the row actually applies it to all of its members. For
example, with the channel group compressed, if you apply the Fade Up tool to its first cell, the result will

look like this:

Time Scale

+| Unit M

-

ol |

1.00
!

2.00 3.00
1 ]!

]

The same channel group, collapsed, after applying the Fade Up tool while it was collapsed
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But when you expand the channel group, it becomes apparent that the Fade Up tool was applied to all of
the channel group's members:

Time 5cale RN |1|'["{I

2.00
N R RN

—-| Unit01.1

-
Uit 07.2
Unit 01.3
Unit 07.4
Unit 01.5
Unit 018
Uit 071.7
Unit 07.8
Unit 01.9
Unit 01.10
Uit 01,11
Unit01.12
Unit 01.13
Unit07.14
Unit 01.15
Unit 01.16

o 3

The same channel group, expanded

If you then collapse the channel group, and apply the Chase tool to it while it is collapsed, no change will
be evident from what is displayed:

209

+ it 01 ‘ | |
o | »

After applying the Chase tool, while collapsed

Time Scale -l'I]I{I

2.00
!
|

But a change did happen - the Chase tool was applied to the entire channel group. The only reason that
no change is evident from what is displayed is because when the channel group is collapsed, only the
effects of the first channel are displayed, and the Chase tool did not alter the effects of the first channel.
Expanding the channel group rewveals the change:

© 2015 Light-O-Rama, Inc.



Light-O-Rama Concepts 179

Time Scale §.uq

—| UritotA ‘

Unit 01.2

1.00 2.00
[ O O O O T I

Unit 01.3

Urit 07.4

Uit 01.5

Unit 01.6

Unit 01.7

Unit 01.8

Unit 01.9

Unit 07.10

Unit 07.11

Unit 01.12

Unit 01.13

Unit 07.14

Unit 01.15

Unit 01.16

o | ’

Expanded, after achase

If the channel group is then partially expanded, the chase can be partially seen:

Time Scale o |:|3'I][|I

| O T Y A I |
= Uit 011 ‘

Urit 07,5 “
Urit 07,11 ‘

Unit 01.16

< | )

Partially expanded, after achase

2.00
Ly
|

While it is partially expanded, applying a tool to a single row will apply that tool only to that channel. For
example, if the Shimmer tool is applied to the row for "Unit 01.6", the result will look like this:
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Time Scale 1 |]||]

-| Unitor1 ‘
Urit 01.6 ‘ NN

Urit 07,11 ‘

Unit 01.16

< | ]

After ashimmer is applied to asingle row while partially expanded

Z2.00 3.00
RN N 1y

Expanding the channel group reveals that the shimmer really was applied only to that channel:

Time 5 cale |||||||||'||||||||:|Z'I][|I|||||||3|'I][|I|||||

=l Unit01.1

Unit 07.2

Unit 1.3

Uit 07.4

Unit 01.5

Unit 1.6 w

Uit 071.7

Unit 07.8

Unit 01.9

Unit 01.10

Unit 07.11

Unit 01.12

Unit 01.13

Unit 07.14

Unit 01.15

Urit 0. 16

< | b

Fully expanded, after asingle row shimmer

But if a tool is applied to more than one row while partially expanded, it is actually applied to all channels
from the first selected row to the last, regardless of whether they are explicitly displayed or not. For
example, if (while partially expanded) the Twinkle tool is applied to "Unit 01.6" and "Unit 01.11", the
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result will look like this:

i Sl ||||||||1|'m{||||||||:|2'm{||||||||3|'m{l||||
= Unit01.1
Urit 01.6 ‘ w
rit 01.11 ‘
Urit 01.16
Jd | B

Partially expanded, after atwinkle is applied to multiple rows

But expanding the channel group rewveals that the twinkle was applied not just to Unit 01.6 and Unit
01.11, but also to all channels in between them:

Time Scale 1 I]l{l

~ Unito?A ‘

Unit 01.2

2.00 3.00
P T I

Unit 071.3

Uit 07.4

Unit 01.5

Unit 01.6 N

Uit 01.7

Unit 07.8

Unit 01.9

Unit 01.10

Unit 07.11

Unit01.12

Unit01.13

Unit07.14

Unit 01.15

Unit 01.16

< | ]

Expanded, after atwinkle was applied to multiple rows while partially expanded
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4.1.6

Channel groups can be created via the Insert Device dialog. If the "Add as a Group" checkbox on that
dialog is checked, the device will be added as a channel group; if it is unchecked, the device will be
created as raw channels and/or RGB channels.

You can also conwert existing channels (and RGB channels, etc.) so that they become part of a new
channel group, by using "Conwert to Group" on a channel button's right-click popup menu. You can
"degroup" a group -- that is, mowe its children to its parent, and then remowe it itself from its parent -- by
using "Degroup” on that same popup menu.

Cosmic Color Device Channel Groups

When a Cosmic Color Ribbon (or Bulb) or a Cosmic Color Array is created as a group, and it contains
macro channels, it is treated a little differently than other channel groups. First, those macro channels
will only be displayed when the channel group is fully expanded, and never when it is only partially
expanded. Instead, when it is partially expanded, the last displayed row will be the last RGB channel.
Second, if a tool is applied to the group while collapsed, it is only applied to the group's RGB channels,
not to its macro channels.

Timings

Timings are the times in a sequence at which you can command the lights to do various effects - to turn
on, turn off, fade up, fade down, and so forth.

Timings are represented in the Sequence Editor by ertical grey lines. For example, the following
sequence has timings every half a second, at 0.5 seconds, 1 second, 1.5, 2, 2.5, 3, and so forth:

¥ (new sequence 2)*

Time 5 c:ale RN |1|'I][|I

2.00
R R

Channel 1
Channel 2

Channel 3

Channel 4
Channel &

A sequence with timings every half asecond

Timings do not have any direct effect themselves on the behavior of your lights; rather, they simply give
you a way to specify a start time and an end time for effects on a channel. The space between two
timings can be set to an effect by selecting the appropriate tool (such as the "Fade Up" tool) and clicking
on the space (please see "Editing Sequences Using the Keyboard" and "Editing Sequences Using the
Mouse" for details). For example, selecting the "On" tool and clicking the cell between 1 second and
1.5 seconds for Channel 2 results in:
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¥ (new sequence 4)* |:”E|[zl

Time Scale NEEN |||1'uq

2.00

3.00
RN RN RN

Channel 1

Channel 2
Channel 3

Channel 4
Channel &

1 4

The second channel has been turned on, between 1second and 1.5seconds

Timings do not have to be equally spaced (as they are in the above example). For example, the following
sequence has timings at 0.37 seconds, 1 second, and 3.2 seconds:

¥ (new sequence 3)*

Time Scale 1 uq

. 2.00 3.00 4.00 -
| I T Y A Y Y I | |||||||||||||||||||||||||||||||

Channel 1

Channel 2

Channel 2
Channel 4

K o[

A sequence with timings at 0.37 seconds, 1 second, and 3.2 seconds

Timing Grids

A set of timings is known as a "timing grid". A sequence can have more than one timing grid, with one
being shown at a time (or, if the sequence has more than one track, one per track at a time). The timing
grid that is currently shown can be changed by selecting from the "Timings" dropdown box on the Tracks
and Timings Toolbar. There are two types of timing grids: fixed grids and freeform grids.

Fixed Timing Grids

In a fixed timing grid, each timing is the same length of time from the next timing. For example, a fixed
timing grid might have a timing every second, or every tenth of a second.

The timings in a fixed timing grid cannot be mowed, deleted, or added to.
Freeform Timing Grids

In a freeform timing grid, timings do not have to be equidistant. For example, a freeform timing grid might
have one timing at time 1.00 (i.e. one second), another half a second later at time 1.50, and another 2.2
seconds past that at time 3.70.

The timings in a freeform grid can be mowved or deleted, and new timings can be added.
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Creating, Deleting, and Modifying Timings

Timings can be automatically inserted into a sequence when it is created, in a variety of ways. For
example, you can tell the Sequence Editor to insert timings every so often - for example every half
second, or, for a musical sequence, insert timings based on the song itself using various tools like the
Beat Wizard, VU Wizard, Tapper Wizard, and MIDI Wizard. If you tell it to insert timings every so often

(such as every half second), it will give you the option to create them in a fixed timing grid or a freeform
timing grid; if you tell it to use one of the tools, or not to insert timings, it will use a freeform timing grid.
Please see the New Animation dialog and New Musical Sequence dialog for details.

.

o Mew Musical Sequence Options @

Author af this new "
zequence [optional]

Kalimba.mp3

Atizt |Mr. St
Title |K.alimba
Album Niiia Tuna

| Uze LOR |nternal Media Format [fires most plavback, izzues with media)

Channel Setup

{; Select channel count - can  Mumber of channels used |3
be changed later v zing standard LOR contrallers

Ilze a zaved channel
configuration template | J

Initial Timing

Uze a'wizard to create timings Uze equally spaced timings
- "Wizards can be uzed later -- Fixed gridz must be set niow
lﬁ " & tenth of a second
" sze the T apper Wizard " Half a second
(* |lze the Beat Wizard " A zecond
" ze the WU ‘wizard " Some other value:
(~ Don't add any timings |D'1 L
v

[ Sawve az defaults.

] ] 0K Cancel
[ Don't azk me thiz again.

-

The New Musical Sequence dialog

These tools (such as the Beat Wizard and MIDI Wizard) can also be used after the sequence has been
created, by selecting them from the Tools menu.

Timings in a freeform timing grid can be mowved by clicking and dragging them. Or, if you wish, this
behavior can be turned off by selecting "Lock Timings" in the Edit menu.

Timings can also be added, deleted, and resized in a variety of other ways:
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¢ On the Edit menu:
e Copy and paste timings
¢ Insert multiple timings
e Delete extraneous timings
e Switch timing grid
e On the right-click context menu:
¢ Copy timing
e Paste timing at...
e Paste timing at (centisecond)
e Paste timing multiple
e Insert timing at...
¢ Insert timing at (centisecond)
¢ Insert multiple timings
e Delete timing at...
¢ Delete selected timings
e Resize timings to...
e Resize timings to equal times
e Using the Tracks and Timings toolbar

417 Effects

Light-O-Rama allows you to make your lights behawe in a variety of ways. In addition to simply turning
them on and off, you can turn them on to varying lewels of brightness, have them fade up or down,
shimmer, or twinkle.

You can assign these effects to channels in a sequence using the Sequence Editor. There are various
ways to apply the effects to a sequence; see Editing Sequences Using the Keyboard and Editing
Sequences Using the Mouse for details. One simple way is to select the effect's tool from the Tools
toolbar, and click on a cell or range of cells that you want to apply the effect to.

Most of these effects require that you use Light-O-Rama controllers. Although Light-O-Rama can control
other types of devices (such as X10 controllers or digital 10 cards), only "on" and "off" are supported in
these non-LOR controllers.

e On, Off, and Set Intensity

e Twinkle

e Shimmer

e Fade Up and Fade Down

Custom Fade/Intensity Twinkles and Shimmers

DMX Intensity

Related to effects are the effect editing modes: background effects, foreground effects, and regular
effects. These are not themselves effects, but are ways to use the Sequence Editor to turn effects on
based upon the existing effects. For example, with background effects mode on, if some cells are
selected and the "twinkle" tool is used, only the selected cells that are currently off will be changed to
twinkles. The other cells - those that are on or at some intensity, have fades, shimmers, or twinkles, will
remain unchanged.

On, Off, and Set Intensity

The "On" and "Off" effects will turn a string of your lights to their full brightness or completely off,
respectively. Additionally, the "Set Intensity" effect allows you to specify a percentage of full
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brightness - for example, 50% bright.

In the Sequence Editor, an "on" effect is displayed as a cell having the color that you chose for the
channel, and an "off" effect is displayed as a light grey cell. "Set intensity" is displayed as a color
somewhere in between the two (depending upon the intensity chosen). For example, the following
picture shows a sequence with two channels (one red and one green), each being on for the first half
second, off for the next, then 50% on, then off again, then 20% on, and then off again:

¥ (new sequence 1)*

1.0

Tirme Scale EI
Mirnitree #1 [Red)
Minitree #1 [Green]
L 2

Different levels of intensity

Alternatively, you can choose to have varying intensities displayed not by varying colors, but by filling
in the cells to varying degrees. This is done by selecting "View Fades as Ramps" from the View
menu (or, to make this your default, by setting it in the Display Preferences dialog of the Edit menu).
For example, here is the exact same sequence, but this time with "View Fades as Ramps" turned
on:

¥ (new sequence 1)*

Time Scale

1.00
R N

initree #1 [Red)
kinitree #1 [Green]

Ll

The same sequence, with "View Fades as Ramps" turned on

The brightness used by the "Set Intensity"” tool can be controlled by the Intensity Tool Settings
dialog:

¥ Intensity Tool
Interizity L X
2

1]

|i |i |i {i [+ ¥ K
3
1]

The Intensity Tool Settings dialog, with 70% intensity selected

Any of the ten values listed on the Intensity Tool Settings dialog can be changed, by clicking its
"Edit" button to open the Intensity Tool Options dialog.

In the Tools toolbar, the "On" tool's button shows a green square, the "Off" tool's shows a red
square, and the "Set Intensity” tool's shows three green columns of varying heights. Additionally,
there is a "Toggle" tool, which can be used to turn any cell that is off to on, and any other cell to off.
The "Toggle" tool's button shows two blue squares, one in front of the other. Finally, the Intensity
Tool Settings dialog's button looks like the Set Intensity button, but with a question mark in front of
it:
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@ On

@ Off

al Set Intensity
Toggle

& Intensity Settings

Intensity-related toolbar buttons

"Set Intensity" is only supported on Light-O-Rama controllers. If it is used on a different device type,
any intensity greater than 10% is considered "on", and lesser percentages are considered "off".

Twinkle

The "Twinkle" effect causes your lights to quickly vary between on and off.

The difference between "Twinkle" and "Shimmer" is that twinkle is more random: Two different strings
of lights that are both told to shimmer at the same time will quickly turn off and on in sync with each
other; if they are instead told to twinkle, they will still quickly turn off and on, but not in sync with
each other.

In the Sequence Editor, twinkle is represented with crossed diagonal hatching:

* (new sequence 1)* E|@”E|

Time Scale 1.00 2.00

Minitree #1 [Red] m

Minitree #1 [Green] m
KIN I

Two channels, each with twinkle between 1 and 2 seconds

On the Tools toolbar, the Twinkle tool is represented by a button with stars on it:

|;i| Twinkle

The twinkle toolbar button

Twinkle is only supported on Light-O-Rama controllers. Ifit is used on a different device type, it will
simply turn the lights on to their full brightness.

The Twinkle tool itself twinkles the lights at full intensity. You can also twinkle the lights while fading
up or fading down, or at some intensity other than full intensity, by using a custom tool instead of the
Twinkle tool.

Shimmer
The "Shimmer" effect causes your lights to quickly vary between on and off.

The difference between "Shimmer" and "Twinkle" is that twinkle is more random: Two different strings
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of lights that are both told to shimmer at the same time will quickly turn off and on in sync with each
other; if they are instead told to twinkle, they will still quickly turn off and on, but not in sync with
each other.

In the Sequence Editor, shimmer is represented with diagonal lines:

¥ (new sequence 1)* -
Time Scale 1 I]l{l 2.00

Mirnitree #1 [Red)
Minitree #1 [Green]

Ll 2

Two channels, each with shimmer between 1second and 2 seconds

On the Tools toolbar, the Shimmer tool is represented by a button with waw lines:

|E|Shimmer

The shimmer toolbar button

Shimmer is only supported on Light-O-Rama controllers. If it is used on a different device type, it will
simply turn the lights on to their full brightness.

The Shimmer tool itself shimmers the lights at full intensity. You can also shimmer the lights while
fading up or fading down, or at some intensity other than full intensity, by using a custom tool
instead of the Shimmer tool.

Fade Up and Fade Down

The fade tools will make the brightness of your lights gradually change, either brighter or less bright.
Both the starting brightness and the ending brightness can be specified, anywhere from 0% to
100%, as can the length of time that it takes to fade from one to the other.

In the Sequence Editor, fades are represented by gradually varying colors, between light grey
(representing 0%) and the color that you assigned to the channel (representing 100%). For

example, the following picture shows a sequence with four channels (two red and two green), all
fading over the course of the first second of the sequence. The first channel fades up from 0% to
100%; the second from 25% to 100%; the third fades down from 100% to 0%; the fourth from 100%
to 25%:

¥ (new sequence 2)*

Time Scals
YWindow #1 [Fed]
Window #2 [Fed]

Window #1 [Green]
Window #2 [Green]

1] J

—raf
=
—=
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Four different fades

Alternatively, you can choose to have fades displayed not by varying colors, but by filling in the cells
to varying degrees. This is done by selecting "View Fades as Ramps" from the View menu (or, to

make this your default, by setting it in the Display Preferences dialog of the Edit menu). For
example, here is the exact same sequence, but this time with "View Fades as Ramps" turned on:

¥ (new sequence 2)* |:”E|[zl
1.00 2.00

Time: Scale R R

YWindow #1 [Red]
Window #2 [Red]
Window #1 [Green]
Window #2 [Green]

N J

The same sequence, with "View Fades as Ramps" turned on

The starting and ending brightnesses used by the Fade Up and Fade Down tools can be controlled
via the Fade Tool Settings dialog:

Fade Down Peeoeeeee .
The Fade Tool Settings dialog, with fade up 50%-75% and fade down 100%-0% selected

Any of the ten values on the Fade Tool Settings dialog can be changed, by clicking its "Edit" button
to open up the Fade Tool Options dialog.

On the Tools toolbar, the Fade Up and Fade Down tools are represented as blue up and down arrows
in front of green triangles. The Fade Tool Settings dialog's button looks like that of the Fade Up tool,
but with a question mark in front of it:

| Fade Up
|i2| Fade Down

|fiz| Fade Tool Settings

Fade-related toolbar buttons

Fades are only supported on Light-O-Rama controllers. If one is used on a different device type, it
will simply immediately turn the lights completely on or completely off, based on the ending
brightness of the fade (fades ending at greater than 10% brightness are considered "on", and others
are considered "off").
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Custom Fade/Intensity Twinkles and Shimmers

Only one of the Twinkle, Shimmer, Fade Up, Fade Down, and Set Intensity tools can be selected at
any given time. They can therefore be used, for example, to twinkle the lights, or to fade the lights
up, but not both. However, you can still twinkle the lights while fading them up, in another way: By
using the Custom tool.

On the Tools toolbar, the Custom tool is shown as a large yellow star. To the right of it are five
buttons, which are enabled when the Custom tool is selected (and disabled if any other tool is
selected). These five buttons allow you to select "twinkle" or "shimmer", and "set intensity", "fade
up", or "fade down". Each of these five looks like the corresponding button for the base effect (such

as "twinkle"), with a smaller yellow star in its lower right corner.

For example, to select a tool that will let you twinkle the lights while fading them up, select the
yellow star "Custom" button. The five custom option buttons will then become enabled; select the
"Custom Twinkle" button and the "Custom Fade Up" button.

The regular fade tool settings apply to faded twinkles and shimmers, and the regular set intensity
tool settings apply to set intensity twinkles and shimmers.

If you have an older Light-O-Rama controller, it may need a firmware upgrade before it will be able to
twinkle or shimmer while fading, or at any intensity other than full intensity. If a custom twinkle or
shimmer is sent to such a controller that does not have the appropriate firmware upgrade, it will react
as it would to a "standard" twinkle or shimmer - i.e. it will twinkle or shimmer at full intensity.

K - 13X

Time Scale 1.00 2.00 -
Chaninel 1

A twinkling fade up followed by ashimmering fade down

75 Custom

% Custom Twinkle

i Custom Shimmer

i, Custom Set Intensity
i Custom Fade Up

i Custom Fade Down

Toolbar icons for custom twinkles and shimmers

DMX Intensity

The intensity for most effects - such as fades - can vary between zero and 100. The DMX intensity
effect, howewer, can vary between zero and 255.

This is useful for sending DMX commands to DMX devices Via a Light-O-Rama controller; the DMX
protocol supports intensities from zero to 255, and so this effect allows Light-O-Rama to send any of
the 256 possible DMX intensities to a device, instead of only 101 of them. However, please note that
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not all Light-O-Rama controllers support this functionality; DMX intensity events sent to a controller
that does not support them will simply be ignored. To check whether any particular controller
supports it, please refer to that controller's documentation.

The DMX intensity tool is not enabled in the Sequence Editor by default - that is, by default, the

Sequence Editor will not show a toolbar button for the DMX intensity tool, nor a menu item in the
Tools menu, nor allow a keyboard shortcut for it. To enable these things, make sure that "Allow
DMX Editing" is checked in your DMX Preferences.

#h| DMX Intensity

The DMX Intensity toolbar button

When DMX editing is enabled and the DMX intensity tool is selected, a dialog will appear allowing
you to set the exact DMX intensity that will be used whenever the tool is used on a cell or group of
cells:

5 =

DMX Intensity: 128

} 128
0 16| 32| 48 B4 80 95 | 112 128
144 | 160 | 176 | 192 | 208 | 224 240 | 255 | Edi

The DMX Intensity dialog

The intensity can be set in this dialog in several ways: by moving the slider, by typing in the text
box, by using the up/down buttons next to the text box, or by selecting any of the preset intensity
buttons. Additionally, the values of the preset buttons can be changed by clicking the "Edit" button:

3 =

DM¥ Intensity: 128

J 128 —
0 [16 |32 (48 |54 [s0 (36 [112 [128
144 [160 176 |192 |206 |224 |240 |255 Save

Editing the DMX Intensity dialog's preset intensities

After modifying the preset intensities using these text boxes, click "Sawe" to go back to showing the
buttons instead of the text boxes. Note: When you click "Edit", Light-O-Rama will automatically sort
the values that you entered so that they are displayed from lowest to highest, regardless of the order
that you entered them in. Also, if you enter any particular value more than once, Light-O-Rama will
automatically filter out the duplicates, and replace them with values that are in between those that
you have entered.

The Sequence Editor displays DMX intensity effects using a checkerboard pattern:
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% [new sequence 1)*
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Several channels, each with a DMX intensity of 128 followed by a DMX intensity of 255

Background and Foreground Effects

Background and foreground effects are not themselves effects, but are rather modes of editing effects
in the Sequence Editor. These modes affect the behavior of tools (such as "Twinkle" and "Fade Up")
in the following manner:

If background effects have been turned on, the tool only applies to those selected cells that are
completely off (that is, at intensity zero for their entire duration).

If foreground effects have been turned on, the tool only applies to those selected cells that are not
completely off.

If neither background effects nor foreground effects have been turned on, the tool will apply to all
selected cells. This is referred to as "regular effects”.

Some examples:

¥ (new sequence 2)*

Time Scale

Channel 1

Channel 2
Channel 3

Channel 4

Before abackground fade up
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¥ (new sequence 2)*
1.0

]
[

Time Scale

Channel 1
Channel 2

Channel 3

Channel 4

After abackground fade up

¥ (new sequence 2)*
Tirme Scale

Channel 1

1.
|

Channel 2

Channel 3

Channel 4

Before aforeground fade up

¥ (new sequence 2)*

Time Scale TR

Channel 1
Channel 2

Channel 3

Channel 4

After aforeground fade up

Background and foreground effects can be turned on and off in several ways:

¢ Via the Tools Menu ("Tools/Background Effects" and "Tools/Foreground Effects");
¢ Via the Tools toolbar;
¢ Via the keyboard:
e The "A" key ("bAckground") will cause the next keystroke (and only the next keystroke) to
use background effects mode rather than whatever mode is currently selected,;
e "Shift-A" will cause background effects to be turned on until it is explicitly turned off;
e Similarly, "O" and "Shift-O" (“fOreground") for foreground effects, and "E" and "Shift-
E" ("rEgular") for regular effects (i.e. for turning off both background and foreground effects).

These tools are also available via the effect grid's right-click popup menu, for single-shot use, like the
other tools (for example "on", "twinkle", and "fade up").
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@ Background Effects
Foreground Effects

The background and foreground effects toolbar buttons

418 Loops

An animation sequence (but not a musical sequence) can contain loops. When the Show Player or the
Sequence Editor plays a sequence with loops, when the end of a loop is reached, the sequence will go
back to the beginning of the loop. This will happen a certain number of times (which you specify), after
which the sequence will continue on past the end of the loop.

Each time through a loop, you can have the sequence speed up, slow down, or remain at the same
speed.

A sequence can contain many loops. Loops can be nested - that is, a loop can contain other loops.
In the Sequence Editor, loops are shown in a white row, above the grey rows representing channels. For

example, the following picture shows a sequence with a loop starting at 1 second and ending at 2
seconds:

¥ (new sequence 1)*

Time Scale | T T

Loop 1 - o

Channel 1
Channel 2

A sequence with aloop, starting at 1 second and ending at 2 seconds

More than one loop can be in a sequence. For example, here is the same sequence, with a second loop
added, from 2.5 seconds to 3 seconds:

¥ (new sequence 1)*

Tirne Scale ||||||||1|'I][|I| R |:|2'm{|| RN |:|3'["{I
Loop 1 e ey e
Channel 1

Channel 2

Two loops in asequence

Loops can contain loops; this is represented by having multiple rows of loops. For example, in the
following picture, a second loop level has been added, and a loop was put into it from 0.5 seconds to 3
seconds, thus containing both of the loops of the lowest loop level:
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¥ (new sequence 1)*

Time Scale ||||||||1|'I][|I| L |2|'m{|| RN |:|3'["{I
Loop 2 _,..--"'"""FFF' _h“""""---..h
Loop 1 e ey -
Chatitiel 1
Charirel 2

A loop containing loops

To use loops in an animation sequence, you first must use the "Turn on Loops" option in the Edit menu
of the Sequence Editor (or, alternatively, specify that you want to use loops when you create the
sequence in the New Animation dialog).

To create a loop, select the appropriate time range and the loop level, either by clicking and dragging the
mouse in the white loop rows or by using the keyboard. The Loop Context menu will pop up:

B

¥ (new sequence 1)*

Time Scale ||||||||1|'[I[|I| P |:|Z'u[|ll Pt |:|3'[":|I
Loop 2 _,..--"""'""F—' hh"""--..._‘_
Loop | Insert Loop ™
Channel 1

Add Loop Level Above
Channel 2 Add Loop Level Below

Remove Loop Level
Remove 8l Loops on Level

The Loop Context menu

After selecting "Insert Loop". You will then be prompted for how many times the loop should loop back,
and then whether (and by how much) it should increase, decrease, or remain the same speed in each
pass through the loop:

Setting Loop Parameters

Loop back how many times?

Cancel |

5

Inserting aloop: How many times should it loop back?
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¥ Loop Speed

Haow much ghould the loop speed

up or zlow doven each ime +37%%
through™?
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The firgt loop will take 2.00 zeconds...

... and the lazt loop will take 0.41 zeconds.

k. Cancel

Inserting aloop: Should it speed up or slow down?

Clicking on an existing loop also brings up the Loop Context menu, but with additional menu items, such
as displaying information about the loop and removing the loop:

¥ (new sequence 1)*

o=1ES

Time 3 cale ||||||||1|'["{I|||||||2|'["{I|||||||::Tu'-"{I =
Loop 2 _...--"'"""'-F# “h"‘"‘--._
Loop 1 =

hange Loop
Channel 1 Loop Info
Charnnel 2 Remove Loop

Add Loop Level bove
Add Loop Level Below
Remove Loop Level
Remove All Loops on Level

The Loop Context menu, on an existing loop

Seweral of these menu items can also be accessed by clicking on the loop level's button (specifically, the
ones dealing with loop lewels, such as "Add Loop Lewel Above" and "Remove Loop Lewel™).

419 Tracks

A sequence can contain multiple tracks, with each track being a group of channels. A channel can be in
one track, or can be shared among multiple tracks. For example, the following sequence has two
tracks, and two channels, with both of the channels being in both of the tracks:
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¥ Bushes.las

Track 1: Tenth Second Timings -
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1

Two tracks in one sequence, with the same channels in both tracks

Notice that the two tracks have different timings than each other - in this case, the top track has timings
every tenth of a second, and the bottom track every half a second.

All sequences are initially created with a single track. There are a few ways to add another track using
the Sequence Editor:

¢ In the Edit menu:
e "Add New Track" will add a track with entirely new channels.
e "Duplicate Track" will add a new track and share all of the channels of the currently selected
track with it.
¢ On a channel button's right-click popup menu:
e "Copy to New Track" will add a new track and copy the channel to it, while also giving you the
option to automatically insert new channels as well.
e "Mowe to New Track" does much the same, except that the channel will be moved, not copied,
to the new track.
e Using the Tracks and Timings toolbar

Important: To share a channel between tracks, make sure to use one of the abowve duplication or
copying commands. Do not simply set two different channels in different tracks to the same unit ID,
circuit number, et cetera. Doing that will have unexpected and undesired results, as the two different
channels compete for control over the same physical circuit.

If a sequence has more than one track, each will be displayed with a preceding track bar. The bar will be
labeled with the track's number within the sequence (the track at the top is track #1, the next one down
is track #2, and so forth). If the track is given a name (such as by "Change Track Name" of the Edit
menu), it will also be displayed on the bar:
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¥ (new sequence 2)*

Track 1
Time Scale RS |||||